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1 Dasar-Dasar MineScape 

Buku petunjuk ini disiapkan sebagai bagian dari training Minescape. Untuk 
memahami buku ini, sebuah copy data  telah dipersiapkan.  
 
Minescape merupakan software perencanaan tambang terpadu yang dirancang 
khusus untuk industri pertambangan mencakup semua aspek informasi teknis 
tambang, mulai dari data eksplorasi hingga penjadwal produksi tambang. 
 
Core Minescape mendukung berbagai macam software aplikasi khusus  yang 
memungkinkan anda secara interaktif membuat dan mengolah model-model geologi 
tiga dimensi  serta desain tambang.  
 
Minescape dirancang untuk digunakan oleh semua profesional tambang termasuk 
surveyor, geologist dan mine engineer. Fleksibilitas yang dimiliki oleh Minescape 
memastikan bahwa software tersebut dapat digunakan dalam perencanaan tambang 
jangka pendek dan jangka panjang untuk tambang batu bara dan bijih. 
 
Minescape memiliki interface intuitif yang disebut Graphical Task Interface (GTI). 
Interface tersebut menjadikan pekerjaan anda lebih mudah dikerjakan sehingga 
lebih efisien dan mengurangi kebutuhan pelatihan. 
 
Minescape dapat dioperasikan dalam platform Windows®. 
 
1.1 Project 

Semua pekerjaan dalam Minescape didasarkan pada project–project yang secara 
umum disesuaikan dengan operasi tambang atau prospek eksplorasi. Project-project 
tersebut memungkinkan pekerjaan dapat dikelola secara logis sehingga  
memudahkan dalam manajemen dan pengaksesan. 
 
Minescape hanya mengijinkan bekerja pada satu project dalam satu session  
meskipun data dari project yang lain dapat diakses. Project tidak dapat diubah 
selama session Minescape. Apabila anda ingin mengubah project, anda harus 
keluar dari project dan pilih project baru. Beberapa session Minescape dapat 
dijalankan secara bersama-sama. 
 
1.2 Aplikasi Minescape 

Aplikasi Minescape merupakan inti dari sistem Minescape meliputi sistem dasar dari 
program, bahasa pemrograman, struktur data, library, tools dan modul-modul yang 
merupakan bangunan dari kesesuaian software Minescape. 
 
Minescape dapat dikonfigurasikan sesuai dengan berbagai proses yang ada di site.  
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1.3 Komponen-Komponen Interface 

 

1.3.1 GTI Window 

GTI Window merupakan front-end sistem Minescape yang menyediakan manajemen 
interface yang kaya akan features dan secara visual berbeda dari environment 
Minescape. GTI merupakan kependekan dari Graphical Task Interface yang terdiri 
dari base window dan berisi sejumlah Page yang dapat dikonfigurasikan untuk 
kebutuhan pemakai yang ditampilkan sebagai tab-tab dalam tab-deck. 
 

1.3.2 Page 

Page merupakan accumulate windows  yang menjalankan fungsi-fungsi khusus dan 
ditampilkan di dalam GTI window. Hingga 32 Page dapat ditampilkan secara 
bersama-sama dalam GTI window, tergantung pada kemampuan RAM, dan 
sebagainya.  Secara umum, page ada dua macam, yaitu: 
 
Minescape Page 
Minescape Page menyediakan fungsi-fungsi Minescape (misalnya: modelling). Page 
work sentral dari suatu page mampu menampilkan grafik CAD dalam satu atau lebih 
CAD windows. Sarana Minescape lainnya dapat juga ditampilkan dalam area ini. 
 
Monitor Page 
Monitor page menyediakan layanan pemantauan dan kontrol terhadap modul-modul 
yang dijalankan selama session Minescape dan mengkomunikasikan langsung 
dengan server modul Minescape. Page work sentral dari Monitor Page menampilkan 
modul-modul menurut batch yang ingin dijalankan. Informasi lengkap untuk setiap 
modul dapat diperoleh dengan mudah. Page tersebut juga meliputi kontrol-kontrol 
untuk melihat, jeda, mengakhiri dan memulai eksekusi modul dan berinteraksi 
dengan modul server. 
 

1.3.3 CAD Window 

CAD window menampilkan grafis 3D CAD dari Minescape (Computer Aided Design). 
Subsistem CAD GTI memadukan bahasa pemrograman dengan arsitektur 
client/server sehingga dapat menyediakan fasilitas edit dan management data grafis 
secara menyeluruh. 
 

1.3.4 Form 

Form merupakan window tersendiri yang menampilkan parameter dan data yang 
relevan untuk mengoperasikan Minescape secara khusus serta memungkinkan anda 
untuk melihat, memanipulasi parameter secara interaktif dan menyerahkan modul-
modul tersebut untuk dijalankan. 
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1.3.5 Bahasa Pemrograman 

MPL 
Minescape Programming Language atau MPL merupakan bahasa pemprograman 
aplikasi tingkat tinggi untuk program-program penulisan (dikenal dengan user 
commands) yang berinteraksi dengan data dan modul-modul Minescape. MPL terdiri 
dari fungsi spesialis yang secara internal dikenal dengan MPL verbs. 
 
ActionMPL 
ActionMPL merupakan kemasan gambar derivatif dari MPL standar yang 
memungkinkan program-program (yang dikenal sebagai action) ditulis dengan 
menghubungkan interface Minescape dan fungsionalitas dasar. ActionMPL verbs 
dapat direferensikan di dalam program sehingga memberikan kemudahan akses  
terhadap banyak feature Minescape. 
 

1.3.6 Modules 

Modules merupakan program khusus Minescape untuk membuat, mengimpor, 
mengekspor dan menampilkan data yang kompleks. Modul tersebut dijalankan untuk 
memproses data-data yang kompleks dan memerlukan banyak memori seperti 
modelling, pembuatan contour dan penghitungan volume. Secara eksternal semua 
model dijalankan dari interface Minescape GTI baik di dalam foreground ataupun 
background melalui modul server yang tersedia. Dengan menjalankan modul-modul 
tersebut dalam background, anda dapat terus menggunakan interface grafis secara 
bebas dari berbagai overhead yang berhubungan. 
 

1.3.7 Libraries dan Tools 

Minelib 
Minelib adalah suatu mining yang  berorientasi pada kegunaan library dan 
menyediakan sebuah API untuk: 
 
• Management data surface. 
• Management data grid. 
• Management data tabel dan editing spread sheet. 
• Database Mining block. 
• Coordinat Geometry dan Graphics Output (COGO) tools. 
 

1.4 Produk-produk Minescape 

Produk adalah plug-in perangkat lunak khusus yang dipadukan dengan aplikasi 
Minescape. Produk-produk plug-in memberikan kehandalan dalam aplikasi dan 
fungsi-fungsi tambahan yang khusus pada operasi-operasi tertentu (misalnya: 
Stratmodel dan Open Cut Planning dsb). 
 
Berbagai produk menggunakan arsitektur, program, library, dan tools Minescape 
core.  
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Produk-produk yang tersedia dalam Minescape meliputi: 
 
• Drill Hole Database (GDB) 
• Stratigraphic Modelling 
• Block Modelling 
• Open Cut Planning 
• Underground Planning 
• Scheduling 
• Mine Surveying 
• Haul Road Design 
• Drill & Blast  
• Dragline Modelling 
 
1.5 Memulai MineScape 

Semua pekerjaan di MineScape didasarkan pada project. Project-project ini berarti 
mengelompokkan informasi yang berhubungan dalam suatu daerah dan 
memungkinkan mengorganisasikan secara logis daerah-daerah kerja. Secara umum 
suatu project berkaitan dengan suatu daerah operasi tambang atau proyek 
eksplorasi. 
 
MineScape dapat dijalankan dari: 
 
• Dari icon MineScape yang terdapat di desktop. 

 

  
 

• Project name — field ini menampilkan directori project dimana MineScape 
dimulai. Pilihan nama project dapat dipilih dari daftar pilihan “pull-down” jika 
diperlukan.  
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• Pilih tombol  untuk membuat project baru. 
 
Lihat: Membuat Project Baru untuk detail metoda yang dapat digunakan untuk membuat 

project 
 
• Application — Pilih aplkasi yang diinginkan misalnya Stratmodel dari daftar 

pilihan pull-down.  
• Restore. Pilih jika ingin merestore grafis yang ditampilkan sebelumnya pada saat 

aplikasi ditutup.  
 
Catatan: Grafis pada current page secara otomatis disimpan pada saat keluar dari 

MineScape. Jika ada yang secara individu ditutup (menggunakan Page>Close 
Page) grafisnya disimpan untuk aplikasi tersebut dan dapat direstore 
mengunakan “check box” di atas.  

 
• Pilih OK — Window GTi akan ditampilkan.  
 

1.5.1 GTi Window 
GTi (Graphical Task Interface) menyediakan interface utama ke Minescape. GTi 
window terdiri atas sejumlah page, yang ditempatkan dalam tab-deck interface. 
 

 

 

Tab 
Interface 
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1 Project MineScape 

Di dalam suatu project, data tambang yang saling berhubungan dikelompokkan 
sedemikian rupa sehingga dapat digunakan secara efektif, dimanipulasi dan 
dianalisis. Diharapkan, suatu project akan sesuai dengan operasi site tambang atau 
prospek eksplorasi. 
 
Semua pekerjaan di dalam Minescape harus dikerjakan di dalam suatu project.  
 
Minescape session memungkinkan hanya satu project untuk dibuka pada satu waktu 
tertentu. Project tersebut disebut sebagai current project dan ditampilkan dalam Title 
Bar dari GTI window. 
 
Setiap project memiliki directory terpisah yang dikenal sebagai directory project. 
Directory tersebut terdiri dari struktur directory yang telah ditentukan sebelumnya 
untuk informasi Minescape (yaitu: data, log files, laporan, dan sebagainya.) dan 
secara otomatis dibuat dalam rangkaian pembuatan project. 
 

1.1 Memulai Sebuah Project 

Untuk memulai sebuah project Minescape, pilih shortcut Minescape dari Dekstop  
 
Form berikut akan ditampilkan: 

 

 
 
 
Jika anda sudah mempunyai project Minescape sebelumnya maka pilih nama 
projects anda pada bagian Project Name, dengan cara klik pull-down (tanda 
segitiga hitam) kemudian pilih jenis Application  yang ingin dibuka. 
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Jika anda akan membuat projects Minescape baru  maka pilih tab Create Project. 
Setelah meng-klik Create Project maka form Initial Setup Project akan ditampilkan 
seperti pada contoh berikut: 
 

 
 
Project Panel 
• Name. Nama project. 
• Description. Keterangan dari project. 
• Project Path. Tempat penyimpanan direktory project anda. Misalnya, project 

anda akan disimpan dibawah direktory D:\projects. Jika anda ingin menamakan 
project dengan nama tutorial, maka pada field Project Path ketikkan 
D:\projects\tutorial dan secara otomatis pada field Name akan tercantum 
tutorial. 

 
Spatial Orientation Panel 
• Origin easting, northing dan Elevation. Koordinat origin untuk easting, northing 

dan elevasi dari project anda, dimana koordinat ini merupakan pusat dari project. 
• Quadran. Masukkan NE (Quadran 1). 
 
Current Unit Panel 
• Category. Nama unit category yang disediakan oleh Minescape.  
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• Current unit.  Satuan unit dari masing-masing category. Anda dapat mengubah 
satuan unit dengan cara klik kiri dua kali pada field current unit pada masing-
masing category sampai menu pull-down ditampilkan (tanda segitiga hitam) 
kemudian klik menu pull-down dan pilih satuan unit yang anda inginkan. 

• Decimal place. Jumlah angka desimal dibelakang koma. Anda dapat mengubah 
angka decimal dengan cara klik kiri pada field Decimal Place kemudian ketikkan 
angka desimal yang anda inginkan. 

• Update. Jika anda mengubah current unit atau decimal place maka secara 
otomatis pada field Update akan diisi Yes. Jika anda tidak mengubah current unit 
atau decimal place maka secara otomatis pada field Update akan diisi No. 

 
Pilih Create Project 
 
Sebuah popup konfirmasi berikut  akan ditampilkan 
 

 
 
Pilih Create Project 

 
Modul MNSCREATE dijalankan dan akan membuat beberapa direktori untuk project 
yang dibuat, menyesuaikan database dan project definition file. Selain itu dua buah 
design file akan dibuat yaitu Blocks dan Surface. Design file tersebut digunakan 
untuk menyimpan data spatial untuk blocks dan surface. 
 
Setelah proses pembuatan direktori selesai maka akan ditampilkan sebuah form 
seperti pada gambar pertama dengan Project Name: training. 
 
Klik OK untuk masuk ke project tersebut. Sebuah form akan ditampilkan yang 
disebut GTI Window yang terdiri dari menu-menu, icon-icon, tool bar, tab dan CAD 
window. 
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1.2 Keluar dari Project 

Jika anda sudah selesai dan ingin keluar dari project maka pilih menu dari GTI 
window: 
 
Page>Exit 
 

 
 
Sebuah pop-up konfirmasi akan ditampilkan. Klik OK untuk keluar dari Minescape. 
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1.3 Memasukkan Informasi Identitas Project 

Informasi identitas Project terdiri atas nama, deskripsi dan lokasi project. 
 
• Nama project harus sesuai dengan konvensi penamaan standar Minescape, 

yaitu:16 karakter atau kurang, tanpa spasi, jenis huruf bebas, hanya berupa 
karakter alpha-numeric dan underscore (_). Ini akan didefault ke nama dari 
directory project. 

• Diskripsi Project adalah field yang tidak dapat diformat yang menjelaskan 
project dan dapat terdiri dari  256 karakter dalam satu baris. 

• Project Path secara otomatis ditampilkankan sebagai subdirectory dari root 
project site seperti yang ditetapkan dalam $MIN_ROOT environment variable. 
Directory project harus mengikuti aturan penamaan seperti nama project dan 
hurufnya harus kecil. 

 
Kalau project path tidak sesuai dengan yang diinginkan, anda dapat meminta Sistem 
Administrator untuk mengganti atau memilih alternatif lain pada $MIN_ROOT. 
 
1.4 Menentukan Spatial Orientation Project 

Menentukan Spatial Orientation project terdiri dari: 
 
• Menentukan Global Origin 

• Menentukan Project Quadrant. 
 

1.4.1 Menentukan Global Origin 

Data resource files dalam Minescape disimpan dalam  koordinat-koordinat XYZ 
sebagai offset dari suatu titik referensi, yang dikenal sebagai global origin. Misalnya, 
kalau global origin suatu project adalah (651000, 7404000,0) dan satu koordinat 
dimasukkan pada (651800,7414000,-10) Minescape akan menyimpan koordinate 
tersebut sebagai (800,10000,-10) – offset dari global origin. 
 
Offset disimpan dalam single-precision floating point format, yang memungkinkan 
penyimpanan XYZ offset dalam tujuh digit. Misalnya, kalau unit pengukurannya 
adalah meter, Minescape dapat menyimpan data koordinat sampai radius 10 km dari 
global origin dengan ketepatan milimeter. 
 
Suatu global origin project ditentukan dengan: 
 
• Easting – koordinat barat/timur (koordinat X) 

• Northing – koordinat selatan/utara (koordinate Y) 

• Elevation – koordinat kedalaman/ketinggian (koordinat Z). 
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1.4.1.1 Menjadikan Global Origin Sebagai  Pusat 

Global origin harus mendekati pusat geografis project (centroid) untuk 
memaksimalkan ketepatan di dalam project. Misalnya: 
 
Suatu prospek tambang meliputi area persegi panjang 9 km X 18 km. Ada dua 
pilihan untuk global origin project: 
 
• Sudut baratdaya dari project 

• Pusat project 
 
Gambar berikut menunjukkan bahwa kalau global origin ditetapkan dalam sudut 
barat daya (sembarangan) dari project, ketepatan millimeter tidak dapat 
dipertahankan untuk keseluruhan project. 

 
Suatu SW global origin dalam suatu project 9 km X 18 km 

Project 

Ketepatan suatu area 

Glob
al 

Gambar di atas menunjukkan bahwa kalau global origin ditetapkan di pusat project, 
ketepatan milimeter dapat dipertahankan untuk keseluruhan project. 
 
Suatu central global origin untuk project yang berukuran 9 km X 18 km 
 

Global  

K
ilo

m
et

er

Gambar di atas memberikan contoh nyata di mana anda harus menempatkan global 
origin. 
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Menempatkan Global Origin di Pusat Project 

 

Global origin dari project dalam Gambar di atas adalah: 
 
• Easting – 651000.00 

• Northing – 7404000.00 

• Elevation – 0.00 (Elevation biasanya 0.00) 
 

1.4.2 Menentukan Project Quadrant 

Quadrant di mana global origin ditempatkan harus ditentukan. Quadrant menetukan 
arah koordinat X dan Y.  
 
Quadrant pertama (Quadrant NE) adalah yang paling biasa digunakan, di mana 
koordinat X bertambah  ke arah kanan dan koordinat Y bertambah  ke arah atas. 
 
Catatan: Hanya satu quadrant yang dapat ditentukan untuk suatu project. 
 
Gambar di bawah menunjukkan quadrant-quadrant yang berbeda. 
 
Quadrant 
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1.5 Menangani Project 

Bagaimana Current Project Ditentukan 
Current project ditentukan pada saat memulai Minescape. Project yang ditampilkan 
dalam form MineScape_initialisation secara default, merupakan project terakhir yang 
digunakan sebelum Minescape ditutup terakhir kalinya. 
 
Mengubah Current Project 
Mengubah project tidak diijinkan pada saat dijalankan. Untuk mengubah project, 
anda harus keluar dari Minescape, pilih project baru atau yang sudah ada dan mulai 
lagi Minescape. 
 
Project yang Simultan 
Minescape tidak memungkinkan bekerja pada banyak project pada GTI window 
yang sama. Tetapi, session Minescape yang lain dapat ditampilkan secara simultan. 
 
Mengakses file-file dari project lain  
Walaupun current project tidak dapat dirubah pada saat dijalankan, tapi file-file data 
dari project lain dapat di akses.  
 

1.5.1 Konvensi Directory Project 

Minescape secara otomatis menciptakan seperangkat subdirectory dan file sewaktu 
membuat project baru. Dengan struktur directory yang terkontrol dan konvensi 
penamaan file memastikan bahwa file-file disimpan dan diberi nama. Untuk 
melakukan hal ini, Minescape menempatkan setiap jenis file dengan suffix yang 
khusus dan menyimpannya dalam default directory. 
 
Sewaktu nama-nama file dimasukkan tanpa ekstensi atau path directory, Minescape 
akan menambahkan default ekstensi dan path directory. Tujuan utama dari struktur 
default directory dan konvensi penamaan file adalah untuk memastikan bahwa file-
file mudah ditempatkan dan ditentukan. 

 

Catatan: Memasukkan nama-nama file dengan extensi atau path directory adalah 
berbahaya. Kalau ekstensi atau path berbeda dengan defaultnya, Minescape 
mungkin tidak mengenali file tersebut atau dapat menemukan file tersebut di 
waktu mendatang. 

 

1.5.2 Konvensi File 

Nama file Minescape dibatasi sampai 16 karakter. Semua nama file yang telah 
dibuat disimpan dalam huruf kecil – ini akan memastikan bahwa masalah susunan 
pengelompokan yang tidak sesuai dengan perintah UNIX tidak terjadi. 
 
Daftar file selalu dikelompokkan secara alpabetis. Kalau nama-nama filenya 
merupakan cross-product dari dua atau lebih komponen, hanya underscore (_) yang 
seharusnya memisahkan komponen-komponen tersebut. Underscore selalu 
mengawali karakter alphanumeric dalam pengelompokannya. 

  8 of 11 

DOWNLOAD TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys

Download TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys



  Project MineScape 
 

 
 
Catatan: Hindarilah menggunakan spasi untuk memisahkan komponen-komponen nama 

file cross-product, karena Minescape hanya mengenali kompenen pertama dari 
nama tersebut (yaitu, karakter-karakter sebelum spasi tersebut) sewaktu menulis 
nama file ke disk. Pemisah pernyataan dan karakter khusus seperti !, ., @, #, $, 
%, ^, &, *, (,), |,\, /, dan sebagainya. harus dihindari karena mereka memiliki arti 
khusus dalam environment UNIX.  

 

1.5.3 Default Directory dan File Suffix 

Semua jenis file Minescape memiliki default ekstensi file dan directory untuk 
memudahkan pencarian file. 
 
Tabel di bawah berisi default suffix dan directory. Default directory di bawah ini 
merupakan subdirectory pada project anda.  
 

Jenis File Default 
Directory 

Default 
Suffix Keterangan 

adobe ps font dpsfonts  Berisi deskripsi jenis font yang digunakan 
dalam Minescape 

app_defaults app_defaults .ad Berisi aplikasi file default yang digunakan 
pada saat memulai Minescape. 

as2482 as2482 .dat Berisi informasi untuk mengubah feature 
– data mapping digital yang sudah diberi 
kode dengan menggunakan Standard 
Australia.  

datfile data .dat File data. 

dbsfile database .DBS.DAT File database. 

bmodfile tables .tab File block model. 

dgnfile designs .dgn File-file design. 

dmpfile dump .dmp File-file dump. 

grdfile grids .grd File-file grid. 

logfile logfiles .log Berisi file-file log dari sebuah modul yang 
dieksekusi. File-file tersebut berisi 
sebuah audit dari suatu modul yang 
dieksekusi termasuk input Spec secara 
detail, pesan feedback dan kesalahan-
kesalahan. 

mdsfile mdsserver .batch File-file mdserver yang sudah disave. 

mxlfile  mxl .mxl File-file MXL/ 

pltfile plots .plt File-file plot. 

rptfile reports .rpt File-file report. 

reserves tables .rsv File-file tabel reserve. 
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tabfile tables .tab File-file tabel. 

tratfile triangle .tfl File-file triangulasi. 

quality tables .tab File-file tabel quality. 

qualdef specs .qualdef Defaults quality. 

specfile spects .{cat} Berisi file-file umum Minescape Spec 

survey tables .tab File-file tabel survey. 

textures texture  Textur peta untuk grafis. Misalnya: aerial 
photo dan sebagainya. 

stratfile tables .tab File-file tabel stratmodel. 

washfile tables .wsh File-file tabel wash. 

 

Perhatian: Jangan menggunakan file-file tersebut kapanpun 
 

1.5.4 Konvensi Penamaan 

Minescape tidak menentukan konvensi penamaan. Tetapi disarankan untuk 
menentukan sistem penamaan untuk item-item project. Konvensi penamaan yang 
baik adalah penting untuk organisasi, informasi pencarian dan referensi. 
 
Penentuan konvensi penamaan diperlukan, dan harus  disesuaikan dengan hal-hal 
berikut: 
 
• Apakah item tersebut berhubungan dengan waktu, misalnya apakah item 

tersebut diupdate setiap bulan, kuartal, tahunan, dan sebagainya, seperti dalam 
Contoh 1. Jika demikian, masukkanlah komponen tanggal ke dalam nama. 

 
• Apakah item tersebut memiliki parrent yang  sesuai, misalnya design file dan 

hubungan kelompok. Jika demikian, putuskan apakah akan memasukkan atau 
tidak  jenis designator ke dalam konvensi penamaan. Kalau tidak, masukkanlah 
jenis designatornya. 

 
• Apakah nama-nama tersebut dihasilkan oleh cross-product, misalnya 

kesinambungan dengan Roof  dan Floor, seperti dalam Contoh 2. Jika demikian, 
tetapkanlah konvensi penamaan yang sesuai dengan cross-produknya. Misalnya, 
<seamname>_<attribute> di mana <attribute> adalah Roof atau Floor atau 
mungkin thick atau nama qualitas lainnya. 

 
Contoh 1 
Sebuah survei airborne mine dilakukan setiap bulan. Kontraktor menyediakan 
AutoCAD DWG file yang menunjukkan posisi atas dan bawah. File DWG diimport ke 
dalam Minescape dan digital terrain mode yang diupdate dan seperangkat volume 
yang dijalankan pada terrain model bulan sebelumnya. 
 
Dinamakan apakah file di mana data DWG diimport? 
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Karena file tersebut terdiri atas data topografis, dapat disebut topo.dat. Tetapi, 
karena file data topografis dilakukan perbulan, file dengan nama ini dapat dengan 
mudah ditimpa. 
 
Karena file tersebut terkait dengan waktu (yaitu, bulanan), tambahkan komponen 
tanggal misalnya topo_nov_94, topo_dec_94, dst – yang memungkinkan files tidak 
ditimpa. User lain juga dapat dengan mudah mengidentifikasikan nama-nama file 
dan pemeliharaan data-data lama juga lebih mudah. 
 
Catatan: Kalau sebuah file memiliki nama cross-product dan mungkin terdapat banyak file 

yang terkait, lebih baik untuk menggunakan komponen pertama yang biasa (yaitu, 
TOPO_NOV_94 lebih baik daripada NOV_TOPO-94) karena file-file biasanya 
dikelompokkan, baik dalam Minescape maupun dalam directory. 

 
Contoh 2 
Lima lapisan batubara dinamakan A, B, C, D dan E. Bagian paling atas dan paling 
bawah dari setiap lapisan membutuhkan contour. Contour akan memiliki design file 
yang sama.  
 
Nama-nama apa yang baik untuk design file layer? 
 
Konvensi penamaan cross-product sederhana dapat digunakan untuk memberikan 
nama-nama lapisan seperti A_ROOF, A_FLOOR, B_ROOF, B_FLOOR, dan 
sebagainya. Tetapi, karena setiap lapisan mewakili satu contour, komponen contour 
dapat dimasukkan sebagai bagian dari nama, misalnya A_ROOF_CONT, 
A_FLOOR_CONT, dan sebagainya. 
 
Kalau konvensi ini diikuti dan surface meshes  dari lapisan batubara tersebut juga 
dibutuhkan, konvensi dapat menyesuaikan dengan mudah yang memungkinkan 
design file layer A_ROOF_MESH, A_FLOOR_MESH, dan sebagainya dengan file 
design yang sama. 

 
Alternatif lain adalah mengirimkan outputnya ke dua design file yang berbeda, 
CONTOURS dan MESHES, yang keduanya berisi lapisan-lap 
 
1.6 Memasukkan Data kedalam Project 

Untuk memasukkan data demos kedalam projects dapat dilakukan dengan 
menggunakan fasilitas Window Explorer. Adapun caranya adalah seperti berikut: 
 
• Masukkan CD kedalam PC kemudian buka Window Explorer dan klik CD Drive 

untuk melihat isi disket. 

• Copy data yang ada didalam CD ke directory data pada project training yang 
baru anda buat dengan cara highlight semua data yang terdapat pada CD 
kemudian pilih Copy, expand hirarki dimana project disimpan, misalnya project 
disimpan dibawah disk: D\projects, Expand hirarki training dan pilih folder data 
kemudian pilih paste. 
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1 Page 
1.1 Minescape Page 

 
 

 

 

 

Menu Bar Tool Bar 

Feedback 
Area 

Status 
Area 

Tracker 
Koordinat 

Work  
Area 

Icon 
Bar 

Docking 
Area 

Prompt 
Area 

Page terdiri dari feature berikut: 
 
• Menu bar 
• Tool Bar 
• Icon Bar 
• Work Area 
• Feedback Area 
 
Untuk membuka page pada Gti window pilih menu berikut: 
 
Page>Open Product> Pilih Nama product 
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1.1.1 Menu Bar 

Menu bar adalah suatu item page permanen yang terlihat setiap saat dan tidak 
dapat diturn on atau diturn off. 
 
Menu bar terdiri dari pilihan-pilihan dimana anda dapat melakukan action yang 
bersifat global terhadap current session. 
 
Menu bar berupa default pull down menu yang terdiri dari pilihan-pilihan berikut: 
 
Menu Page 
 

Menu Submenu Action 
Files > terdiri dari pilihan berikut: 
 Open Minescape Explorer  

Open Write … 
 
Close Write … 
Attach Reference … 
 
 
Detach Reference … 

Membuka Minescape Explorer 
Menampilkan design atau triangle 
current file 
Menutup design atau triangle current file 
Memilih source type dan nama file  
untuk ditampilkan sebagai reference 
file. 
Menutup reference 

Open Product> terdiri dari pilihan berikut: 
  

Blasthole Database 
Block Model 
Drillhole Database 
Dragline 
Drill&Blast 
Grade Blocking 
Minescape 
Open Cut Coal 
Haulage Roads 
Stratmodel 
Survey 
Underground Coal 
Unix to Windows 
Saved Spec  

Membuka: 
Product Blasthole Database 
Product Block Model. 
Product Drillhole Database 
Product Dragline 
Product Drill & Blast 
Product Grade Blocking 
Product Minescape 
Product Open Cut coal 
Product Road Design 
Product Stratmodel 
Product Survey 
Product Underground Coal. 
Conversi versi Unix ke Windows 
Spec yang sudah disimpan. 

Change Product> Menu Change Product terdiri dari pilihan berikut: 
  

Blasthole Database 
Block Model 
Drillhole Database 
Dragline 
Drill&Blast 
Grade Blocking 
Minescape 
Open Cut Coal 
Roads 
Stratmodel 
Survey 
Underground Coal 
Unix to Windows 
 
Saved Spec … 

Mengganti current product ke: 
Product Blasthole Database 
Product Block Model. 
Product Drillhole Database 
Product Dragline 
Product Drill & Blast 
Product Grade Blocking 
Product Minescape 
Product Open Cut coal 
Product Road Design 
Product Stratmodel 
Product Survey 
Product Underground Coal. 
Conversi versi Unix ke Windows 
Spec yang sudah disimpan. 
page yang sudah disimpan. 

Save  Menyimpan setting current session. 
Save As …  Menyimpan current session dengan 
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nama yang lain. 
Close Page …  Menutup current page. 
Close Window …  Menutup current window. 
Print …  Mencetak file yang berupa data atau 

report. 
Plot > terdiri dari pilihan berikut: 
 File Plot 

Quick Plot 
 
 
Plotslot Setup 
Plotslot 
Plan Plotslot 
Section Plot 

Mencetak file plot.  
Membuat file plot dengan format 
tertentu secara langsung dari CAD 
window. 
Menentukan setup untuk plotslot. 
Membuat plot file dengan plotslot. 
Membuat plot file tampak atas. 
Membuat plot file tampak samping. 

Task > terdiri dari pilihan berikut: 
 Start recording Cue Card 

 
Edit Cue Card 
Run Cue Card 
Stop Recording Cue Card 
Start Batch 
 
Finish and Run Batch 
 
Run Saved Batch 
 
Command Manager 

Memulai perekaman perintah yang 
dilakukan oleh system. 
Mengedit cue card. 
Menjalankan cue card. 
Menghentikan rekaman cue card. 
Merekam batch untuk menjalankan 
urutan modul. 
Menutup rekaman batch kemudian 
menjalankannya. 
Menjalankan batch yang sudah 
disimpan. 
Memanggil perintah-perintah yang tidak 
ditampilkan dalam menu standard. 

Preference > terdiri dari pilihan berikut: 
 Date… 

 
Confirm options 
 
 
Docking 
Feedback 
Iconbar 
Iconbar Options… 
Prompt 
Status 
Status Options… 
Toolbar 
Toolbar Options… 
Key mapping 
 
Units… 

Mengatur acuan tanggal dan waktu dari 
project anda. 
Mengatur pilihan konfirmasi pada saat 
duplicate elemen, menghapus elemen, 
menutup CAD dan paper window.  
Turn on/turn off Docking Area. 
Turn on/ turn off Feedback Area. 
Turn on/turn off Icon Bar. 
Konfigurasi pilihan Icon Bar. 
Turn on/turn off Prompt Area. 
Turn on/turn off Status Bar. 
Konfigurasi pilihan Status Bar. 
Turn on/turn off Tool Bar. 
Konfigurasi pilihan Tool Bar. 
Konfigurasi tombol-tombol pada 
keyboard. 
Mengatur satuan-satuan unit yang 
digunakan dalam project. 

Exit  Keluar dari aplikasi Minescape dan 
menutup Gti 

 
 
Menu Edit 
 

Pilihan Submenu Pilihan Action 
Undo  Membatalkan pekerjaan terakhir yang 

sudah dilakukan. 
Copy >  terdiri dari pilihan berikut: 
 Single 

Duplicate 
Mengcopy elemen ke lokasi baru. 
Mengcopy elemen ke lokasi yang sama. 
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Along … 
 
Array… 
Circular… 
 
 
Multi… 
Paralel… 

Mengcopy elemen sepanjang elemen 
yang dipilih. 
Mengcopy elemen ke dua arah. 
Mengcopy elemen beberapa kali 
dengan jarak datar disekitar suatu 
busur. 
Mengcopy elemen beberapa kali. 
Mengcopy elemen secara paralel 
dengan jarak yang ditentukan. 

Delete  Menghapus object/elemen yang dipilih. 
Delete Layer  Menghapus layer (tidak termasuk curent 

layer) dengan cara pick elemen yang 
terdapat pada layer yang akan dihapus 
dari CAD window.  

Move  Memindahkan elemen ke lokasi baru 
Pivot  Memutar elemen ke arah tertentu 
Scale  Mengubah skala elemen ke arah X, Y, Z 
Drape  Menempatkan elemen pada surface 

yang dipilih 
Offset  Mengedit elemen dengan cara meng-

offset elemen pada jarak tertentu 
Project  Mengedit elemen dengan cara 

memproyeksikannya pada suatu 
elevasi, surface atau ketinggian tertentu 
dengan sudut tertentu. 

Continue  Melanjutkan pembuatan elemen dari 
elemen yang sudah ada. 

Extend  Melanjutkan pembuatan elemen  
menggunakan arah segment yang 
terakhir. 

Convert > terdiri dari pilihan berikut: 
 Annotation to Text 

To Points 
 
To Lines 
 
To Polygons 
 
To Object Definition 
 

Mengubah anotasi elemen menjadi text. 
Mengubah elemen yang dipilih menjadi 
rangkaian titik.  
Mengubah elemen yang dipilih menjadi 
rangkaian garis.  
Mengubah elemen yang dipilih menjadi  
Polygon.  
Mengubah elemen yang dipilih menjadi  
Object Definition. 

Element Edit ...  Mengedit elemen dengan 
menggunakan suatu form. 

Connect  Menghubungkan dua buah elemen 
menjadi satu elemen. 

Pick Break  Break elemen menjadi sub section. 
Element Break  Break  elemen pada suatu titik atau 

pada perpotongan dengan elemen lain. 
Explode  Mengubah rangkaian elemen menjadi 

elemen yang individual. 
Properties>  terdiri dari pilihan berikut: 
 Annotation… 

Atribute… 
Contours… 
 
Layers… 
Vertex Data… 

Mengedit anotasi elemen. 
Mengedit atribut elemen. 
Menentukan kembali display definition 
untuk major dan minor kontur. 
Memindahkan elemen ke layer lain. 
Mengedit data vertex tambahan pada 
elemen. 

Relimit > terdiri dari pilihan-pilihan berikut: 
 Clip World  Clip diberlakukan terhadap seluruh 
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Clip Selection Set 
 
Clip Fence Element 
 
 
 
 
 
 
Length… 
Polygon Expand… 
Polygon Split… 
Subdivide… 
 
 
Trim to Boundary 
 
Extend to Boundary 
 
Set to boundary 

elemen. 
Clip diberlakukan terhadap elemen 
yang dipilih. 
Clip diberlakukan terhadap elemen 
yang berpotongan dengan boundary 
jika elemen yang di clip terdapat diluar 
boundary. Jika elemen yang diclip 
terdapat di dalam boundary maka 
semua elemen yang terdapat didalam 
boundary akan dihapus. 
Mengedit panjang suatu elemen. 
Expand  polygon. 
Membagi polygon menjadi dua. 
Menambah vertex suatu elemen 
berdasarkan jarak atau jumlah vertex 
yang ditentukan. 
Memotong elemen oleh suatu batas 
yang ditentukan. 
Menambah panjang elemen terhadap 
suatu batas yang ditentukan 
Memotong atau menambah panjang 
suatu elemen terhadap boundary yang 
ditentukan. 

Segments > terdiri dari pilihan berikut: 
 Connect 

 
Delete 
Grade 
 
Intersect … 
 
Length … 
Move Centre 
 
Move Free 
Moved Fixed 
 
Swap Triangle 

Menghubungkan dua segment menjadi 
satu elemen. 
Menghapus segmen yang dipilih. 
Memasukan grade kedalam suatu 
segment. 
Membuat suatu elemen dari 
perpotongan dua segmen. 
Memodifikasi panjang elemen. 
Memindahkan segmen yang dipilih 
searah segmen tersebut. 
Memindahkan segmen ke segala arah. 
Memindahkan segmen pada arah yang 
sama. 
Mengubah arah garis diagonal dari dua 
titik triangle. 

Vertices> terdiri dari pilihan berikut: 
 Delete 

Delete Range … 
 
Delete by Number 
 
Filter… 
 
Insert… 
Move 
Move All 
 
 
 
Curve 
Reverse 
 
Z Values…  
Reorder 
 

Menghapus vertex. 
Menghapus vertex berdasarkan range 
dari vertices. 
Menghapus vertex berdasarkan urutan 
nomornya. 
Mengurangi vertex berdasarkan 
toleransi yang ditentukan. 
Memasukkan vertex. 
Memindahkan vertex ke lokasi baru. 
Memindahkan vertex dari multiple 
element (vertex pada titik perpotongan 
multiple element) dalam satu kali 
proses. 
Mengubah vertex menjadi kurva. 
Membalikkan urutan vertex dalam suatu 
elemen. 
Mengedit elevasi vertex. 
Mengubah urutan nomor vertex, 
misalnya vertex no 3 mau diubah 
menjadi no 2.  
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Triangles> terdiri dari pilihan berikut: 
 Enclose 

Vertex All Move 
Menutup surface triangle. 
Memindahkan vertex triangle. 

 
 
Menu View 
 

Menu Submenu  Action 
Animation >  terdiri dari pilihan berikut: 
 Rotation 

 
Follow Line 

Menampilkan elemen grafis seolah-olah 
diputar disekeliling suatu titik tengah. 
Mengatur pandangan dalam current 
CAD window seolah-olah melihatnya 
melalui sepanjang garis. 

Section Manager >  terdiri dari pilihan berikut: 
 Define Sections … 

 
Section Controls … 
Attach 
Block Models 
Drill holes 
 
Blast holes 
 
Quick Start … 
 
Instant Start 
Module Output … 
 
Stepping 
Forward step 
Backward step 
 
Pick 
Section view 
Finish 

Membuat section dari sebuah spec 
secara interaktif. 
Mengontrol tampilan section. 
 
Menampilkan section dari blok model 
Menampilkan drill hole dalam current 
section. 
Menampilkan blast holes dalam current 
section. 
Membuat section dengan cepat tanpa 
mendefinisikan sebuah spec. 
Membuat section secara cepat. 
Menampilkan module section dengan 
graphical output. 
 
Maju  satu tahap ke section berikutnya. 
Mundur satu tahap ke section 
sebelumnya. 
Pilih section untuk menampilkan. 
Flip view parallel ke current section. 
Menutup semua window section. 

Fit  Menyesuaikan tampilan grafis dengan 
ukuran CAD window. 

Top  Menampilkan elemen grafis dalam CAD 
window dari pandangan atas. 

Front  Menampilkan elemen grafis dalam CAD 
window dari pandangan depan. 

Left  Menampilkan elemen grafis dalam CAD 
window dari pandangan samping kiri. 

ISO > terdiri dari pilihan berikut: 
 NE 

 
NW 
 
SE 
 
SW 

Mengatur tampilan current CAD window 
secara isometri dari timur laut. 
Mengatur tampilan current CAD window 
secara isometri dari barat laut. 
Mengatur tampilan current CAD window 
secara isometri dari tenggara. 
Mengatur tampilan current CAD window 
secara isometri dari barat daya. 

Zoom> terdiri dari pilihan berikut: 
 Zoom In 

 
Zoom Out 
 
Window 

Memperbesar tampilan elemen grafis 
menjadi 2x. 
Memperkecil tampilan elemen grafis 
menjadi setengahnya. 
Memperbesar  tampilan elemen grafis 

  6 of 17 

DOWNLOAD TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys

Download TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys



  Page 
 

 
Fit Element 

dalam suatu window yang dipilih. 
Menyesuaikan elemen grafis pada CAD 
window. 

Rotate> terdiri dari pilihan berikut: 
 X axis 90 

Y axis 90 
Z axis 90 
X axis 180 
Y axis 180 
Z axis 180 
 

Menampilkan pandangan dari current 
layer yang dipilih dan diputar pada 
sumbu dan sudut tertentu. 

Plane  Mengatur pandangan ke suatu bidang 
yang dipilih. 

From Element  Mengatur pandangan dari suatu elemen 
yang dipilih. 
 

X Section  Mengatur pandangan ke suatu cross 
section vertical. 

Undo  Membatalkan operasi pengaturan 
pandangan yang paling akhir dan 
mengembalikan ke pandangan 
sebelumnya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Menu Draw 
 

Menu Submenu  Action 
Points  Membuat elemen titik pada CAD 

window. 
Lines  Membuat elemen garis pada CAD 

window. 
Polygon > terdiri dari pilihan berikut: 
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 Free 
 
Regular 
 
Rectangle 
 
Parallelogram 
 
Circle 
Bounding 
 
Donut 
Exclude 
 
Expand 
 
Intersect 
 
Merge 
 
Surround 
 
Strips 

Membuat elemen  polygon bebas pada 
CAD window. 
Membuat elemen polygon teratur pada 
CAD window. 
Membuat elemen empat persegi 
panjang pada CAD window. 
Membuat elemen parallelogram pada 
CAD window. 
Membuat elemen lingkaran. 
Membuat suatu polygon boundary dari 
elemen-elemen disekeliling titik pusat. 
Membuat elemen polygon donat. 
Mengeluarkan area elemen polygon 
dari yang lainnya. 
Memperbesar/memperkecil elemen 
polygon. 
Membuat polygon dari hasil 
perpotongan dua buah polygon. 
Menggabungkan dua buah polygon 
menjadi satu. 
Membuat suatu polygon yang 
mengelilingi semua elemen yang dipilih. 
Membagi polygon yang dipilih menjadi 
elemen strip polygon. 

Text …  Membuat elemen-elemen text pada 
CAD window. 

Drape …  Menempatkan elemen pada surface, 
elevasi atau ketinggian tertentu. 

Offset …  Mengoffset elemen ke jarak tertentu. 
Project …  Memproyeksikan elemen dengan sudut  

tertentu. 
Intersection  Intersect dua buah elemen. 
Follow Surface …  Bentuk elemen yang mengikuti suatu 

surface. 
Smooth Line …  Menghaluskan bentuk elemen pada 

bagian vertex. 
Subdivisions …  Membagi elemen berdasarkan jarak 

atau jumlah pembagiannya. 
Triangles> terdiri dari pilihan berikut: 
 Setting … 

 
Triangulate 
Triangulate in Poly 
Sub Set … 
Intersections 
 
Boundary 
Surface 
Create A Triangle 
 
Close Surface 

Menentukan setting pada saat membuat 
triangle dari CAD. 
Membuat triangle dari design. 
Membuat triangle dalam suatu polygon. 
Membuat suatu subset dari triangle. 
Membuat garis-garis perpotongan 
diantara dua triangle yang dipilih. 
Membuat batas dari suatu triangle.  
Membuat surface dari triangle. 
Membuat triangle dari triangle yang 
sudah ada. 
Menghubungkan antara dua buah 
triangle menjadi triangle yang tertutup. 

Wireframe> terdiri dari pilihan berikut: 
 Link Add 

 
Link Clear 
 
Link Toggle 
Wireframe 
 

Menambah link element baru utuk 
digunakan dalam wireframe. 
Menghapus semua link yang curent dari 
penggunaan. 
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Menu Setting 
 

Menu Submenu  Action 
Drawing > terdiri dari pilihan berikut: 
 Anotation On/Off 

Anotations… 
 
Atribute Manager… 
 
 
COGO Manager… 
 
 
Plane Locking 
Parameters… 

Turn On/turn off anotasi. 
Mengatur tampilan anotasi yang akan 
ditampilkan. 
Membuka atribut manager untuk 
mengatur atribut gambar pada CAD 
window. 
Membuka COGO manager untuk 
mengatur tampilan atribut suatu elemen 
dalam CAD window. 
Memilih plane yang default. 
Mengatur default design parameter. 

Info > terdiri dari pilihan berikut: 
 Design Status … 

 
Details … 
 
Brief Details … 
 
Pick Angle … 
 
Segment Angle … 
 
Dip & Strike … 
 
Slope & Distance … 
Select Set Limits … 
 
Distance between Element 
 
Distance between Segment 
 
Distance Point to Element 
 
Element Plane Intersect 
 
Segment Intersect 
 
 
Measure&angle 
Pick Polygon Volume 

Menampilkan secara detail design file 
yang dipilih. 
Menampilkan semua atribut dari elemen 
yang dipilih. 
Menampilkan statistik dari elemen yang 
dipilih. 
Pick empat titik untuk mengukur sudut 
diantara dua segmen. 
Pick dua segmen untuk mengukur sudut 
diantara dua segmen. 
Mengukur dip dan strike dari suatu 
plane. 
Mengukur slope dari suatu segmen. 
Menampilkan current selection set limit 
dalam feedback area. 
Mengukur jarak terdekat diantara 
element. 
Mengukur jarak terdekat diantara 
segments. 
Mengukur jarak dari suatu titik ke 
sebuah elemen. 
Mengukur intersect point dari elemen 
dan plane. 
Menemukan titik perpotongan dari dua 
segmen dan menampilkannya sebagai 
titik untuk sementara. 
Menghitung jarak dan sudut. 
Menghitung volume polygon. 

Digitiser> terdiri dari pilihan berikut: 
 On 

Restore layout… 
 
Mount Map… 
Remove Map… 
Mount Menu… 
Define Menu… 
Remove Menu… 
Button Mappings… 
Configure… 
Status… 

Turn on/turn off digitizer. 
Menampilkan kembali layout yang 
sudah ada.  
Mount suatu peta. 
Unmount suatu peta. 
Mount menu digitising. 
Menentukan menu digitising. 
Menghapus menu digitising. 
Memetakan puck button digitizer. 
Konfigurasi digitizer. 
Melihat status digitiser. 
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Planes 
Manager… 

 Membuat, clip, update atau 
menampilkan planes dengan 
menggunakan planes manager. 

Selection Sets > terdiri dari pilihan berikut: 
 Info 

 
Manager… 
 
Polygon Fence 
 
Polygon Elemen Fence 

Menampilkan informasi mengenai 
current selection set. 
Membuka selection set manager untuk 
memfilter tampilan elemen grafis. 
Menggambar polygon fence disekeliling 
elemen yang diinginkan. 
Menggunakan elemen yang ada untuk 
memilih elemen yang diinginkan. 

Snapping > terdiri dari pilihan berikut: 
 Snap Vertex 

 
Snap Segment 
Snep Surface 
 
Snap Only 
Float All 
 
Picking 

Snap terhadap suatu vertex jika berada 
dalam jarak snapping. 
Snap terhadap segment yang dipilih. 
Snap terhadap surface dari suatu 
polygon. 
Harus snap untuk memasukkan titik. 
Menggambar garis rubber-banding 
dalam semua window. 
Mengatur parameter konfigurasi picking. 

View > terdiri dari pilihan berikut: 
 View Setting Manager… 

 
GDS Manager… 
 
 
 
Layer Manager… 
Visual Overrides… 
 
 
Clear Overrides 
 
Remap Textures 
 

Membuka View setting manager dan 
menampilkan view setting CAD window. 
Membuka GDS manager untuk 
menentukan graphical data source yang 
akan dilihat dan atau menentukan 
override elemen grafis. 
Mengatur on/off suatu layer. 
Mengatur visual overrides untuk atribut, 
status dan anotasi suatu window, 
reference atau daftar tampilan. 
Mengembalikan tampilan ke keadaan 
semula. 
Memodifikasi texture yang sudah ada. 

 
 
 
 
 
 
 
 
 
Menu Model 
 

Menu Submenu  Action 
Grids > terdiri dari pilihan berikut: 
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 Data… 
Design… 
Table… 
 
Triangle… 
Surface… 
 
Multi Surface… 
Blocks… 
Incusions… 
 
MXL… 
 
In Fill… 
 
No Miss… 
 
Quality… 

Update nilai grid dari data ASCII. 
Update nilai grid dari data design. 
Update nilai grid dengan meng-grid data 
tabel. 
Update nilai grid dari data triangle. 
Update nilai grid dari surface 
expression. 
Grid dari  satu surface atau lebih. 
Update nilai grid dari block solid. 
Membuat nilai grid untuk dimasukkan 
dalam polygon. 
Modifikasi suatu grid dengan 
menggunakan MXL expression. 
Memasukkan nilai kedalam node yang 
kosong. 
Menghapus/menghilangkan nilai yang 
hilang dari grid values. 
Membuat grid dari model quality, hanya 
berlaku untuk page stratmodel. 

Triangles> Menu Triangles terdiri dari pilihan berikut: 
 Data… 

Design… 
Table… 
Boundary… 
 

Membuat triangle dari data ASCII. 
Membuat triangle dari data design. 
Membuat triangle dari data tabel. 
Membuat boundary polygon dari 
triangle yang sudah dibuat. 

 
 
 
Menu Graphics 
 

Menu Submenu Pilihan Action 
Ancillaries > terdiri dari pilihan berikut: 
 Base Grid… 

Section Grid… 
Table… 
 
Sub Table… 
 
Sheet 
 
Grid 
 
Title Box 

Membuat suatu base grid. 
Membuat cross section dari base grid. 
Menampilkan tabel kedalam suatu 
design file. 
Menampilkan subset dari suatu tabel 
kedalam design file. 
Menampilkan sheet ke dalam layer 
suatu  design file. 
Menggambar suatu struktur grid 
kedalam suatu design file. 
Membuat box untuk judul peta. 

Charts>  terdiri dari pilihan berikut: 
 Bar.. 

Line… 
Frequency… 
 
Rosin Rammler… 
 
X Plot… 

Membuat bar chat dari tabel. 
Membuat line chart dari tabel. 
Membuat frequency distribution chart 
dari tabel. 
Membuat Rosin Rammer chart dari 
tabel. 
Membuat crossplot dari suatu tabel. 

Contour  Membuat kontur dan outputnya 
disimpan dalam design file. 

Mesh > terdiri dari pilihan berikut: 
 Grid… 

Surface… 
Expression… 

Membuat mesh dari grid. 
Membuat mesh dari surface. 
Membuat mesh dari surface expression. 

Post > terdiri dari pilihan berikut: 
 Grid … Membuat post dari grid. 
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Table… 
 

Membuat post dari table. 

Section > terdiri dari pilihan berikut: 
 Block… 

Block Expose… 
Surface… 
Surface Expose… 
 
Wireframes… 
 
Elements… 
Polygons… 

Membuat section dari block solid. 
Intersect surface dengan solid. 
Membuat section melalui surface. 
Membuat interset dari dua buah 
surface. 
Membuat cross section melalui 
wireframes. 
Membuat suatu section melalui elemen. 
Membuat cross section polygon dari 
design file. 

 
 
Menu Help 
 

Menu Submenu Pilihan Action 
About…  Mengakses informasi tentang versi 

software minescape, current project dan 
session dengan menampilkan form help 
about. 

On Context…  Akses ke context sensitive help. 
Manuals…  Akses ke Online Manual. 
Mscape3 to 
Mscape4 … 

 Menjalankan proses konversi dari menu 
Minescape versi 3 ke Menu Minescape 
versi 4 

Reference > terdiri dari pilihan berikut: 
 Module 

MPL 
 
MXL 

Akses reference help untuk modul. 
Akses reference help untuk MPL 
function. 
Akses reference help untuk MXL 
function. 

 
 

1.1.2 Tool Bar 

Tool Bar menampilkan informasi status current page dan terdiri dari short cut dan 
field yang menunya dapat dipilih sewaktu-waktu.  
 
Komponen pada Tool Bar page Minescape selalu ada untuk semua page. Tool Bar 
dapat dikonfigurasi, di-turn on dan turn off sesuai dengan yang  diinginkan. 
 
Untuk mengkonfigurasi Tool Bar pilih menu berikut: 
 
Page>Preference>Toolbar Options 
 
Untuk turn off Tool Bar pilih menu berikut: 
 
Page>Preference>Toolbar tidak dipilih ( ). 
 

Untuk turn on Tool Bar pilih menu berikut: 

Page>Preference>Toolbar dipilih (√ ). 
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1.1.3 Icon Bar 

Icon bar adalah suatu menu yang terdiri dari pallete dan tombol icon yang dapat 
dipilih sewaktu-waktu. 
 
Icon bar dapat dikonfigurasikan, di-turn on dan turn off sesuai dengan yang anda 
inginkan. 
 
Untuk mengkonfigurasi icon bar pilih menu berikut: 
 
Page>Preference>Iconbar Options 
 
Untuk turn off icon bar pilih menu berikut: 
 
Page>Preference>Iconbar tidak dipilih ( ) 
 

Untuk turn on Icon bar pilih menu berikut: 

Page>Preference>Iconbar dipilih (√ ) 
 

1.1.4 Work Area 

Work area adalah CAD window yang digunakan untuk menampilkan dan 
memanipulasi elemen grafis. 
 

1.1.5 Feedback area 

Feedback area menyediakan informasi dari page work area secara terus menerus. 
Informasi tersebut ditampilkan dibawah work area. 
 
Feedback area terdiri dari 3 bagian yaitu: 
 
• Prompt area 
• Massage feedback area 
• Docking Area 
 
Feedback area dan bagian-bagiannya dapat diturn on dan turn off. Untuk turn off 
feedback area pilih menu berikut: 
 
Page>Preference>Feedback tidak dipilih ( ) 
 
Prompt Area 
Prompt area akan menampilkan tahapan-tahapan yang harus dilakukan yang 
berhubungan dengan action current page yang dipanggil. Sebagai contoh jika anda 
membuat garis pada CAD window, prompt area akan memberitahukan tahapan-
tahapan yang harus anda lakukan untuk membuat garis. 
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Prompt area dapat di-turn on dan turn off. Untuk turn off prompt area pilih menu 
berikut: 
 
Page>Preference>Prompt tidak dipilih ( ) 
 
Message Feedback Area 
Pesan feedback area terdiri dari informasi dan peringatan yang berhubungan 
dengan proses-proses system. 
 
Pesan pada feedback area dapat dihapus dengan cara highlight text dan tekan 
[Delete].  Selain itu ukuran feedback juga dapat diubah dengan cara drag kiri  
sashed sampai ukuran yang diinginkan. 
 
 
Docking Area 
Docking area menampilkan current status dari setiap model batch yang dijalankan 
dan ditandai oleh icon yang menandakan status batch tersebut. 
 
Docking area dapat di-turn on dan di-turn off. Untuk turn off docking area pilih menu 
berikut: 
 
Page>Preference>Docking tidak dipilih ( ) 
 
Status Bar 
Status bar ditampilkan langsung dibawah page feedback area dan menampilkan 
aktivitas Gti yang sedang berlangsung.  
 
Status bar terdiri dari area berikut: 
 
• Koordinat tracking area. Menunjukan titik-titik koordinat dari posisi titik kursor 

mouse di dalam current drafting plane. 
• Working status area. Menampilkan pesan-pesan singkat yang berkaitan dengan 

aktivitas Gti misalnya pada saat suatu form sedang diload dan menampilkan 
status activity indiktor. 

 
Status bar dapat dikonfigurasi, turn on dan turn off. 
 
Untuk mengkonfigurasi status bar pilih menu berikut: 
 
Page>Preference>Status Options 
 
Untuk turn off Status Bar pilih menu berikut: 
 
Page>Preference>Status tidak dipilih ( ) 
 
Untuk turn on Status Bar pilih menu berikut: 
 
Page>Preference>Status dipilih (√ ). 
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1.2 Monitor Page 

Monitor page digunakan untuk memonitor semua aktivitas module dalam pojects 
serta mengontrol module yang sedang dijalankan. 
 
 
 

 

Menu Bar 

Batch List  

Window 

Batch Display 

Filters 

Batch  

Options 

 
Monitor page terdiri dari feature berikut: 
 
• Menu Bar 
• Batch list Window 
• Batch List Filters 
• Batch Options. 
 
Menu Bar 
Untuk mengontrol module execution pilih menu berikut: 
 
Monitor Page>Set Up 
 
Sebuah form akan ditampilkan seperti berikut: 
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Pada field Maximum running anda dapat mengetikkan angka dari mulai 1 – 6 untuk 
mengatur jumlah modul execution. Misalnya jika anda mengisi angka 1 pada field 
tersebut maka proses  akan dijalankan satu persatu.. 
 
Batch List Window 
Batch list window menampilkan daftar batch yang sudah dipilih. Daftar batch dapat 
dihapus dengan cara klik kiri batch-batch yang akan dihapus kemudian pilih tombol 
Delete. 
 
Atau jika semua daftar batch akan dihapus anda tinggal pilih tombol All kemudian 
pilih tombol Delete. 
 
Batch List Filter 
Batch display filter memungkinkan anda untuk memfilter tampilan batch-batch dalam 
batch List window. Batch Display Filter terdiri dari tombol-tombol icon yang masing-
masing mewakili status batch. Secara default minescape akan menampilkan semua 
status batch. Jika anda tidak ingin menampilkan Pending batch, maka pilih tombol 
Pending. 
 
Batch Options 
Batch option memungkinkan anda untuk mengubah status batch yang dipilih dalam 
batch List window. Batch options terdiri dari sejumlah tombol-tombol yang masing-
masing mewakili status batch. Pada saat anda memilih tombol yang tersedia status 
batch yang dipilih akan diaplikasikan sesuai dengan tombol yang dipilih. Misalnya,  
jika anda ingin mengubah status batch dari running menjadi stop, maka pilih batch 
yang statusnya akan diubah kemudian pilih tombol Stop. Selain itu anda dapat 
menghapus batch-batch yang telah selesai prosesnya dengan cara memilih batch-
batch yang akan dihapus pada batch list window kemudian pilih tombol Delete. 
 
1.3 Menutup Page 

Untuk menutup page yang telah dibuka pilih menu berikut: 
 
Page>Close Page 
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Sebuah pop-up konfirmasi berikut ditampilkan: 
 

 
 
Pilih OK untuk menutup page. 
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1 Design File 

Design file adalah suatu fasilitas dalam Minescape yang digunakan untuk 
menyimpan data grafis. 
 
Didalam Minescape ada dua jenis design file, yaitu: 
 
• Design file 2D, yang memungkinkan memasukkan dan memanipulasi data dalam 

koordinay X dan Y saja. 
• Design file 3D yang memungkinkan memasukkan dan memanipulasi data dalam 

koordinat X, Y dan Z. 
 
Design File menyimpan data grafis elemen yang dapat ditampilkan dalam sebuah 
CAD window.  Design File dapat dimanipulasi pada CAD melalui modul dengan 
menggunakan perintah-perintah pengguna.  Sebuah Design File terdiri dari 
beberapa elemen grafis yang dibentuk dari koordinat-koordinat X, Y dan Z (yang 
sebenarnya), serta tampilan atribut dan data yang berkaitan.  Setiap elemen grafis 
dapat dilihat dan dimanipulasi tersendiri atau bersamaan dengan elemen grafis 
lainnya. 
 
Design File dapat menerima masukan yang berasal dari data survey, data 
pengeboran, peta foto udara, gambar dan lain-lain.  Anda juga dapat memasukkan 
data secara langsung dengan cara menggambar elemen grafis dalam CAD window.  
Jenis data tersebut dapat digunakan untuk menghasilkan kontur, section, mesh, 
business graphics, peta-peta dan gambar. 
 
Setiap project dapat berisi bermacam-macam Design File, dimana keterbatasan 
yang ada hanyalah pada kapasitas disk.  Design File dibuat dalam direktori project 
designs dan namanya diberi akhiran .dgn. 
 

1.1 Komponen-Komponen Design File 

Data Design File disimpan dalam sejumlah Layer  yang berdiri sendiri dimana 
elemen-elemen disimpan. Setiap elemen dimiliki oleh sebuah kelas elemen tertentu 
dan mempunyai sebuah identitas unik.  Tampilan suatu elemen dimodifikasi oleh 
atribut-atribut yang mengontrol tampilannya. 
 

1.1.1 Layer 

Sebuah design file terdiri dari elemen-elemen yang dihasilkan dari bermacam-
macam pengoperasian termasuk eksekusi modul dan pemasukan informasi secara 
langsung kedalam CAD window. Untuk mengontrol dan mengatur pengoperasian 
elemen dasar, elemen-elemen tersebut disimpan dalam sebuah rangkaian Layer 
yang diberi nama. Seluruh Layer dibuat dalam sebuah design file yang merupakan 
bagian umum dari global origins dan secara bersamaan akan mempunyai hubungan 
antar project untuk menyetarakan penyimpanan elemen dalam design file yang 
sama. 
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Untuk memungkinkan anda mengontrol tampilan data design file dalam sebuah CAD 
window, Layer dapat diaktifkan dan dimatikan secara sendiri-sendiri satu sama 
lainnya.  Fleksibilitas ini memungkinkan anda untuk menampilkan Layer mana saja 
secara terpisah, atau sebuah kombinasi dari beberapa Layer yang lain. 
 
 
Sebuah Design File mungkin hanya terdiri dari satu atau beberapa layer.  
 
Layer adalah tingkatan informasi yang berdiri sendiri didalam design file yang 
memungkinkan data grafis dan data yang berhubungan disimpan didalamnya.  
Contoh spesifik ialah dengan menggunakan layer untuk menyimpan data output dari 
berbagai macam sumber untuk memudahkan pembedaan. 
 
Sebuah layer dapat dipergunakan seperti sebuah transparency dari sebuah 
overhead projector.  Dimana layer dapat disimpan di atas layer lainnya untuk 
membentuk sebuah model secara rinci yang berisi beberapa tingkatan informasi 
yang terlihat berkesinambungan. 
 
Dalam konteks yang sama, anda juga dapat melihat layer tersebut secara satu 
persatu.  Anda dapat menampilkan Layer dalam berbagai kombinasi dan 
menambahkan atau menggantinya dari tampilan  CAD window secara sendiri-
sendiri. Layer membantu anda mempunyai fleksibilatas yang sangat tinggi untuk 
melihat data grafis di dalam CAD window, seperti diilustrasikan dalam gambar 
berikut ini: 
 
Menampilkan layer-layer yang berbeda 

 
Setiap design file dapat terdiri dari 1024 Layer, mulai nomor 0 – 1023.  Layer-layer 
ini dibagi ke dalam: 
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No. Layer Keterangan 

0–999 User/modul penempatan Layer.   Nomor terendah yang 
tersedia di berikan untuk setiap Layer baru. 

1000–1021 Layer-layer grafis sementara, nomor yang tertinggi 
diberikan untuk setiap user. 

1022 PLOTSLOT Layer yang bekerja. 

1023 Layer grafis temporer yang sudah lama (kemungkinan 
bertabrakan pada multi-user). 

 
Sebuah Design File dapat berisi sampai dengan 1000 user-specified layer, mulai 
nomor 0 sampai dengan 999 (Layer 1000 sampai 1023 merupakan grup khusus 
yang digunakan oleh CAD subsystem).  Setiap Layer diidentifikasi dengan: 
 
• Sebuah nomor  
• Sebuah nama (optional) 
• Sebuah title (optional) 

 

1.1.2 Elemen–elemen 

Data disimpan dalam sebuah Layer sebagai rangkaian dari elemen-elemen.  Setiap 
elemen tersebut mempunyai hubungan kelas objek.   Environment   daftar kelas 
tersebut terdiri dari nama-nama kelas objek yang ada.  Berikut ini adalah kelas-kelas 
dari elemen-elemen: 

 
Titik-Titik (Point String) 
Sebuah point string digunakan untuk menyimpan satu rangkaian  data titik yang 
tidak berhubungan yang secara grafis ditampilkan dalam bentuk rangkaian  tanda-
tanda (markers) atau simbol-simbol. Elemen-elemen ‘Point string’ dapat digunakan 
untuk menyimpan hal-hal berikut, contohnya: 
 
• Titik Ketinggian (spot high) 
• Lokasi Drill Hole 
• Cultural Feature 

 
Setiap vertex atau koordinat dapat berdiri sendiri dan pengelompokkan kedalam 
sebuah elemen single hanya merupakan mekanisme untuk mengurangi 
penyimpanan.  Sampai dengan 1000 data titik dapat disimpan dalam sebuah elemen 
‘single point string’. 
 
Garis-Garis (Line String) 
Sebuah ‘line string’ merupakan suatu rangkaian titik-titik yang berhubungan, dan 
secara grafis ditampilkan sebagai sebuah rangkaian garis-garis dan tanda-tanda 
atau simbol-simbol tertentu. Rangkaian tititk-titik tersebut merupakan suatu 
gabungan atribut dari data yang ada.  ‘Line string’ dapat digunakan untuk 
menghasilkan hal berikut, contohnya: 
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• Garis Kontur. 
• Section dari surface. 
• Garis Toe dan Crest. 
• Jalan dan tampilan umum lainnya. 

 
Sampai dengan 1000 data titik yang berhubungan dapat disimpan di dalam sebuah 
elemen ‘single line string’. 

 
Polygon (Polygon String) 
A polygon is a set of connected points that encloses an area. The enclosed area can 
be graphically represented as a filled and/or as a closed series of lines and optional 
markers or symbols. Polygon elements can be used to store, for example:  
 
 
Sebuah Polygon merupakan satu rangkaian titik-titik yang  saling berhubungan yang 
membentuk/menutup sebuah area. Area yang tertutup tersebut dapat digambarkan 
secara grafis sebagai sebuah isian dan/atau sebagai sebuah rangkaian garis 
tertutup.  Elemen-elemen Polygon dapat digunakan untuk menyimpan hal berikut,  
contohnya: 
 
• Batas Daerah 
• Permukaan Solid 
• Layout Blok. 

 
Polygon juga dapat digunakan untuk meng-clip data lainnya, biasanya digunakan 
dalam menghitung volume, dan dapat membantu menyediakan informasi rinci 
mengenai suatu area.  Sampai dengan 1000 data titik-titik yang berhubungan dapat 
disimpan untuk menampilkan  area yang diinginkan   
 
Teks ( Text String) 
A text string contains a set of character information that is graphically represented as 
a series of line strokes according to the predefined font definition. Font definitions for 
the CAD window and plotter are currently built into the actual programs and cannot 
be changed. Text string elements can be used for: 
 
Sebuah ‘Text String’ terdiri dari  rangkaian informasi karakter yang secara grafis 
ditampilkan sebagai sebuah garis yang tergantung kepada definisi jenis huruf (font) 
yang ditentukan sebelumnya. Definisi-definisi ‘font’ untuk CAD dan plotter pada saat 
ini dibuat dalam bentuk program aktual dan tidak dapat diubah.  Elemen ‘Text String’ 
dapat digunakan untuk: 
 
• Judul dan deskripsi 
• Penamaan features secara umum. 

 
NoVertex 
Elemen-elemen NoVertex tidak mempunyai atribut-atribut grafis atau tampilan, 
sehingga sulit untuk memanipulasinya dalam CAD atau modul-modul umum. 
Elemen-elemen NoVertex dapat digunakan sebagai: 
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• Parent  dari satu set objek grafis. 
• Child penghubung yang merangkum aliran objek informasi. 
• objek yang diberi nama  untuk merangkum informasi umum. 
 
Catatan: Karena tidak adanya tampilan grafis yang dapat dipakai, anda perlu  menelusuri  

elemen-elemen tersebut melalui mekanisme parent/child, elemen ID atau  nama 
yang diingat. 

 

1.1.3 Display Definition 

Display Definition merupakan definisi yang terdiri dari setting atribut elemen grafis. 
Display Definition digunakan oleh setiap modul Minescape pada saat sebuah modul 
memindahkan data ke sebuah Design File (atau sebuah Triangle file).  Contoh, 
Stratmodel menggunakan Display Definition untuk membatasi atribut-atribut dari 
setiap interval yang akan dimodel. 
 
Setiap jenis surface menggunakan Display Definition sehigga  grafis surface tersebut 
akan mempunyai atribut grafis  dari Display Definition. Minescape akan mengalami 
beberapa kesalahan dalam penggunaan Display Definition apabila cara penggunaan 
Display Definition tidak dibatasi.  Seluruh Display Defintions dapat diedit. 
 
Dikarenakan karakteristik tampilan akhir dikontrol oleh banyaknya setting atribut, 
maka Minescape Environment menyediakan sebuah metoda dimana atribut-atribut 
tersebut dibagi kedalam grup (atau bundle) dan diberi nama.  Penggrupan  tersebut 
dinamakan Display Definition. 
 

1.1.3.1 Struktur Display Definition 

Sebuah display definition terdiri dari: 
 
Sebuah nama yang panjangnya dapat mencapai16 karakter. 
 
Sebuah vector count – memungkinkan sebuah display definition kembali ke simbol 
setting yang berbeda berdasarkan nilai vector field dari elemen tersebut.  Hal ini 
digunakan agar output grafis berubah berdasarkan nilai variabel kontrol, contoh: 
pengeluaran satu set dari nilai kontur tertentu.  Bila sebuah display definition 
digunakan tanpa vector, seluruh garis kontur akan mempunyai simbol yang sama, 
sementara dengan menggunakan vector, macam-macam atribut dapat diubah 
berdasarkan jenis nilai kontur yang dikeluarkan. 
 
Atribut-atribut tersebut berupa: 
 
• Warna 
• Jenis garis 
• Jenis tanda 
• Pattern Index 
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Vector count dapat di atur mulai 1 (angka pertama yang biasa tampil dalam display 
definition) sampai dengan panjang maksimum vector yang diinginkan - Batas 
maksimum membatasi jumlah nilai atribut yang berbeda yang digunakan.  
 
Sebagai contoh, kalau Vector count di atur  pada angka 5 dan colour-nya cycle 
(lihat atrribute settings), maka nilai kontur yang keluar dengan warna tersebut adalah 
1, 2, 3, 4, 5, 1, 2, 3, 4, 5, dll.  Namun, bila colour di set ke merah, vector count-nya 
tidak akan mempengaruhi efek warna. 

 

1.1.3.2 Setting Atribut 

Display definition dapat membatasi setting untuk atribut-atribut berikut: 
 
• Warna 
• Jenis tanda 
• Jenis garis 
• Ketebalan garis 
• Kehalusan jenis 
• Fill Pattern 
• Size Fill Pattern. 
• Pattern Angle 
• Huruf teks 
• Ukuran teks 
• Sudut teks 
 
Atribut-atribut warna, jenis garis, jenis tanda dan fill pattern dapat di diatur untuk  
setiap nilai pada daftar environment yang benar atau Cycle, yang mengkhususkan  
perputaran daftar atribut dengan menggunakan batasan untuk display definition dan 
vector field yang disimpan dalam elemen. 
 
Display definition digunakan oleh modul-modul yang mengeluarkan grafiks untuk 
mengontrol keluaran simbol.  Sebagai contoh, garis-garis kontur ditampilkan 
menggunakan setting atribut yang berlaku dari MAJORCONTOUR dan 
MINORCONTOUR untuk kontur INTERVAL dan VALUE CONTOUR untuk kontur 
VALUE. 
 
Note: Contoh display definition yang digunakan untuk CONTOUR  merupakan defaults 

dan dapat diubah. 
 

1.1.3.3 Membuat Display Definition 

Display definition dapat dibuat cara berikut ini: 
 
Buka Minescape Explorer dengan memilih Page>Current>Minescape Explorer dari 
Menu Bar atau dengan memilih tombol Minescape Explorer dari Tool Bar. 
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Ekspansi/pilih hirarki Environment. 
 
Pilih folder Display Definition 
 
Pilih tombol Create – form berikut ini akan terbuka: 
 
Masukkan nama untuk Display Definition yang baru ke dalam field Names. 
 
Ubah fields yang diperlukan dengan memilih dari daftar pilihan pull-down atau 
dengan mengekspansi panel dengan memilih tombol   .  
 

1.1.3.4 Viewing Display Definition 

Display Definition dapat dilihat dengan cara berikut ini: 
 
Pilih salah satu display definition dalam field display definition. 
 
Pilih view dari menu – form yang muncul akan serupa dengan form pada creating 
display definition. 
 

1.1.3.5 Mengedit Display Definition 

Untuk membuat perubahan-perubahan pada display definition, gunakan fungsi edit. 
 
Pilih salah satu display definition dalam field display definition. 
 
Pilih edit dari menu – form yang muncul akan serupa dengan form pada creating 
display definition. 
 

1.2 Current Design File (atau WRITE) 

Design File merupakan sumber utama data grafis pada Minescape.  WRITE 
DESIGN FILE, disebut juga sebagai current Design File atau WRITEDESIGN, 
adalah file dimana anda mempunyai akses penulisan yang tidak terbatas dari CAD.   
File Write Design harus terdiri dari sebuah current layer – hanya data dalam layer 
yang dapat di up-date dan hanya satu Write Design file yang diperbolehkan  dalam 
setiap satu work page. 

 
Anda dapat mengubah current Design File dan current Layer setiap saat.  Nama  
current Design File dan current Layer ditampilkan dalam Tool Bar.  Tombol Tool Bar 
juga menyediakan mekanisme untuk mengubah WRITEDESIGN. 
 
Seperti pada current Layer, current Design File dapat menampung  beberapa  Non-
current Layer yang aktif (ingat, sebuah Design File dapat terdiri dari 1000 layer). 
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1.2.1 Menentukan Current Design File 

Current Design File dapat ditentukan  dengan menggunakan cara berikut ini: 
 

 
 

 
 
Kemudian pilih nama design file yang ingin ditampilkan sebagai current design file. 
 

 
 

 
 

1.2.2 Mengubah Current Design File 

Anda dapat mengubah current design file dengan cara berikut: 
 
 
 
 
 
Catatan: tampilan terakhir dari data dalam file yang ada, disimpan pada saat anda 

mengubah design file. 
 

1.3 Membuat Design File 

Pada saat membuat project sebetulnya Minescape secara otomatis telah membuat 
dua buah design file yaitu design file Blocks  dan Surface. Jika anda ingin membuat 
design file baru gunakan menu berikut: 

Curent 

Design file 

Open Write Design file 
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Minescape Explorer>Folder Design Files>Create 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 

 
Panel Design File 
• Name. Nama design file yang akan dibuat (tutorial). 
 
Spatial Orientation: 
• Origin Easting, Northing dan Elevation. Koordinat origin untuk easting dan 

northing serta origin elevasi. 
• Dimension. Dimensi dari design file apakah 2D atau 3D. 
• Quadran. Pertambahan nilai X ke arah kanan dan nilai Y ke arah atas. 

Pilihannya ada dua yaitu NE dan SE. 
 
Units Panel 
• Internal unit. Satuan unit yang digunakan. Pilihannya adalah metres, 

centimetres, milimetres dan sebagainya. 
 
Pilih OK  atau Apply. 
 

1.4 Memasukkan Data kedalam Design File 

Berbagai  format data dapat dimasukkan kedalam design file. Adapun data yang 
dapat dimasukkan dapat berupa: 
 
Berasal dari software selain Minescape 
• DXF/DWG Format. 
• AS2482 (Standard Australia untuk interchange dan pemetaan digital) 
• MOSS-Genio 
• Surface (program survey/perencanaan tambang). 
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• MICROLYNK (program survey dan perencanaan tambang dengan menggunakan 
PC). 

• Features umum termasuk data X, Y, Z. 
• Miner2 
 
Berasal dari Minescape 
• Dari suatu model, blok tambang, triangle, titik bor dan data survey. 
• Output grafis dari model seperti plot file mincom. 
• Digitize menggunakan CAD. 
• Penggambaran melalui CAD. 
• Sebuah MPL program yang dibuat oleh pengguna. 
 
Untuk memasukkan data kedalam design file gunakan menu berikut: 
 
Minescape Explorer>Folder Design Files>Import 
 
Berikut adalah contoh memasukkan data topografi dalam format DXF kedalam 
design file.  
 

 
 
Input Panel 
• DXF file. Nama dari file data dxf. Ketikkan nama file atau pilih dari menu pull-

down (segitiga hitam). 
 
Output Panel 
• Design file. Nama design file dimana output grafis hasil import akan disimpan. 
• Layer. Nama layer dimana output grafis hasil import akan disimpan. 
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• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 
dalam design file, maka jika field append dipilih (3), output grafis akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh grafis yang dimasukkan. Field 
ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari grafis 
yang berada dalam layer. 

 
Controls Panel 
• Layer prefix. Jika layer prefix diisi, maka nama layer dimana output grafis 

disimpan akan  mempunyai prefix sesuai dengan yang dimasukkan. Misalnya 
nama layer asli dari file dxf adalah topo_dig kemudian pada field layer prefix 
diisi a maka nama layer dimana output grafis disimpan menjadi atopo_dig. 

• Colour mapping  dan Line style mapping. Atribut warna dan garis untuk output 
grafis. 

 
Pilih OK atau Apply. 
 

1.5 Mengeluarkan Data dari Design File 

Data dapat di ekspor dari sebuah Design File kedalam jenis-jenis file yang ada di 
bawah ini.  Pilihan-pilihan yang tersedia di dalam Minescape dapat dipilih dengan 
cara memilih salah satu Tab-Dividers yang diperlihatkan pada contoh berikut ini: 
 
Dumps Dumps isi Design File kedalam  suatu file ASCII dump. 
DXF Mengeluarkan suatu Design File kedalam file DXF. 
Genio Dump data Design File dalam form Genio F12.3.  Sebuah Spec 

pemetaan digunakan untuk memetakan Display Definition dan nama-
nama Layer untuk menunjukkan ID (identitas). 

M2Culture Mengeluarkan data Design File kedalam suatu form Miner2 Cultural. 
Vulcan Mengeluarkan data Design File kedalam suatu dump file Vulcan. 
Unload Mengeluarkan isi Design File kedalam file data ASCII. 
XYZ Mengeluarkan data Design File ke dalam form file data X, Y, Z. 
 
Data yang terdapat didalam design file dapat dikeluarkan dalam berbagai format 
seperti DXF, XYZ, Vulcan dan sebagainya dengan menggunakan menu berikut: 
 
Minescape  Explorer>Folder Design Files>Export 
 
Dibawah ini contoh mengeluarkan data dari design file kedalam format DXF. 
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Input Panel 
• Design file. Nama design file dimana layer grafis yang datanya akan dikeluarkan 

disimpan. 
• Search layers. Nama-nama layer dimana elemen grafis yang datanya akan 

dikeluarkan disimpan. Untuk memilih layer klik tanda … kemudian pilih layer-
layernya. 

 
Output Panel 
• DXF file. Nama output file. 
 
Pilih OK  atau Apply. 
 

1.6 Mengolah Data Design File 

Minescape menyediakan beberapa fasilitas untuk mengolah data yang disimpan 
dalam design file yang dapat dilakukan dengan memilih menu berikut: 
 
Minescape Explorer>Folder Design Files> Process 
 
• Search. Mencari elemen-elemen design file yang sesuai dengan kriteria 

pencarian yang ditentukan. Outputnya adalah berupa nomor ID elemen. 
• Drape. Menempatkan elemen-elemen grafis baik secara individu maupun 

kelompok ke surface tertentu. Elevasi dari elemen yang asli akan diubah dan 
diganti sesuai dengan elevasi surface dimana elemen grafis ditempatkan. 

• Reduce. Pengurangan jumlah elemen, jumlah vertex dalam suatu design file 
dengan cara menghilangkan vertex-verex yang tidak digunakan. 
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• Link. Menghubungkan line string yang disimpan dalam layer yang sama, 
menyediakan titik-titik akhir dari garis yang terletak pada jarak tertentu. 

• Intersect line. Mencari dan membuat titik perpotongan dari line string dan 
menghilangkan titik-titik dan segmen-segmen duplikat dalam line string. 

• Merge. Penyesuaian koordinat dari titik-titik dalam sebuah line string, point string 
atau polygon yang terletak di dalam suatu jarak yang ditentukan sehingga titik-
titik yang disesuaikan tersebut akan terletak pada koordinat yang sama. 

• Clip. Menghapus elemen-elemen grafis baik yang terdapat diluar atau didalam 
polygon. 

 

1.7 Mengcopy Data Design File  

Elemen dan layer yang terdapat dalam suatu design file dapat dicopy ke design file 
lain baik dalam projects yang sama maupun berbeda. Jika yang akan dicopy berupa 
elemen, maka anda harus memasukkan nomor ID elemen yang akan dicopy. 
Sedangkan jika yang dicopy layer maka anda harus memilih/mengetikkan layer yang 
akan dicopy. 
 
Untuk mengcopy data baik berupa elemen grafis maupun layer gunakan menu 
berikut: 
 
Minescape Explorer>Design Files>Pilih Salah Satu Design File>Copy 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 
 
 
Output Panel 
Design file. Nama design file dimana hasil copy akan disimpan. 
 
Input/Output Panel 
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• Input design file. Nama design file dimana elemen grafis atau layer yang akan 
dicopy disimpan. Jika elemen grafis atau layer yang akan dicopy berada pada 
project yang sama, maka anda tinggal memasukkan nama design file atau pilih 
dari menu pull-down. Jika elemen grafis/layer yang akan dicopy berada pada 
project yang berbeda, maka anda harus klik kanan pada field tersebut kemudian 
pilih Projects. Sebuah form akan ditampilkan kemudian pada field projects pilih 
nama project dimana elemen grafis/layer yang akan dicopy disimpan dan pada 
field File name  masukkan nama design file. 

• Input layer. Nama layer dimana elemen grafis/layer yang akan dicopy disimpan. 
• Output. Nama layer dimana output elemen grafis/layer hasil copy disimpan. 
• Overwrite. Jika anda memasukkan nama layer yang sama dengan yang telah 

ada dalam design file, maka jika field overwrite diisi Yes, maka layer yang telah 
ada isinya akan diganti (overwrite) oleh grafis yang dimasukkan. Jika field 
Overwrite diisi No, maka output grafis akan ditambahkan pada layer tersebut. 
Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

 
Pilih OK  atau Apply 
 

1.8 Menghapus Data Design File (Layer) 

Jika suatu layer sudah tidak diperlukan lagi maka dapat dihapus dengan 
menggunakan menu berikut: 
 
Minescape Explorer>Hirachy Design Files>Pilih Design File>Pilih Layer>Delete 
 

1.9 Menghapus Design File 

Jika design file sudah tidak diperlukan maka dapat dihapus dengan menggunakan 
menu berikut: 
 
Minescape Explorer>Folder Design>Pilih Design Files>Delete 
 

1.10 Menampilkan Nama Design File 

Untuk menampilkan semua nama design file yang telah dibuat pilih menu berikut: 
 
Minescape Explorer>Folder Designs 
 
Nama design file akan ditampilkan disebelah kanan pada minescape explorer. 
 

1.11 Bekerja Dengan Layer Design File 
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1.11.1 Layer Manager 

Layer Manager memungkinkan Layer Design File untuk diaktifkan atau tidak dalam 
CAD window.  Current Write Layer juga dapat diubah.  Current Write Layer 
diperlihatkan dalam field Layer Name dalam panel Current Write Layer  dan selalu 
ditampilkan.  Semua Layer yang ditampilkan dalam CAD window diperlihatkan dalam 
panel Display Layer dan layer yang tidak ditampilkan diperlihatkan dalam panel 
Source Layer. 

 

1.11.1.1 Membuka Layer Manager 

Untuk membuka Layer Manager Pilih tombol Layer Manager dari Tool Bar. 
 

 
 

 
Layer dapat dipilih atau tidak dipilih agar ditampilan dalam CAD window dengan 
memindahkan panel-panel Source Layer dan Display Layer dengan menggunakan 
tombol-tombol berikut ini: 
 
Untuk menambahkan sebuah layer tunggal: 
Hitamkan (klik tombol kiri) Layer yang akan ditambahkan dan tekan > Cara lain, 
hitamkan Layer yang diinginkan dan tekan dua kali tombol kiri.  Layer yang 
diinginkan akan pindah ke panel Display Layer.  
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Untuk menambahkan multiple non-continuous layer: 
Hitamkan ([Ctrl]-klik tombol kiri) Layer yang ingin ditambahkan dan tekan >. 
 
 
Untuk menambahkan multiple continuous layer: 
Hitamkan (klik tombol kiri) Layer pertama yang akan ditambahkan. 
Hitamkan ([Shift]-tekan tombol kiri) Layer terakhir dalam pilihan untuk ditambahkan 
(seluruh Layer diantara kedua Layer yang dipilih akan terbawa) dan tekan > 
 
atau 
 
Hitamkan (tekan tombol kiri dan drag/tarik) kebawah Layer-Layer yang dipilih untuk 
ditambahkan dan tekan  >. 
 
 
Untuk menambahkan seluruh layer: 
Cukup tekan >> Seluruh Layer akan dipindahkan ke panel Display Layer. 
 
Untuk tidak memasukkan layer yang tidak diinginkan 
Untuk Tidak memasukkan (tidak dipilih) sebuah layer, [Ctrl] tekan tombol kiri sekali 
lagi. 
 
Field Filter memungkinkan anda untuk memindahkan Layer diantara panel-panel 
Source Layer and Display Layer dengan menggunakan sebuah ‘wildcard’ contoh: 
A*, memilih seluruh Layer yang namanya dimulai dengan huruf A.  Masukkan 
sebuah ‘filter expression’ dan tekan tombol Filter atau tombol perintah yang ada 
seperti  
 

1.11.2 Current Layer 

Tiap elemen-elemen data yang dibuat dalam sebuah CAD window ditempatkan 
kedalam current layer dari current design file.  Hanya satu Current Layer dapat 
berada di setiap page, walaupun Current Layer dapat diubah setiap saat. 
 

1.11.2.1 Menentukan/Merubah Current Layer 

Nama dari Current Layer ditampilkan pada Current Design Layer dalam Tool Bar.  
 
 
 

 
 
Untuk menentukan atau mengubah Current Design File Layer dalam CAD window, 
pilih sebuah Layer menggunakan tombol pull down dari daftar layer yang ada 
(seluruh Layer dari Current Design File tersedia dalam daftar pilihan). 

 

Current Layer 
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1.11.2.2 Membuat Current Layer 

Anda dapat membuat sebuah Current Layer secara manual dalam sebuah CAD 
window.  Ketika anda membuat Layer ini, Layer tersebut tidak akan berisi data 
apapun – data dapat ditambahkan secara interaktif menggunakan CAD sementara 
Layer tersebut current. 
 
Cara membuat sebuah Current Layer 
 
1. Pilih Current Design Layer di dalam Tool Bar, tekan tombol kanan – menu pull-

down  akan muncul   . 
2. Pilih Create dari menu pull-down – form berikut ini akan muncul: 
 

 
 
3. Masukkan sebuah nama untuk Current Layer yang baru di dalam Layer field. 
4. Sebuah title untuk Layer tersebut juga dapat ditambahkan/dimasukkan. 
5. Tekan OK untuk membuat Layer. 

 

1.11.2.3 Non-Current (Active) Layer 

Non-current Layer adalah semua Layer dari current design file yang masih aktif 
(contoh dapat ditampilkan dalam sebuah CAD window) tapi tidak dapat di ubah atau 
diperbaharui. 
 

1.11.2.4 Mengaktifkan dan Menonaktifkan Layer 

Pada saat sebuah design file di akses untuk pertama kali, seluruh Layer dinyalakan 
(atau aktif).  Oleh karena itu seluruh data dalam design file akan terlihat dalam CAD 
window.  Setiap Layer dapat dinyalakan dan dimatikan sendiri-sendiri satu sama 
lain.  Data hanya akan ditampilkan untuk Layer-Layer yang dinyalakan saja. 
 
Layer-layer aktif dapat dimatikan (sebagai contoh dihilangkan dari tampilan CAD 
window) dengan menggunakan cara berikut ini: 

 
Pilih tombol Layer Manager dari Tool Bar. 
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Layer-Layer yang dinyalakan akan terdapat dalam daftar Display Layers di dalam 
Layer Manager. 
 
1. Pilih satu atau beberapa Layer yang ingin dimatikan. 
 
2. Pilih  tombol < untuk memindahkan Layer-Layer yang dipilih dari panel  
 
3. Display Layer ke panel-panel Source Layer atau pilih tombol << untuk 

memindahkan seluruh Layer. 
 

Filter fields memungkinkan anda untuk memilih layer-layer dengan 
menggunakan sebuah wildcard seperti A* memilih semua layer-layer yang 
namanya dimulai dengan huruf A. Masukkan suatu filter dan tekan Filter atau 
(lihat contoh berikut). 

 
4. Pilih Apply  untuk memindahkan layer-layer yang dipilih dari tampilan CAD 

window. 
 
Untuk mengaktifkan satu atau beberapa layer pilih tombol > atau >> untuk seluruh 
layer. 
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1.11.2.5 Listing Layer 

Untuk meng-akses design file layer: 
 
Ekspansi hirarki Design File  untuk menampilkan daftar design file suatu project. 
Kemudian  buka folder nama design file yang layer-layernya ingin anda tampilkan  – 
Layer-layer tersebut akan ditampilkan dalam panel Layer Name. 
 

1.11.2.6 Menghapus Suatu Layer 

Jika sebuah design file layer tidak diperlukan lagi, maka file tersebut dapat dihapus.  
Hal ini akan sangat menguntungkan apabila layer tersebut menyimpan data dalam 
jumlah besar.  Penghapusan layer tersebut akan meningkatkan kecepatan redraw 
gambar. 

 
Untuk menghapus sebuah layer dari sebuah design file: 
 
1. Buka Minescape Explorer dan ekspansi hirarki Design File – sebuah daftar 

design file dari project akan ditampilkan di bawah folder. 
2. Buka folder nama design file yang layernya akan dihapus.  Layer-layer tersebut  

disimpan dalam panel Layer Name. 
3. Pilih layer atau beberapa layer yang ingin dihapus. 
4. Pilih tombol Delete – sebuah  pop-up untuk konfirmasi akan muncul: 
 
Tombol-tombol di bawah ini akan muncul dalam pop dialogue: 
 

 
 
Delete All menghapus semua layer yang dihighlight dalam panel values. Tidak 

akan ada pertanyaan untuk konfirmasi lebih lanjut. 
Delete Menghapus layer-layer secara individu, memerlukan konfirmasi untuk 

setiap penghapusan yang dijalankan. 
Ignore Membatalkan sebuah perintah delete dalam daftar yang di ‘highlight’ 

dan pindah ke perintah berikutnya. 
Cancel Membatalkan seluruh operasi delete. 
Help Menyediakan informasi  dalam proses penghapusan. 
 
5. Pilih salah satu dari pilihan-pilihan di atas untuk menghapus layer berikut data 

yang ada dalam current project. 
 

1.11.2.7 Mengganti Nama Suatu Layer 

Untuk mengganti nama layer: 
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1. Buka Minescape Explorer dan ekspansi hirarki Design File – sebuah daftar 
design file suatu project ditampilkan di bawah folder. 

2. Buka folder nama design file yang berisi layer yang namanya  akan diganti. 
Layer-layer terdapat pada panel Layer Name. 

3. Pilih layer yang namanya akan diganti. 
4. Pilih tombol Rename – sebuah pop-up muncul menampilkan nama layer yang 

dipilih:  
 

 
 
5. Masukkan nama yang baru untuk layer tersebut. 
 
6. Pilih OK untuk mengubah nama layer. 
 

1.11.2.8 Mengcopy Suatu Layer 

Anda dapat mengcopy satu atau lebih layer-layer yang sudah diberi nama kedalam 
design file yang berbeda dalam current project.   
 
Cara mengcopy layer dapat dilihat pada bagian sebelumya, yaitu bagian 1.7 “ 
Mengcopy Data Design File”. 
 

1.11.2.9 Memindahkan Suatu Layer 

Anda dapat memindahkan satu atau beberapa layer kedalam design file yang 
berbeda dalam current project.  Fungsi ini dilakukan dalam form yang sama seperti 
untuk mengcopy layer, hanya bagian Tab yang dipilih adalah Move Layers. 
 
Catatan:  Hanya 6 (enam) design file yang dapat dibuka secara bersamaan.  Jika nama 

output layer dibiarkan kosong, nama input layer akan dipakai untuk output.  Jika 
beberapa layer ditransfer ke salah satu output layer  yang menyimpan ulang data 
yang sudah ada, seluruh tampilan harus diberi tanda ON untuk penyimpanan 
ulang, atau layer-layer tersebut tidak akan terpindahkan. 

 

1.11.2.10 Melaporkan Informasi Layer 

Sebuah daftar layer-layer design file dapat diperiksa agar kembali ke batas  data, 
jumlah  elemen-elemen serta vertices dengan menggunakan beberapa pilihan di 
bawah ini: 
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1. Buka Minescape Explorer 
2. Buka folder Design File  – design file tersebut disimpan dalam panel design file. 
3. Pilih design file yang layernya akan diperiksa. 
4. Pilih tombol Info – form berikut ini akan terbuka: 
 

 
 
 
5. Pilih Tab-Divider Layer Info. 
 
6. Lengkapi field-field berikut: 
� Nama Design file harus dimasukkan. 

� Sebuah daftar Search layer harus diberikan.  Masukkan layer atau pilih dari 
Search  

� Manager .  Jika tidak ada layer yang dimasukkan, akan diasumsikan bahwa 
seluruh layer  akan digunakan.  

� Limits (batasan) dapat diberikan jika informasi akan dibatasi per  sheet atau 
nilai  yang tertinggi dan terendah.  Kalau hal ini tidak menjadi masalah, 
batasan harus di-atur ke ‘missing’. 

� Sebuah ID domain dari polygon dapat juga dipakai untuk membatasi data 
yang akan diinterrogated.  Nama Domain design file dan ID Polygon harus 
dimasukkan kemudian. 

� Polygon dapat ditandai sebagai Inside limits atau Outside limits  . 

 
7. Pilih OK atau Apply untuk mendapatkan informasi mengenai layer-layer. 
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1.11.2.11 Memproses  Layer 

Berikut ini adalah cara pengoperasian prosessing layer yang ada dalam design file: 
 
Layer Info. Interrogates daftar design file layer dan memberikan informasi mengenai 
batas-batas data lengkap dengan jumlah elemen-elemen dan vertices yang dipakai. 
 
Report. Membuat sebuah laporan kesimpulan sebuah design file.  Laporan tersebut 
meliputi nama, judul dan tanggal pembuatan setiap layer dan sebuah daftar  objek-
objek yang ditemukan pada setiap layer.  Sebuah hitungan dibuat dalam jumlah 
setiap jenis objek dan vertices yang saling berhubungan. Jumlah keseluruhan design 
juga diberikan. 
 
Untuk memproses layer: 
 
1. Buka Minescape Explorer   
2. dan ekspansi hirarki Design file – sebuah daftar design file untuk project 

ditampilkan di bawah folder. 
3. Buka folder nama design file yang layer-layernya kan diproses. Layer-layer 

tersebut disimpan dalam panel Layer Name. 
4. Pilih satu atau beberapa layer yang ingin anda proses. 
5. Pilih  tombol Process – form berikut ini akan terbuka: 
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6. Pilih proses operasi yang diperlukan dengan memilih tab yang sesuai.  Contoh: 
untuk mengetahui informasi design file layer, pilih tab-divider Layer Info. 

7. Masukkan parameter-parameter yang sesuai kedalam form fields. 
8. Pilih OK atau Apply untuk memproses layer. 
 
Catatan: Pilih nama-nama tab-divider yang disimpan dibawah processing layer untuk 

informasi mengenai  bermacam-macam fields forms. 
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1 Grid File 

Grid file merupakan jenis file khusus  untuk menyimpan data regular pada lokasi X, 
Y, dan Z tertentu. Data yang umum disimpan berupa surface (roof, floor) dan 
interval. 
 
Grid mempunyai beberapa komponen seperti grid cell yang diatur dalam baris-baris 
horisontal (rows) dan kolom-kolom vertikal (columns) serta dipisahkan oleh garis-
garis grid (grid lines) horisontal dan vertikal. Titik persilangan antara garis-garis 
horisontal dan vertikal disebut nodes. 
 
Komponen-komponen grid 

 
Grid-grid menyimpan data spatial pada grid node dalam form biasa,. Nilai grid  
dibuat oleh interpolasi data original ke dalam jaringan grid node. Data grid file yang 
dimasukkan dalam jarak datar memungkinannya cepat diakses oleh Minescape. 
Bagaimanapun juga, beberapa resolusi mungkin hilang pada saat menggunakan 
grid. 
 
Data atau grid value dibuat sebagai suatu hasil interpolasi dari data asli kemudian 
disimpan kedalam grid node. Penyimpanan data yang teratur dalam grid 
menyebabkan grid sangat cepat diakses, akan tetapi resolusinya bisa hilang. 
 
Posisi dari grid ditentukan oleh originnya dan orientasi grid ditentukan oleh rotasinya. 
Origin grid ditentukan letaknya pada bagian sudut kiri bawah dari daerah yang digrid. 
Rotasi ditentukan sebagai perbedaan sudut antara grid dengan sumbu X, dimana 
nilai positif berlawanan dengan arah jarum jam dari sumbu X. 
 
Grid cell selalu kubus dimana ukurannya ditentukan dalam meter, feet dan 
sebagainya tergantung pengaturan initial setup project. Jumlah baris dan kolom 
dalam suatu grid tidak perlu sama. 
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1.1 Konsep Grid 

 
Jumlah baris dan kolom dalam sebuah grid tidak perlu selalu sama. Sebagai contoh, 
sebuah grid yang terdiri dari 70 baris dan 38 kolom dapat dibuat. Grid cell selalu 
berbentuk persegi. Lebar grid cell ditentukan oleh current LENGTH units. Ukuran 
maksimum sebuah grid tergantung kapasitas disk yang ada. 
 

1.1.1 Konsep  Subgrid 

Grid dapat diputar agar sesuai dengan data yang dimasukkan  dan memiliki bentuk 
subgrids yang tumpang tindih (overlapping) dengan ukuran cell berbeda dengan grid 
utama.  Subgrid ini terbentuk di dalam (atau di luar) suatu area yang dibatasi  atau 
pada domain polygon. 
 

.1.2 Origin Grid dan Orientasi  
 

1

Posisi sebuah grid ditentukan oleh origin grid sedangkan orientasinya ditentukan 
oleh sudut rotasi. Secara konvensi,  origin grid menentukan posisi bawah-pojok kiri 
dari sebuah grid. Sudut rotasi  menentukan sudut bagian subtended  antara grid dan 
sumbu X. Sudut rotasi akan bernilai positive  jika berlawanan dengan arah jarum jam 
dari  sumbu X . Origin Grid dan orientasi ditetapkan dalam grid Spec grid file. 
 
1.2 Membuat Grid File 

Sebelum membuat grid file anda sebaiknya membuat sheet specification untuk 

.2.1 Membuat sheet Specification 

memudahkan penentuan batas area yang akan di grid dan membuat grid 
specification untuk menentukan cell size, rotation serta maximum value pada tiap 
node. 
 

1

Untuk membuat sheet specification gunakan menu berikut: 
Minescape Explorer>Specs>Create>Category>Sheet 
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Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 
 
Sheet Panel 
• Name. Nama sheet yang akan dibuat. 
 
Limits Panel 
• North, East, West  dan South. Koordinat north, east, west dan south dari sheet. 

Koordinat tersebut dapat anda ketikkan langsung atau anda dapat pick dari 
polygon rectangle dengan memilih tombol pick from element dan secara 
otomatis koordinatnya akan ditampilkan (polygon rectangle harus dibuat terlebih 
dahulu dimana polygon tersebut merupakan batas daerah dari sheet yang akan 
dibuat). 

 
Pilih OK atau Apply. 
 
Atau 
 
Anda dapat membuat sheet specification pada setiap form dimana ada field Sheet 
kemudian klik kanan pada field tersebut dan pilih create. 
 

1.2.2 Membuat Grid Specification 

Untuk membuat grid specification gunakan menu berikut: 
 
Minescape Explorer>Specs>Create>Category>Gridspec 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
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Grid spec dibuat dengan cara mengis Cell Size pada form di atas, kemudian memilih 
Sheet name yang dibuat sebelumnya menggunakan full down list. Field lain yang 
perlu diisi adalah Rotation of Grid dan maximum Number of Values at Grid Node. 
 
Source Sheet Spec Panel 
• Sheet name. Nama sheet yang akan digunakan. 
 
Grid Spec Panel 
• Name. Nama spesifikasi grid yang akan dibuat. 
 
Definition Panel 
• X origin of grid dan Y origin of grid. Koordinat origin untuk easting dan 

northing. Koordinat tersebut secara otomatis akan ditampilkan jika field sheet 
name sudah diisi. 

• Row in grid  dan Columns of grid. Jumlah baris dan kolom dalam grid. Angka 
tersebut akan otomatis terisi setelah anda mengisi field cell size. 

• Cell size. Ukuran dari grid cell. 

• Rotation of grid. Rotasi dari grid. 

• Maximum number of values at grid node. Jumlah maksimum value pada tiap 
grid node. Minescape dapat menyimpan hingga 400 value dalam setiap grid 
node. 

Information Panel 
• Node count. Jumlah node yang dibuat berdasarkan definisi di atas. 

• Grid Length dan Grid width. Panjang dan lebar grid yang dibuat berdasarkan 
definisi di atas. 

 
Pilih OK  atau Apply 
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Atau  
 
Anda dapat membuat grid specification pada form apa saja dimana terdapat field 
Grid Specification dengan cara klik kanan pada field tersebut kemudian pilih 
Create. 
 

1.2.3 Membuat Grid File 

Untuk membuat grid file gunakan menu berikut: 
 
Minescape Explorer>Folder Grid File> Create 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 
 

Ketikkan nama Grid File kemudian pilih Grid Distance Unit (metres) serta nama Grid 
Specification yang telah dibuat sebelumnya. 
 
File Spec Panel 
• Grid File. Nama grid file yang akan dibuat dengan cara mengetikkannya. 

• Grid distance unit. Unit yang digunakan pada giid. 
 
Value at each Node Panel 
Field pada panel ini adalah pilihan dapat diisi atau tidak. Jika value ditentukan maka 
fild berikut harus diisi. 
 
• Value. Nama value yang akan dibuat. 

• Description. Keterangan yang dapat dimasukkan. 

• Category. Katagori dari value, misalnya depth. 
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• Unit. Satuan yang akan digunakan untuk value. 
 
Grid Spec Panel 
• Name. Nama grid spec yang telah dibuat sebelumnya. 
 
Pilih OK  atau Apply. 
 
1.3 Membuat Model Grid 

Model grid dapat dibuat dengan cara menginterpolasi data acak kedalam grid file 
dengan menggunakan menu berikut: 
 
Model>Grid  
 
Atau 
 
Minescape Explorer>Grid Files>Process 
 
Data Interpolasi data file ASCII ke dalam grid file value. File ini harus 

terdiri dari nilai  X, Y, Z secara berurutan, tapi tempat data tersebut 
tidak perlu sama.  

Design Interpolasi data design file ke dalam grid file value.  
Table Interpolasi data table file ke dalam grid file value.  
Triangle Interpolasi data triangle file ke dalam grid file value.  
Surface Interpolasi data surface expression ke dalam grid file value.  
Multi Surface Resample satu atau lebih surface menurut grid Spec dan 

menyimpan sample-sample tersebut dalam grid file sebagai grid 
values. 

Block Interpolasi data block solid ke dalam grid file value.  
Inclusion Memproses sebuah grid file value, mengindikasikan apakah sebuah 

grid node itu berada di dalam atau di luar polygon. 
In Fill Isi lubang bor atau gap dalam grid file value yang  disebabkan 

penggunaan interpolator tertentu yang  tidak efisiennya dalam 
membuat titik-titik dalam area yang telah ditentukan. 

No Miss Menghapus seluruh missing value dari sebuah grid termasuk hole-
hole yang ada dalam grid dan missing value pada periphery  grid 
tersebut. 

 
Catatan: Sebelum data di-interpolasi, Grid Spec dan Interpolator Spec perlu ditentukan. 

Setiap grid file value dapat  memiliki grid Spec yang berbeda dalam area grid 
yang berbeda pula, contoh subgrid. 

 
Dibawah ini adalah contoh membuat grid model dari design file. Sebuah form akan 
ditampilkan seperti berikut: 
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Input Panel 
• Data design file. Nama design file dimana data grafis yang akan diinterpolasi 

disimpan. 

• Search layer. Nama-nama layer dimana data grafis yang akan diinterpolasi 
disimpan. Klik  tombol … kemudian pilih nama-nama layer. 

 
Output Panel 
• Grid file. Nama grid file dimana data grafis hasil interpolasi akan disimpan. Grid 

file harus sudah ada dalam project atau dibuat terlebih dulu. 

• Value. Nama output value sebagai nama dari data yang disimpan dalam grid. 
Nama value bisa yang telah ada/dibuat atau yang baru. 

• Value description. Penjelasan dari value, misalnya seperti pada contoh di layar. 

• Value unit category dan value unit. Kategori satuan dari value (depth, 
thickness dan sebagainya) dan satuannya (meter, feet dan sebagainya). 

 
Polygon Domain Panel (Optional). 
• Domain design file. Nama design file dimana polygon yang digunakan untuk 

membatasi daerah yang akan diberikan pengecualian disimpan. Polygon harus 
dibuat terlebih dahulu didalam CAD. 
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• Ids. Nomor ID dari elemen polygon. Nomor tersebut dapat dikeluarkan dengan 
cara klik kanan pada field tersebut kemudian pilih Pick dan pilih elemen polygon. 

• Include. Jika dipilih Yes, maka data yang terdapat didalam dan diluar polygon 
batas akan ditampilkan. Jika dipilih No, maka data yang terdapat didalam 
polygon batas tidak ditampilkan. 

 
Controls Panel 
• New /replace. Jika anda memasukkan nama value yang sudah ada maka value 

yang lama akan direplace oleh yang baru sehingga yang berfungsi adalah 
replace. Jika anda memasukkan nama value yang baru maka akan dibuat value 
baru dimana yang berfungsi adalah New.  

• Patch. Digunakan untuk mengupdate data value pada daerah tertentu dengan  
menggunakan specifikasi yang sama. Data baru harus dimasukkan terlebih duluu 
ke dalam minescape. Kemudian buat polygon yang membatasi daerah yang 
datanya akan diupdate. Pada field output anda harus memasukkan grid file dan 
value yang sudah ada dan akan diupdate. 

• Nodes. Digunakan untuk mengupdate value nodes. 
• Spec. Fungsinya sama seperti patch hanya spec yang digunakan berbeda 

dengan yang sudah ada. 

• Interpolator spec. Nama interpolator specification yang digunakan. Pilih 
interpolator FEM. 

• Sheet spec. Nama sheet specification yang digunakan dan telah ada dalam 
project. 

• Minimim level dan maximum level. Nilai maksimum dan minimum yang akan 
diinterpolasi kedalam grid. Jika kedua field tidak diisi maka semua nilai data akan 
diinterpolasi. 

• Smooth grid patch. Dipilih jika anda memilih control Patch yang digunakan 
untuk menghaluskan (smoothing) disekitar batas polygon agar tidak terjadi 
perbedaan yang mencolok antara data yang lama dengan data yang baru. 

 
Pilih OK  atau Apply. 
 
1.4 Mengimport  Data ke dalam Grid  

Pada umumnya data grid dari sumber lain dapat diimport kedalam grid. Tipe data 
yang dapat di-import adalah seperti dalam daftar dibawah ini.  
 
Data Diskripsi 
ASCII data grid dari sebuah file ASCII. 
CPS-III data grid dalam format CPS-III. 
Dump data grid dari Minescape Dump file. 
M2 Structural grids Miner2 Structural model values untuk seluruh seam dan 

surface (contoh, Topografi, Base of weathering, Seam roof, seam 
floor, seam parting, dsb). 
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M2 Grid Grid Miner2 single surface grids. 
M2 Topo Miner2 topografi model. 
M2 Quality Miner2 quality model—lebih sampai 100 qualitas x 60 seam. 
Minex Grid Minex grid export file 
Dozer Grid Minex grid export file 
Vulcan Grid Minex grid export file 
 
Cara mengimport data ke dalam sebuah grid file menggunakan menu berikut: 
 
Minescape Explorer> Grid Files>Import 
 
Pilihan jenis data ada dalam Minescape dengan cara memilih satu tab-divider yang 
ada pada contoh form di bawah. Contoh, apabila anda ingin mengimport data dalam 
format ASCII, pilih tab-divider ASCII.  
 

 
 
Masukkan parameter yang sesuai kedalam field form termasuk grid file dimana 
datanya akan dimasukkan. 
 
Pilih OK atau Apply untuk mengimport data. 
 
1.5 Mengeluarkan Data dari Grid File 

Grid file dapat diexport kedalam jenis file dibawah ini—pilihan untuk mengeksport  
ada dalam Minescape  dengan cara memilih salah satu tab-divider seperti yang 
ditunjukkan dalam form dibawah. 

 
ASCII mengeksport data grid kedalam  sebuah file ASCII. 
Dump mengeksport data grid kedalam  Minescape Dump file. 
M2 Grid mengeksport data grid kedalam  Miner2 single surface gridds. 
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Untuk mengeluarkan data dari grid file gunakan menu berikut: 
 
Minescape Explorer>Grid Files>Export 
 
Dibawah ini adalah contoh export grid ke dalam ASCII file. 
 

 
 
 
Input Panel 
• Grid file. Nama grid file yang akan diexport dengan cara memilih dari daftar full 

down. 

• Grid Value. Nama value yang akan diexport. Dipili dari daftar full down. 
 
Output panel 
• Data file. Nama output ASCII file dengan cara mengetikkannya. 
 
Controls Panel 
• Start row dan End row. Awal dan akhir baris yang dapat ditentukan sebagai 

batasan data ynag dikeluarkan. 

• Start column dan End column. Awal dan akhir kolom yang dapat ditentukan 
sebagai batasan data ynag dikeluarkan. 

 
Pilih OK  atau Apply. 
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1.6 Menghapus Grid File 

Grid file yang tidak terpakai dapat dihapus dengan menggunakan menu berikut: 
 
Minescape Explorer>Grid Files 
 
Pilih grid file yang akan dihapus, kemudian pilih Delete 
 
sebuah pop-up konfirmasi akan ditampilkan dan memberikan beberapa pilihan: 
 
• Delete All – menghapus semua grid file yang dihitamkan (dihighligh) dalam 

panel. 

• Values.   Tidak diminta konfirmasi lebih lanjut. 

• Delete  - menghapus grid file secara sendiri-sendiri, konfirmasi diminta untuk 
setiap operasi delete. 

• Ignore – membatalkan perintah Delete untuk daftar yang sudah dipilih (highlight) 
dan pindah ke perintah berikutnya. 

• Cancel  - membatalkan operasi delete. 

• Help -  menyediakan bantuan dalam operasi delete. 
 
Pilih salah satu pilihan untuk menghapus grid file berikut datanya dari current 
project.  
 

1.6.1 Menghapus Value Grid File  

Untuk menghapus nilai grid file value gunakan menu: 
 
• Buka MineScape Explorer. 

• Expand hirarki Grid Files, daftar grid file project akan muncul dibawah folder. 

• Buka folder grid file yang valuenya ingi dihapus. Daftar value akan ditampilkan 
pada panel sebelah kanan 

• Pilih salah satu grid value atau lebih yang akan dihapus, kemudian pilih Delete, 
form berikut akan muncul. 
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Pilih OK atau Apply untuk menghapus value yang diinginkan dari current project. 
 
Pada saat grid file atau grid value dihapus nama surface grid masih tetap ada, untuk 
menghapus surface dari grid gunakan menu berikut: 
 
Minescape Explorer>Surface>Grid 
 
Pilih nama surface yang akan dihapus, kemudian Delete 
 
1.7 Melihat Grid File 

Untuk melihat sebuah atau lebih value grid file dalam CAD window gunakan 
prosedur berikut: 
 
• Buka MineScape Explorer. 

• Ekspand hirarki Grid file, daftar grid file project akan muncul dibawah folder. 

• Buka folder grid file yang valuenya akan dilihat. Daftar value akan ditampilkan 
pada panel sebelah kanan. 

• Pilih salah satu grid value atau lebih yang akan dilihat, kemudian pilih View. 
 
Window baru akan terbuka dalam CAD untuk menampilkan value yang dipilih. 
 
Catatan: Grid value dapat juga dilihat dengan cara dragging and dropping file tersebut ke 

atas CAD window. 
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1.8 Mengganti Nama Grid File 

Untuk mengganti nama grid file gunakan prosedur berikut: 
 
Minescape Explorer>Grid Files 
 
Daftar grid file akan ditampilkan pada panel sebelah kanan, pilih salah satu grid file 
atau yang namanya akan diganti, kemudian pilih Rename. 
 
Pop-up dialog akan muncul dan meminta anda untuk mengganti nama file yang telah 
dipilih. 
 

 
 
Masukkan nama file baru untuk grid file dan pilih OK. 
 

1.8.1 Mengganti Nama Grid File Value 

Untuk mengganti nama grid file value dalam sebuah grid file gunakan proedur 
berikut: 
 
• Buka MineScape Explorer. 

• Expand hirarki Grid Files, daftar grid file project akan muncul dibawah folder. 

• Buka folder grid file yang valuenya ingin diganti namanya. Daftar value akan 
ditampilkan pada panel sebelah kanan 

• Pilih salah satu grid value atau lebih yang akan diganti namanya, kemudian pilih 
Rename, form berikut akan muncul. 
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Pilih OK atau Apply untuk mengganti nama value. 
 
1.9 Meng-copy Grid File 

Untuk menyalin sebuah grid file gunakan menu: 
 
Minescape Explorer>Grid Files 
 
Daftar grid file akan ditampilkan pada panel sebelah kanan, pilih salah satu grid file 
atau yang akan dicopy, kemudian pilih Copy. 
 
Pop-up dialog akan muncul dan meminta anda untuk memasukkan nama file baru. 
Lokasi direktori dapat ditambahkan, bila filenya disalin ke project lain. 
 

 
 
Ketika anda telah memasukkan nama file, pilih OK. File disalin ke nama file tertentu 
dan lokasi direktori bila diperlukan. 
 

 
Catatan: Sebuah grid file tidak dapat dicopy apabila sedang digunakan oleh suatu module 

atau CAD window. 
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1.10 Informasi dari Grid  

Pilihan informasi dibawah ini dapat dipilih untuk membuat laporan-laporan mengenai 
grid tertentu: 
 
Menu: Minescape Exlorer>Grid Files>Information 
 
Report Membuat laporan mengenai struktur internal sebuah grid. Informasi 

mengenai  grid file header, grid header and subgrid header juga 
dilaporkan. 

Grid Info Memuat informasi mengenai grid value yang dipilih pada layar monitor. 
Infomasi tersebut meliputi keterangan lengkap mengenai value, batas 
dan grid Spec yang digunakan. 

Value List Daftar grid value sebuah grid file. Penjelasan, unit, minima dan maxima 
juga ada. Informasi tersebut dapat dijadikan sebagai sebuah laporan 

Statistic Mengolah statistik laporan mengenai grid value yang dipilih dalam 
sebuah grid file. Jumlah dari value number-nya yang missing, 
minimum, maximum, mean, standard deviasi, skewness dan kurtosis 
juga dilaporkan. 

 
Dibawah ini adalah contoh pembuatan Grid Info: 
 

 
 
Input Panel 
• Grid file. Nama grid file yang akan dibuat informasinya dengan cara memilih dari 

daftar full down. 
 
Output panel 
• Report file. Nama output report file yang akan dibuat dengan cara 

mengetikkannya. 
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Untuk melihat hasilnya pilih field Report File, tekan tombol kanan, kemudian pilih 
View. 
 
1.11 Graphics dari Grid 

Menu dibawah ini dapat dipilih untuk membuat output grafis dari grid: 
 
Graphics 
 
Contour Membuat kontur-kontur dalam design file dengan menggunakan 

data XYZ  dari grid file value. 
Post  Membuat posting dalam design file pada setiap grid node untuk grid 

value yang ada. 
Mesh Membuat sebuah world coordinate mesh ke dalam design file 

dengan menggunakan grid file value. 
 
Contoh pembuatan output grafis dibahas pada Bab 9 “Output Grafis” 
 
1.12 Memproses Grid 

Menu proses ini sama dengan fungsi yang terdapat pada menu Model. 
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1 Table File 

Tabel digunakan untuk menyimpan data tabular atau tabel-tabel, dan menyediakan 
mekanisme yang baik untuk menyimpan data yang tidak spatial dan tidak beraturan 
seperti data kualitas batu bara dan data lain yang dikumpulkan dengan cara 
sampling. Suatu tabel dibuat dengan kolom-kolom yang diberi nama dan 
sekumpulan baris dari data, hampir sama dengan spreadsheet pada aplikasi PC 
seperti Microsoft Excel. 
 
Untuk menampilkan dan memanipulasi data tabel, Minescape mempunyai suatu 
editor tabel grafik yang dikenal dengan nama Tabel Editor. Tabel Editor ini mirip 
aplikasi spreadsheet standar dan memberikan kemudahan akses dan edit data 
tabel. 
 
Data tabel digunakan secara luas dalam Minescape untuk beberapa tujuan. 
Misalnya : 
 
• Sebagai data untuk membuat grid (misalnya kualitas batubara) 
• Untuk menggambar posting data dalam suatu design file 
• Untuk menggambar grafik bisnis 2D (grafik bar, grafik garis, dll.) 
• Untuk menyusun statistik tentang kolom 
• Untuk membuat laporan-laporan dari data yang disimpan dalam tabel 
• Untuk menyimpan data survey polar 
 
Setiap project dapat memuat sebanyak-banyaknya tabel – hanya dibatasi oleh 
kapasitas disk. Tabel dibuat dalam direktori project tables.  
 
1.1 Jenis-jenis tabel 

Tabel digunakan untuk banyak tujuan dalam Minescape. Misalnya, untuk 
menyimpan volumetriks yang disusun dari hasil perhitungan Reserves dan 
Stratmodel, dan juga kualitas data yang disusun dari hasil perhitungan Washability 
dan Quality. Untuk membantu menyusun dan mencari data tabel, klasifikasi tabel 
berikut ini digunakan oleh Minescape. 
 
Generic Tabel Minescape secara umum 
Block Model Tabel yang digunakan oleh Block Model 
Survey Tabel yang digunakan oleh Survey 
Stratmodel Tabel yang digunakan oleh Stratmodel 
Reserves Tabel yang digunakan oleh Reserves 
Quality Tabel yang digunakan oleh Quality 
Washability Tabel yang digunakan oleh Washability 
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1.2 Karakterisk Tabel 

Tabel terdiri dari satu set konstanta sebagai header, diikuti oleh data yang memuat 
hingga 1000 kolom dan baris dalam jumlah yang tak terhingga (hanya dibatasi oleh 
kapasitas disk). 
 
Tabel-tabel Minescape mempunyai karakteristik sebagai berikut : 
 
• Nama tabel hingga 16 karakter 
• Satu set yang terdiri dari hingga 100 konstanta sabagai header 
• Satu set yang terdiri dari hingga 2500 kolom yang masing-masing  mempunyai : 
• Nama yang panjangnya paling banyak 16 karakter 
• Deskripsi yang panjangnya paling banyak 32 karakter 
• Kategori unit dan nama unit. 
• Kolom induk yang bernama jika dibutuhkan untuk weight averaging. 
• Baris dalam jumlah yang tak terhingga (hanya dibatasi oleh kapasitas disk) 
 
1.3 Struktur Tabel 

Struktur Tabel adalah sebagai berikut: 
 
 
 
 

 
 
 
 
 
 

Kol Kol Kol Kol 

Row 

Row 

Row 

Row 

162,8 56,7 57 n Tabel 

R
ow

 tabel 

 

 
 
 
 

1.3.1 Kolom Tabel 

Suatu kolom tabel di kenal dengan: 
 
• Column Name – Nama kolom, sampai dengan 16 karakter 
• Description – keterangan, sampai dengan 32 karakter 
• Unit Category  
• Unit – unit dimana data disimpan.  Jika diabaikan, unit ketika dibuat untuk 

spesifikasi Unit Category yang akan digunakan. 
• Type – String (karakter), Real, Double (precision atau numerik), Integer, atau 

Logika.  
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• Length - Panjang kolom, hanya untuk kolom String (karakter).  
• Column Parent Name - Nama Kolom Induk, bagian dari pembuatan tabel adalah 

definisi dari hubungan antara kolom-kolom. Hubungan ini membantu dalam 
akumulasi baris tabel. Suatu kolom induk (parent) menunjuk pada suatu bobot 
rata-rata induk(weight average), kolom yang digunakan untuk bobot rata-rata. 
Misalnya, kolom yang disebut Coaltons tidak mempunyai induk (merupakan 
suatu tambahan) sedangkan CoalAsh mungkin mempunyai Coaltons (suatu 
kolom tambahan) sebagai induknya.  

 

1.3.2 Konstanta Tabel 

Konstanta tabel merupakan item yang ditetapkan pada bagian atas tabel. Oleh 
karena itu, hanya ada satu nilai yang ditetapkan per tabel (cf. Per baris untuk kolom-
kolom) Sebuah konstanta tabel ditetapkan oleh : 
 
• Constant Name - Nama Konstanta , sampai dengan 16 karakter 
• Deskripsi – sampai dengan 32 karakter 
• Kategori Unit  
• Unit – unit tempat penyimpanan konstanta. Jika diabaikan, unit ketika dibuat 

untuk spesifikasi Unit Category yang akan digunakan.  
• Type – String (karakter), Real, Double (precision atau numerik), Integer, atau 

Logika. 
• Panjang – Hanya untuk konstanta Karakter. 
• Vektor – konstanta dapat berupa susunan-susunan subskrip tunggal, sampai 

dengan jumlah vektor maksimal.  
 
1.4 Membuat Table File 

Membuat tabel dalam minescape adalah mendefinisikan format dari tabel tersebut 
seperti nama tabel, nama kolom, jenis kolom, ukuran kolom dan sebagainya. 
 
Untuk membuat tabel gunakan menu berikut: 
 
Minescape Explorer>Hirarki Table Fil> Folder Generic>Create 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
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Output Panel 
• Table file. Nama output tabel yang akan dibuat. 
 
Table columns Panel 
• Name. Nama kolom-kolom yang akan dibuat. Pada saat pembuatan kolom,  

urutan dan namanya harus sesuai dengan urutan kolom data (ASCII) yang akan 
dimasukkan. Daftar nama kolom pada form di atas sebetulnya masih menerus, 
akan tetapi sebagian tidak tampil dan berada diurutan bawah. Sisa nama kolom 
yaitu  im, ash, vm, fc, ash  dan cv. 

• Description. Penjelasan  dari isi kolom. 
• Unit category. Nama dari unit kategori yang akan digunakan data dalam kolom 

tersebut (depth, length, decimal2 dan sebagainya). Anda dapat menampilkan 
daftar nama unit kategory dengan cara klik kiri dua kali pada field tersebut 
kemudian klik menu pull-down. 

• Unit. Nama unit yang akan digunakan pada data dalam kolom tersebut (meter, 
feet dan sebagainya). Anda dapat menampilkan daftar nama unit dengan cara 
klik kiri dua kali pada field tersebut kemudian klik menu pull-down. 

• Type. Jenis data pada kolom tersebut, misalnya string, karakter, numeric, double 
dan sebagainya. Anda dapat menampilkan daftar type dengan cara klik kiri dua 
kali pada field tersebut kemudian klik menu pull-down. 

• Length. Lebar dari kolom data. Length harus diisi jika type kolom berupa string 
atau karakter. 

• Parent. Nama kolom induk yang digunakan untuk menghitung rata-rata weight. 
Misalnya kolom product ash akan mempunyai parent column yield  dan kolom 
thickness akan mempunyai parent column area. 

 
Table constants Panel 
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Item yang didefinisikan dalam header tabel file. Constant didefinisikan mirip dengan 
kolom, hanya constant mempunyai vektor (value  yang diulang). 
 
Pilih OK atau Apply. 
  
1.5 Memasukkan Data ASCII ke dalam Tabel  File 

Jika tabel telah dibuat maka anda dapat memasukkan data ASCII kedalamnya 
dengan menggunakan pilihan berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Import 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 
 
Input Panel 
• Data file. Nama data file ASCII yang akan dimasukkan. 
 
Output Panel 
• Table file. Nama output tabel yang telah dibuat dimana data akan dimasukkan. 
 
Controls Panel 
• Table column. Nama kolom yang ada dalam tabel yang akan diisi data. 

Urutannya harus sesuai dengan kolom data ASCII. Untuk melihat daftar nama 
kolom klik kiri dua kali pada field tersebut kemudian pilih nama kolom. Jika urutan 
nama column sudah sesuai biarkan field tersebut kosong. 
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• Delete existing table. Jika dipilih (3), maka jika telah ada data dalam tabel yang 
dipilih, data tersebut akan dihapus dan diganti dengan yang baru dimasukkan. 
Jika tidak dipilih ( ), maka data yang dimasukkan akan ditambahkan kedalam 
data yang telah ada di dalam tabel yang dipilih. 

• Update existing rows. Berfungsi jika data yang dimasukkan akan ditambahkan 
kedalam data yang telah ada (field sebelumnya tidak dipilih). Jika dipilih (3) , 
maka data baru akan ditambahkan pada bagian bawah data yang ada. 

• Table start row. Berfungsi untuk menentukan mulai pada urutan baris keberapa 
data akan dimasukkan. 

 
Pilih OK  atau Apply. 
 
1.6 Melihat Table File 

Untuk melihat sebuah pilih menu : 
 
Minescape Explorer>Hirarki Table  File>Folder Generic>Pilih Nama Table>View 
 
1.7 Menambah Kolom pada Table 

Kolom pada tabel dapat ditambah dengan menggunakan menu berikut: 
 
Minescape Explorer>Hirarki Table  File>Folder Generic>Pilih Nama Table>Edit 
 
Edit>Columns>Add 
 
Sebuah form akan ditampilkan dan lengkapi seperti berikut: 
 

 
 
Input Panel 
• Table file. Nama tabel file dimana kolomnya akan ditambah. 
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Column Detail Panel 
• New column. Nama kolom baru yang akan ditambahkan. 
• Column description. Penjelasan dari kolom yang akan dibuat. 
• Column type. Jenis data pada kolom tersebut, misalnya string, karakter, 

numeric, double dan sebagainya. Anda dapat menampilkan daftar type dengan 
cara klik kiri dua kali pada field tersebut kemudian klik menu pull-down. 

• Column length. Lebar dari kolom data. Length harus diisi jika kolom merupakan 
fixed format, yaitu pada jenis data string atau karakter. 

• Column unit category. Nama dari unit kategori yang akan digunakan data 
dalam kolom tersebut (depth, length, decimal2 dan sebagainya). Anda dapat 
menampilkan daftar nama unit kategory dengan cara klik kiri dua kali pada field 
tersebut kemudian klik menu pull-down. 

• Column Unit. Nama unit yang akan digunakan pada data dalam kolom tersebut 
(meter, feet dan sebagainya). Anda dapat menampilkan daftar nama unit dengan 
cara klik kiri dua kali pada field tersebut kemudian klik menu pull-down. 

• Parent. Nama kolom induk yang digunakan untuk menghitung rata-rata weight. 
Misalnya kolom product ash akan mempunyai parent column yield  dan kolom 
thickness akan mempunyai parent column area. 

 
Initialisation Panel 
• Mxl Expression. File expression dimana hasilnya akan disimpan menjadi isi 

kolom baru. File tersebut harus dibuat terlebih dulu atau anda dapat membuatnya 
langsung pada saat membuat kolom baru.. Jika file mxl sudah ada maka anda 
harus memasukkan file tersebut dengan ketentuan  -file <nama file mxl>. 
Misalnya nama file mxl so_elv  maka pada field mxl expression  anda harus 
memasukkan –file so_elv. 

 
Untuk membuat file mxl klik kanan pada field Mxl expression kemudian pilih 
Create.  

 
Pilih OK atau Apply. 
 
Lihat apakah kolom yang baru dibuat sudah ada atau belum.  Kalau sudah ada, save 
table yang sudah diedit dengan memilih menu File>Save, kemudian pilih File>Close 
untuk menutup table. 
 
1.8 Mengolah Data Tabel File 

Minescape menyediakan beberapa fasilitas untuk mengolah data yang disimpan 
dalam tabel file yang dapat dilakukan dengan memilih menu berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Process 
 
• Clone. Membuat tabel baru yang persis sama dengan tabel yang sudah ada 

tetapi tanpa data.  
• Expression. Mengupdate isi kolom sesuai dengan expressi yang dimasukkan. 
• Merge. Menggabungkan beberapa tabel menjadi satu. 
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• Short. Menampilkan isi kolom secara ascending atau deccending. 
• Subset. Membuat tabel baru dari tabel yang sudah ada dimana nilai dari isi 

kolom dapat dibatasi.   
 
Dibawah ini adalah contoh fungsi subset, dimana table yang dibuat kolom diambil 
sebagian dari table yang ada. 
 

 
 
 
Pilih OK atau Apply. 
 
Untuk melihat hasilnya pilih menu berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Pilih <nama 
table>)>View. 
 
1.9 Mengeluarkan Data Table  File  

Data yang terdapat di dalam table dapat dikeluarkan melalui menu: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Export 
 
• Data ASCII (UNLOAD) juga dapat diakumulasikan dan dikeluarkan kedalam 

sebuah file data ASCII (ACCUMULATE) 
• File dump (DUMP) 
• File Lotus 123 (LOTUS 123) 
• File CSV format (CSV) 
• File Excel (Excel) 
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• File data minestar (MINESTAR) 
 
Dibawah ini contoh mengeluarkan data dalam format CSV. 
 

 
 
Pilih OK  atau Apply 
 
Untuk melihat hasilnya pilih Minescape Explorer>Folder Data <Nama File>>View 
 
1.10 Mengedit Tabel File 

Tabel file yang sudah dibuat dapat diedit dengan memilih berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Pilih <Nama Table 
File>>Edit 
 
1.11 Mengcopy Tabel File 

Tabel file yang sudah dibuat dapat dicopy dengan menggunakan perintah berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Pilih <Nama Table 
File>>Copy 
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1.12 Menghapus Tabel File 

Jika suatu tabel sudah tidak diperlukan lagi maka dapat dihapus dengan 
menggunakan menu berikut: 
 
Minescape Explorer>Hirarki Table File>Folder Generic>Pilih <Nama Table File> 
>Delete 
 
Jika yang akan dihapus adalah kolom dari suatu tabel maka gunakan menu berikut: 
 
Minescape Explorer>Hirarki Table File>Hirarki Generic>Folder Table 
Columns>Pilih< Nama Kolom>>Delete 
 

1.13 Output dari Tabel  

Ouput dari table berupa laporan dapat dibuat dengan menggunakan menu: 
 
Minescape Explorer>Hirarki Table File>Folder Generic> Pilih <Nama Table 
File>>Information 
 
Untuk melihat hasilnya pilih menu : 
 
Minescape Explorer>Report>Pilih <Nama Report File>>Edit 
 
Format output table lainnya dibahas dalam Bab 9 “Output Grafis” 
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1 Surface 

Surface merupakan sebuah model dari gabungan data dengan nilai tertentu yang 
beragam dalam suatu magnitude sebagai surface  x dan y. Menurut definisi, untuk 
tiap x dan y hanya terdapat satu z, contoh z=ƒ(x,y). 
 
Surface tidak berisi data, tapi berisi informasi dimana data tersebut  disimpan. 
Sebenarnya surface tidak lebih daripada sebuah definisi. Teknik modelling ini 
memastikan bahwa sebuah surface definition selalu mempunyai informasi yang 
valid, bahkan saat data baru atau tambahan dimasukkan ke dalam Minescape. 
 
Sebuah contoh akan membantu menjelaskan konsep sebenarnya mengenai sebuah 
surface. 
 
Anggaplah sebuah drilling program telah menyediakan informasi mengenai 
kedalaman seam, dengan nama format, yaitu SEAM_A, untuk 3.000 lokasi. Untuk 
tiap drill site, data berikut ini akan dicatat, yaitu sebagai berikut: 
 
• Lokasi site diketahui dengan titik koordinat X dan Y. 
• Kedalaman seam. 
 
Drill site dipilih secara acak pada area tertentu, oleh karena itu data yang diperoleh 
dari drilling program diambil sample-nya secara tidak beraturan. 
 
Kedalaman seam dapat dijadikan model sebagai sebuah surface, sejak kedalaman 
yang beragam tersebut telah diketahui dengan X dan Y. 
 
Seluruh tipe data spatial bisa ditentukan sebagai sebuah surface. Secara lengkap 
surface menentukan: 
 
• Sumber spatial data. 
• Teknik untuk menginterpolasi sebuah surface dengan data ini. 
• Display definition yang digunakan pada saat menampilkan gambar surface, 

seperti contoh irisan surface yang dibuat selama proses sectioning. 
• Unit-unit output. 

 
Surface definition disimpan dalam database surface. 
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1.1 Penggunaan Surface 

Pada saat anda memasuki Minescape, anda akan menemukan beberapa form yang 
menginginkan anda menunjuk sebuah nama surface, bukannya nama grid file, atau 
nama table, dan sebagainya. Sebagai contoh: 

 
• Project to a surface. 
• Locate on a surface. 
• Contour a surface. 
 
Oleh karena itu, anda dapat menetapkan sebuah surface dan mengerjakan proses-
proses Minescape dengan menggunakan surface tersebut, tanpa perlu 
memperhatikan apa tipe dari surface itu atau bagaimana data yang anda 
pergunakan itu ditetapkan. 
 
Complex compound surfaces dapat ditetapkan dengan cara membiarkan potongan-
potongan kecil dari surface-surface itu dibangun dan dipelihara. Sebuah compound 
surface digunakan seperti halnya surface yang lain⎯secara sederhana ditunjukkan 
oleh nama. 
 
1.2 Jenis-Jenis Surface 

Jenis surface yang terdapat dalam minescape: 
 
• Compound  (Menu: COMPOUND) 
• Expression  (Menu: EXPRESSION) 
• Grid (Menu: GRID) 
• Interval (Menu: INTERVAL) 
• Random (Menu: RANDOM) 
• Schema (Menu: SCHEMA) 
• Table (Menu: TABLE) 
• Triangle (Menu: TRIANGLE) 
 

1.2.1 Compound Surface 

Compound surface adalah suatu definisi yang mengacu pada penggabungan dua 
buah surface sederhana atau lebih kedalam satu surface yang rumit. 
 
Domain polygon dalam Surface design file mendefinisikan batas dari surface yang 
akan digabungkan. Surface yang dibatasi oleh domain polygon digunakan untuk 
membentuk compound surface. 
 
Catatan: Poligon yang dibuat searah jarum jam akan dianggap sebagai Inclusive (surface 

ada didalam poligon) dan poligon yang berlawanan jarum jam akan 
mendefinisikan daerah Exclusive (surface tidak terdapat didalam poligon). 
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  Surface 
 

 
Compound surface mengandung: 
 

• Nama surface 
• Keterangan 
• Display definition 
• Nama default surface. Surface yang terdapat dalam daerah yang tidak dibatasi 

poligon. 
• Daftar surface-surface yang dibatasi terdiri dari nama-nama surface dan  nomor 

ID dari elemen poligon pembatas. Hingga 25 surface dapat dimasukkan dalam 
daftar tersebut. 

 
Compound surface dibuat sebagai penggabungan langsung surface-surface, dimana 
pada daerah batas poligon akan diinterpolasi sehingga pengaruh penghalusan tidak 
ada.  
 
Membuat Compound Surface 
 
Untuk membuat compound surface pilih menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Compound>Create 
 
1.2.2 Expression Surface  
 
Surface expression ini didefinisikan menggunakan suatu MXL expression. MXL 
Expression mengubah titik-titik menjadi konstanta, surface, logical dan perhitungan 
matematis. 
 
Surface expression dapat berupa penggabungan surface satu dengan yang lainnya, 
termasuk penggabungan dengan surface expression lainnya.  
 
Sebuah expression surface mungkin sangatlah sederhana, seperti misalnya 
mendefinisikan surface pada suatu nilai elevasi yang tetap atau sangat rumit seperti 
misalnya mendefinisikan suatu model surface yang berkaitan dengan berbagai data 
geologi dan quaity. 
 
Fungsi MXL yang paling umum digunakan untuk surface adalah: 
 
Surface mengakses nilai dari suatu surface yang ditentukan pada lokasi sample 

yang digunakan. Misalnya SURFACE ('TOPO')  berarti mengakses 
value dari surface topo. 

Roof mengakses nilai dari roof interval yang ditentukan pada lokasi sample 
yang berlaku. Misalnya ROOF(‘S100’) yang berarti mengakses nilai 
dari  interval S100. Jika interval A merupakan sebuah interval schema, 
maka expression S100_ROOF juga akan mengakses hal yang sama 
yaitu roof dari interval S100. 

Floor mengakses nilai dari floor interval yang ditentukan pada lokasi sample 
yang berlaku. Misalnya FLOOR(‘S100’) yang berarti mengakses nilai 

  3 of 9 

DOWNLOAD TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys

Download TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys



  Surface 
 

dari interval S100. Jika interval S100 merupakan sebuah interval 
schema, maka expression S100_FLOOR juga akan mengakses hal 
yang sama yaitu floor dari interval S100. 

Thick mengakses nilai dari ketebalan interval yang ditentukan pada lokasi 
sample yang berlaku. Misalnya THICK(‘S100’) yang berarti mengakses 
nilai dari interval S100. Jika interval S100 merupakan sebuah interval 
schema, maka expression S100 saja juga akan mengakses hal yang 
sama yaitu ketebalan dari interval S100. 

 
Jika suatu expression bertambah hingga lebih dari suatu baris, maka suatu tanda ~ 
(tidle) harus ditempatkan pada akhir baris yang menunjukkan bahwa ekspression 
tersebut berlanjut ke baris berikutnya, seperti misalnya: 
 
(SURFACE(‘TOPO’)-SURFACE(‘TOTLOOR’)-THICK(‘S100’)-~ 
THICK(‘S200’)-THICK(‘S300’))-~ 
/(THICK(‘S100’)+THICK(‘S200’)+~ 
THICK(‘S300’) 
 
Expression diatas dapat pula ditulis: 
 
(TOPO-TOTFLOOR-S100-S200-S300)/(S100+S200+S300) 

 
Surface expression mengandung: 
 
• Nama surface 
• Nama Expression 
• Display definition 
• Unit Category dan Unit. 
 
Membuat Surface Expression 
 
Untuk membuat surface expression pilih menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Expression>Create 
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1.2.3 Grid Surface  
 
Grid surface adalah definis surface yang mengacu kepada nama grid value dalam 
sebuah grid file. 
 
Mengingat sistem penyimpanan data dalam grid file sangat teratur, maka 
mengakses grid surface umumnya lebih cepat dibanding dengan surface dari data 
lainnya. 
 
Dibawah ini adalah contoh definisi dari grid surface. 

 
Grid surface mengandung: 
 
• Nama surface 
• Keterangan 
• Display definition. Pengaturan atribut untuk output grafis dari surface. 
• Nama grid file. Nama grid file dimana data surface disimpan. 
• Nama grid value. Nama value dalam grid file untuk surface tersebut. 
 
Membuat Grid Surface  
 
Untuk membuat grid surface pilih menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Grids>Create 
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1.2.4 Interval 

Interval sebetulnya bukanlah suatu surface, tapi merupakan definisi yang mengacu 
kepada perbedaan nilai antara surface diatas (top surface) dengan surface 
dibawahnya (bottom surface). Suatu interval dapat didefinisikan untuk dua buah 
surface apapun, tapi umumnya dibuat untuk seam batubara atau interburden. Jadi 
interval dapat digunakan untuk menentukan ketebalan suatu seam, dimana surface 
bagian atas adalah roof dan surface bagian bawahnya adalah floor dari seam 
tersebut. 
 
Interval surface  mengandung: 
 
• Nama interval 
• Keterangan 
• Top surface 
• Bottom surface 
• Display definition 
 
Suatu interval dapat dibuat dengan dua cara, yaitu: 
 
Secara manual dengan mendefinisikannya dalam minescape dengan memilih menu: 
 
Minescape Explorer>Surfaces>Interval>Create 
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Catatan: Interval schema didefinisikan sepenuhnya dalam schema dan umumnya tidak 

boleh terdapat sebagai interval umum Minescape. Jika interval Minescape 
mempunyai nama yang sama dengan interval schema dapat membingungkan 
pengguna, karena mungkin tidak dapat digunakan mengingat jika schema yang 
mempunyai interval tersebut diatur sebagai current schema, maka dapat 
digunakan sama seperti interval Minescape. 

 

1.2.5 Random Surface 

Design file surface adalah definisi yang mengacu pada data random yang disimpan 
dalam satu atau lebih design file layer. 
 
Pada saat design file surface diakses Minescape, definisi surface akan membaca 
design file dan layer yang ada dan menggunakan interpolator yang tersedia untuk 
menghitung value untuk output. 
Karena sebuah design file surface harus menginterpolasi value setiap kali surface 
diakses, maka menggunakan design file surface akan membutuhkan waktu yang 
cukup lama untuk mengerjakannya. 
 
Design file surface mengandung: 
 
• Nama surface 
• Keterangan 
• Display definition 
• Nama design file 
• Daftar nama design file layer 
• Nama Interpolator yang digunakan dan parameter-parameter. 
 
Membuat Random Surface 
 
Untuk membuat random surface pilih menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Random>Create 
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1.2.6 Table Surface 

Table surface adalah definisi yang mengacu kepada data random yang terdapat 
didalam kolom-kolom table file. 
 
Table surface mengandung: 
 
• Nama surface 
• Keterangan 
• Display definition 
• Nama table file (harus yang mempunyai kolom dengan data Easting, Northing 

dan Elevasi) 
• Nama-nama kolom Easting, Northing dan data dalam table. 
• Nama Interpolator yang digunakan 
 
Membuat Table Surface 
 
Untuk membuat table surface pilih menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Table>Create 
 

1.2.7 Triangle Surface 

Triangulated surface adalah suatu jenis surface khusus yang mengacu kepada data 
ASCII random, table atau design file yang dibuat menjadi suatu rangkaian triangle 
dalam satu triangle design file. 
 
Triangulate surface dapat dibuat dari data point string atau line string dalam design 
file. Oleh karena itu akan sangat berguna untuk membuat model data survey 
tambang terbuka. 
 
Volume juga dapat dihitung menggunakan dua buah triangulated surface dalam 
daerah yang dibatasi poligon. 
 
Membuat Triangle Surface 
 
Untuk membuat triangulated surface pilih menu berikut : 
 
Minescape Explorer>Hirarki Surfaces>Folder Triangle>Create 
 
1.3 Melihat Daftar Surface yang sudah Ada 

Untuk melihat daftar surface yang sudah dibuat pilih menu berikut: 
 
Minescape Explorer>Surfaces 
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1.4 Menghapus Surface 

Untuk menghapus surface menu berikut: 
 
Minescape Explorer>Hirarki Surfaces>Folder Jenis Surface>Pilih  Nama 
Surface>Delete 
 
1.5 Output dari Surface  

Contour 
 
Menu: Graphics>Contour>Surface 
 
Mesh 
 
Menu: Graphics>Mesh>Surface 
 
Section 
 
Menu: Graphics>Section>Surface 
 
Output dari surface dibahas secara detail pada Bab. 9 “Output Grafis”. 
 
1.6 Surface Disediakan Untuk Anda 

Minescape menyediakan surface untuk anda diantaranya pada saat anda: 
 
• Meng-import Miner2 grid. 
• Membuat value baru dalam sebuah grid file, sebagai contoh dengan memodel 

data topo. 
• Membuat model triangulasi. 
• mengcomposite sample quality. 
• Membuat model dalam Stratmodel. 

 
Catatan:  Schema surface ditetapkan secara keseluruhan dalam schema dan biasanya 

tidak harus sebagai general Minescape surface. Apabila general Minescape 
surface benar-benar terdapat dengan nama yang sama seperti schema surface, 
maka akan digunakan pada waktu sekarang atau nantinya. Selama schema 
ditetapkan sebagai Current schema, schema surface dapat digunakan pada cara 
yang sama seperti general Minescape surface. Definisi tampilan untuk schema 
surface diberi nama menurut ketentuan berikut: SURF_<surface>. Sebuah schema 
interval roof ataupun floor surface dapat ditunjukkan dengan menggunakan 
<interval>_ROOF atau <interval>_ FLOOR 
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1 Triangulasi 

Triangulasi adalah suatu metode yang menghubungkan sekumpulan triangle secara 
grafis untuk menggambarkan suatu surfaces dan/atau volume. 
 
Data yang di-triangulasi disimpan dalam triangle file dalam direktori ./triangle pada 
project anda. Tiap triangle file memiliki file yang berakhiran dengan .tfl. Struktur dan 
karekteristik triangle file hampir sama dengan design file. Seperti juga design file, 
sebuah triangle file dibuat dari satu atau lebih layer-layer . Ketika anda membuat 
sebuah triangulasi, anda perlu memasukkan nama output triangle file juga output 
layer. Layer-layer ini terdiri dari satu atau lebih triangulation set (Kumpulan 
Triangulasi)—yaitu subset yang sudah dinamai dari file tertentu yang berisi informasi 
untuk membuat triangulasi. 
 
Minescape membolehkan sebuah single triangulation yang terdiri dari lebih 16.7 juta 
triangles. Batasannya adalah 512 layers per triangle file dan 4096 set per triangle 
file. 

 
Triangle file adalah sumber data grafis yang penting, dan menyediakan fasilitas 
untuk menggambarkan model yang berhubungan dengan geologi dan segala isinya. 
Memiliki ruang dan memori yang efisien dan juga menawarkan kemampuan 
outstanding graphical rendering. Seperti juga design file, 
 
Adapun contoh triangulasi diperlihatkan dalam gambar berikut. 

 

 
Triangulasi dapat dibuat dari data ASCII, Tables dan Design file. Untuk membuat 
triangulasi gunakan menu berikut: 
 
Model> Triangles > (Data – Tables – Design) 
 
Data hasil triangulasi dapat disimpan sebagai surface. Outputnya  dapat dibuat 
kontur atau digunakan untuk menghitung volume. 
 
1.1 Membuat Triangulasi dari Design File 

Untuk membuat triangulasi dari design file gunakan menu berikut: 
 
Model>Triangles>Design 
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Tab Main 
Input Panel 
• Design file. Nama design file dimana layer grafis disimpan. 

• Search layer. Nama satu atau lebih layer dimana elemen grafisnya akan 
ditriangulasi. Untuk memilih nama layer klik tombol … kemudian pilih nama layer.  

 
Triangles Panel 
• Triangle file. Nama design triangle dimana data triangle akan disimpan. Data 

triangle disimpan dalam file khusus yang disebut triangle file. 

• Layer. Nama output layer triangle. 

• Surface name. Nama output surface . Output surface dapat digunakan pada 
saat membuat output grafis seperti section, kontur dan perhitungan volume. 

• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 
dalam design file, maka jika field append dipilih (3), output grafis akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh grafis yang dimasukkan. Field 
ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau baru. 

• Display definition. Display definition untuk triangle. 
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Tab Option 
Boundary Polygon Output Panel 
• Design file. Nama output design file dimana output grafis akan disimpan. 

• Layer. Nama layer dimana elemen polygon hasil triangulasi akan disimpan. 

• Display definition. Display definition untuk polygon. 
 
Controls Panel 
• Convexity. Pengaturan sampai sejauh mana triangle akan dibuat pada daerah 

dimana data tidak ada. 

• Sheet limit. Nama sheet specification yang ada dalam projects yang dapat 
dimasukkan jika anda ingin membatasi output triangle. 

• Minimum dan maximum level. Menentukan batasan dari level elevasi terendah 
hingga tertinggi untuk triangle yang akan dibuat. Jika levelnya  tdak akan dibatasi 
maka kedua field tersebut dikosongkan. 

 
Polygon Domain Panel 
Berfungsi untuk membatasi suatu daerah yang akan diberikan pengecualian, 
misalnya dikosongkan, diisi oleh data yang lain dan sebagainya.  Elemen polygon 
harus dibuat terlebih dulu. 
 
• Design file. Nama design file dimana elemen polygon disimpan. 

• ID. Nomor ID elemen polygon yang akan digunakan sebagai pembatas. Untuk 
mengetahui nomor ID klik kanan pada field tersebut kemudian pilih Pick. 

• Include. Jika diisi Yes maka data didalam polygon domain dan diluarnya akan 
ditampilkan. Jika diisi No maka  data hanya akan ditriangulasi pada daerah diluar 
poligon. 

 
Pilih OK atau Apply. 
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Untuk melihat hasil triangulasi pilih tombol Attach reference, sebuah form akan 
ditampilkan dan lengkapi seperti berikut: 
 

 
 
Pilih Next  - sebuah form akan ditampilkan: 
 

 
 
Pilih Next – Pilih Finish 
 
1.2 Menampilkan Daftar Layer Triangulasi 

Triangulasi yang sudah dibuat dapat ditampilkan dengan menggunakan menu 
berikut: 
 
Minescape Explorer>Triangle Files>Pilih <Nama Triangle File> 
 
Daftar nama layer triangulasi akan ditampilkan disebelah kanan. 
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1.3 Menghapus Triangle File 

Untuk menghapus triangle file gunakan menu berikut: 
 
Minescape Explorer>Triangle Files>Pilih  <Nama Triangle File>> Delete 
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1 Output Graphics 

Output graphics seperti kontur, post, section, base grid dan sebagainya dapat dibuat 
melalui Minescape dan hasilnya disimpan dalam design file. 
 
Untuk membuat graphics menu yang dipilih adalah: 
 
Graphics 
 
1.1 Membuat Base Grid 

Bila akan mencetak peta dari plot file umumnya dibutuhkan gambar yang biasanya 
menampilkan garis-garis koordinat horisontal dan vertikal atau dalam minescape 
dikenal dengan basegrid. 
 
Base grid dapat dibuat kedalam layer dan kemudian diplot bersama-sama dengan 
gambar lainnya, menjadi suatu gambar gabungan berupa peta. 
 
Batas daerah dimana basegrid akan dibuat dapat ditentukan berdasarkan batas 
koordinatnya dari Sheet Specification  atau poligon batas. 
 
Untuk membuat basegrid, pilih menu berikut: 
 
Graphics>Ancillaries>Base Grid 
 
Lengkapi form seperti berikut: 
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Output Panel 
• Design file. Nama dsign file dimana output graphics akan disimpan. 
• Layer. Nama layer dimana output graphics akan disimpan. 
• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 

dalam design file, maka jika field append dipilih (3), output graphics akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh graphics yang dimasukkan. 
Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari graphics 
yang berada dalam layer. 

 
Location Panel 
• Elevation of grid. Untuk design file 3D, elevasinya ditentukan secara konstant, 

misalnya elevasi 0. 
 
Limits Panel 
• Sheet name. Nama sheet spesification yang digunakan sebagai batas gambar 

grid. 
• Domain design file. Untuk membuat base grid berdasarkan polygon batas 

(domain), masukkan nama design file dimana polygon domain disimpan. 
• Domain polygon. Nomor ID dari polygon domain. 
 
Major Grid Display: 
• X dan Y spacing distance. Jarak spacing untuk setiap garis/titik grid pada 

koordinat X maupun Y. 
• Grid lines or points. Bentuk tampilan base grid apakah terdiri dari garis-garis 

atau titik-titik yang membentuk grid. 
• Display definition. Display definition yang digunakan untuk major grid. 
 
Minor Grid Display Panel 
• No of minor/major in X  dan Y. Jumlah garis grid minor untuk setiap spacing 

major grid. 
• Grid lines or ponts. Bentuk tampilan base grid apakah terdiri dari garis-garis 

atau titik-titik yang membentuk grid. 
• Display definition. Display definition yang digunakan untuk minor grid. 
 
Coordinat Display Options Panel 
• Text position. Text dapat ditempatkan didalam (Inside) atau diluar (Outside). 
• Number decimal places. Jumlah angka dibelakang koma pada text. 
• Display definition. Display definition yang digunakan untuk text. 
• Truncate koordinat. Apakah text akan dipotong (3) atau tidak ( ), jika 

berpotongan dengan garis grid. 
• Text prefix in X dan Y. Nama awalan yang diberikan pada koordinat X atau Y. 
• Text suffix in X dan Y. Nama awalan yang diberikan pada koordinat X atau Y. 
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Pilih OK  atau Apply. 
 
Display definition  yang dipergunakan untuk mengatur tampilan base grid terdiri dari: 
 
• Maj_grid_line – untuk major grid line 
• Min_grid _line – untuk minor grid line 
• Maj_grid-text – untuk text anotasi major grid line 
 
Display definition tersebut dapat diedit jika diperlukan, misalnya ingin mengubah 
attribut tampilannya atau ukuran text-nya dengan cara klik kanan pada field tersebut 
kemudian pilih edit. 
 
1.2 Membuat Kontur dari Grid 

Untuk membuat kontur dari grid pilih menu berikut: 
 
Graphics>Contour>Grid 
 
Form terdiri dari 4 buah tab yaitu  tab Controls, Domain, Limits dan Display. 
 

 
 
Tab Contour 
Input Panel 
• Grid File. Nama grid yang akan dibuat kontur. 
• Grid Value. Nama value (surface) yang akan dibuat kontur. 
 
Output Panel 
• Design File. Nama design file dimana output graphics akan disimpan. 
• Layer. Nama layer dimana output graphics akan disimpan. 
• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 

dalam design file, maka jika field append dipilih (3), output graphics akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh graphics yang dimasukkan. 
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Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari graphics 
yang 

 
Contour Controls Panel 
• Smoothing. Menentukan tingkat kehalusan garis kontur. Pilihannya adalah 

Point, Low, Medium, Heigh dan Very High. Pilihan tersebut menunjukkan tinggkat 
penghalusan garis kontur, diman Point  adalah yang paling kasar atau tanpa 
smoothing sedangkan Very High adalah yang paling halus. 

• Type. Kontur dapat dibuat berdasarkan Interval atau Value. 
• Annotation Frequency. Menentukan kontur yang mana yang kan diberi anotasi. 

Jika interval dipilih, maka jumlah frekuensi kontur yang diberi anotasi harus 
ditentukan (misalnya tiap 2, 5 kontur dan sebagainya). Kontur yang diberi anotasi 
akan dicirikan oleh default display definition majorcontour. 

• Contour Interval. Jika interval dipilih, maka kontur akan dibuat dengan interval 
nilai-nilai elevasi yang tetap, misalnya interval 5, berarti kontur dibuat setiap  
perubahan elevasi 5 meter (0, 5, 10 dan seterusnya). Jika value dipilih, maka 
kontur dapat dibuat dengan nilai-nilai elevasi yang ditentukan atau dimasukkan 
sesuai dengan yang diinginkan pada field values dan Labels.  

• Shaded, Rainbow dan Reverse. Polygon dapat dibuat diantara kontur dan diberi 
fill type solid. Kemudian masingmasing polygon kontur dapat diberi range warna 
menggunakan urutan waarna di Minesacpe (Shaded), urutan warna pelangi 
(rainbow) atau urutan warna kebalikan dri pelangi (Reverse). 

 

 
 
Tab Domain 
Domain Clippings Panel 
• Design File. Nama design fle dimana polygon domin disimpan. 
• Polygon ID. Nomor Id elemen polygon. 
• Inclusive. Jika diisi Yes, maka kontur akan ditampilkan didalam poligin domain. 

Jika diisi No maka kontur hanya ditampilkan diluar daerah poligon domain. 
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Tab Limits 
Limits panel 
• Sheet Spec. Nama sheet specification yang digunakan untuk membatasi daerah 

gambar kontur yang ditampilkan. Jika tidak diisi maka kontur akan dibuat sesuai 
dengan batas data yang ada dalam projects. 

• Minimim  dan Maximum Level. Menentukan range dari elevasi kontur terendah 
hingga tertinggi, mialnya dari elevasi 0 hingga elevsi 50. 

 

 
 
Tab Display 
Display Definition Panel 
• Major Contour. Display definition yang digunakan untuk major kontur. 
• Minor Contour. Display definition yang digunakan untuk minor kontur. 
• Value Contour. Display definition yang digunakan untuk value contour. Hanya 

berlaku jika jenis kontur yang dibuat adalah value. 
 
Pilih Ok atau Apply. 
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1.3 Membuat Kontur  dari Triangle  

Menu: Graphics>Contour>Triangle 
 

 
 
Tab Contour 
Input Panel 
• Triangle File. Nama file triangle yang akan dibuat kontur. 
• Search layer. Nama layer traingle yang akan dibuat kontur. 
 
Output Panel 
• Design File. Nama design file dimana output graphics akan disimpan. 
• Layer. Nama layer dimana output graphics akan disimpan. 
• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 

dalam design file, maka jika field append dipilih (3), output graphics akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh graphics yang dimasukkan. 
Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari graphics 
yang 

 
Contour Controls Panel 
• Type. Kontur dapat dibuat berdasarkan Interval  atau Value. 
• Annotation Frequency. Menentukan kontur yang mana yang kan diberi anotasi. 

Jika interval dipilih, maka jumlah frekuensi kontur yang diberi anotasi harus 
ditentukan (misalnya tiap 2, 5 kontur dan sebagainya). Kontur yang diberi anotasi 
akan dicirikan oleh default display definition majorcontour. 

• Contour Interval. Jika interval dipilih, maka kontur akan dibuat dengan interval 
nilai-nilai elevasi yang tetap, misalnya interval 5, berarti kontur dibuat setiap  
perubahan elevasi 5 meter (0, 5, 10 dan seterusnya). Jika value dipilih, maka 
kontur dapat dibuat dengan nilai-nilai elevasi yang ditentukan atau dimasukkan 
sesuai dengan yang diinginkan pada field values dan Labels.  
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• Shaded, Rainbow dan Reverse. Polygon dapat dibuat diantara kontur dan diberi 
fill type solid. Kemudian masingmasing polygon kontur dapat diberi range warna 
menggunakan urutan waarna di Minesacpe (Shaded), urutan warna pelangi 
(rainbow) atau urutan warna kebalikan dri pelangi (Reverse). 

 

 
 
Tab Domain 
Domain Clippings Panel 
• Design File. Nama design fle dimana polygon domin disimpan. 
• Polygon ID. Nomor Id elemen polygon. 
• Inclusive. Jika diisi Yes, maka kontur akan ditampilkan didalam poligin domain. 

Jika diisi No maka kontur hanya ditampilkan diluar daerah poligon domain. 
 

 
 
Tab Limits 
Limits panel 
• Sheet Spec. Nama sheet specification yang digunakan untuk membatasi daerah 

gambar kontur yang ditampilkan. Jika tidak diisi maka kontur akan dibuat sesuai 
dengan batas data yang ada dalam projects. 
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• Minimim  dan Maximum Level. Menentukan range dari elevasi kontur terendah 
hingga tertinggi, mialnya dari elevasi 0 hingga elevsi 50. 

 

 
 
Tab Display 
Display Definition Panel 
• Major Contour. Display definition yang digunakan untuk major kontur. 
• Minor Contour. Display definition yang digunakan untuk minor kontur. 
• Value Contour. Display definition yang digunakan untuk value contour. Hanya 

berlaku jika jenis kontur yang dibuat adalah value. 
 
Pilih Ok atau Apply. 
 
1.4 Membuat Mesh dari Surface 

Untuk membuat mesh dari  surface pilih menu berikut: 
 
Graphics>Mesh>Surface 
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Tab IO 
Input Panel 
• Grid File. Nama grid yang akan dibuat mesh. 
• Grid Value. Nama value (surface) yang akan dibuat mesh. 
 
Output Panel 
• Design File. Nama design file dimana output graphics akan disimpan. 
• Layer. Nama layer dimana output graphics akan disimpan. 
• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 

dalam design file, maka jika field append dipilih (3), output graphics akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh graphics yang dimasukkan. 
Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari graphics 
yang 

 

 
 
Tab Control 
Controls Panel 
• Interval/Value. Mesh dapat dibuat dengan menggunakan Interval  yang tetap 

atau Value yang dipilih. Interval atau value digunakan untuk menentukan 
perubahan warna dalam garis-garis mesh. 

• Mesh Interval. Jika interval dipilih pada field diatas, maka nilai intervalnya harus 
diisi. Jimlah maksimum interval mesh yang dapat dibuat adalah 20. 

• Mesh Value. Jika value dipilih pada field diatas, maka nilai value harus diisi. 
• Line Option. Default dari garis mesh adalah barat-timur dan utara-selatan, tapi 

hanya satu set garis dapat dipilih untuk dibuat. 
• Frequency East  dan North. Defaulnya adalah untuk menghasilkan suatu garis 

mesh untuk setiap baris dan kolom grid. Bila grid sangat halus, frequensinya 
dapat diubah untuk menghasilkan subset dari garis tersebut. 
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Tab Limits 
Limits panel 
• Sheet Spec. Nama sheet specification yang digunakan untuk membatasi daerah 

gambar kontur yang ditampilkan. Jika tidak diisi maka kontur akan dibuat sesuai 
dengan batas data yang ada dalam projects. 

• Minimim  dan Maximum Level. Menentukan range dari elevasi kontur terendah 
hingga tertinggi, mialnya dari elevasi 0 hingga elevsi 50. 

 

 
 
Tab Display 
Display Panel 
• Mesh display. Display definition yang digunakan untuk mesh. 
 
Pilih OK atau Apply. 
 
1.5 Post 

Untuk membuat post pilih menu berikut: 
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Graphics>Post>Table 
 

 
 
Tab IO 
Input Panel 
• Table file. Nama tabel file yang digunakan. 
• X, Y dan Z Column. Nama kolom koordinat X, Y, dan Z yang terdapat dalam 

tabel yang diinput. 
• Selection Expression. MXL expression yang dapat dimasukkan untuk 

memberikan pengecualian atau menentukan data yang akan di post. 
• Posting Column. Nama kolom dari data yang ingin di post. Anda dapat 

memasukkan lebih dari satu nama kolom untuk di post jika diinginkan. Untuk 
memilih nama kolom klik kiri dua kali pada field tersebut kemudian pilih nama 
kolom dari menu pulldown. 

 
Output  Panel 
• Design file. Nama design file dimana output graphics akan disimpan. 
• Layer. Nama layer dimana output graphics akan disimpan. 
• Append. Jika anda memasukkan nama layer yang sama dengan yang telah ada 

dalam design file, maka jika field append dipilih (3), output graphics akan 
ditambahkan pada layer tersebut. Jika field append tidak dipilih ( ), maka layer 
yang telah ada isinya akan diganti (overwrite) oleh graphics yang dimasukkan. 
Field ini tidak berpengaruh jika nama layer yang dimasukkan belum ada atau 
baru. 

• Title. Keterangan yang dapat anda masukkan sebagai penjelasan dari graphics.  
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Tab Controls 
Controls Panel 
• Text Spacing, Angle, Justification  dan Distance. Posisi text pada posting 

diatur oleh jarak, sudut, jarak antar text dan penentuan dari letak titik data. 
• Offset Text, Object Name, Design File, Distance  dan  Index Column. 

Berbagai macam offset tersebut berhubungan dengan objek yang bernama Post 
Line.Post line adalah suatu elemen garis yang diberi nama. 

 

 
 
Tab Display 
Display Definitions Panel 
• Post symbol. Display definition yang digunakan untuk symbol. 
• Post text. Display definition yang digunakan untuk text. 
 
Pilih Ok  atau Apply. 
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1.6 Section 

Menu: GRAPHICS – SECTION - SURFACE 
 
Buka design file topo, kemudian buat current layer Lines_Sct. 
 
Buat garis dengan arah utara-selatan dibagian barat daerah topo, kumudian copy 
parallel garis tersebut kearah timur dengan spasi 250 meter sebanyak 9 copy. 
 

 
 
Tab IO 
 

 
 
Tab Controls 
 
Pilih OK  atau Apply. 
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1 Plotting 

1.1 Quick Plot 

Menu Quick Plot digunakan jika anda mau membuat plot file dari suatu elemen grafis 
atau langsung mem-plot grafis tersebut. Untuk membuka menu Quick Plot pilih 
menu berikut: 
 
Page>Plot>Quick Plot 
 
Sebuah form berikut akan ditampilkan: 
 

 
 
Ada 3 metode view untuk quick plot yaitu: 
 
1. View adalah suatu metode plot dimana semua elemen grafis yang ditampilkan 

dalam CAD window akan diplot. 
2. Fence adalah  suatu metode plot dimana elemen grafis yang diplot hanya 

elemen yang dipilih saja. 
3. Paper adalah suatu metode plot dimana elemen grafis yang diplot hanya elemen 

yang terdapat didalam frame ukuran kertas yang dipilih. 
 
Berikut adalah contoh membuat quick plot dengan menggunakan metode FENCE. 
 

1. Pilih menu : Page>Plot>Quick Plot 
 

2. Pilih Fence kemudian pilih Next 
 

Tentukan elemen grafis yang akan diplot dengan cara menempatkan pointer pada 
ujung kiri atas elemen grafis yang akan diplot kemudian klik kiri - drag sampai ke 
ujung kanan bawah elemen grafis. 
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Jika elemen grafis yang akan diplot sudah di-fence (dipilih), maka sebuah form 
berikut akan ditampilkan: 
 

 
 
Form terdiri atas field-field berikut: 
 

 Paper Size, Scale and Orientation 
 

 Media. Media yang akan digunakan untuk plot, pilihannya yaitu scale,  
A1, A2, A3 dan lain-lain. Jika anda mau plot dengan menggunakan 
skala maka pilih Scale. Jika anda mau plot dengan ukuran kertas, 
maka pilih ukuran kertas yang akan anda gunakan misalnya A1. 

 Scale 1: . Field ini diisi jika media yang dipilih adalah scale. Misalnya 
anda akan plot grafis dengan skala  1 : 5000, maka isikan 5000. 

 Size. Ukuran kertas untuk elemen grafis yang akan anda plot. Angka 
tersebut secara otomatis akan ditampilkan jika anda sudah mengisi 
media dan scale (jika media yang dipilih scale). 

 Margin. Minescape secara default akan mengatur margin kertas 
sebesar 10mm. Margin tersebut bisa diubah sesuai dengan yang 
anda inginkan. 

 Paper White. Jika paper white dipilih maka setelah anda pilih Next 
elemen grafis yang yang sudah dipilih akan ditampilkan pada cad 
window (seperti plot view) dimana backgroundnya adalah putih. Jika 
tidak dipilih maka backgroundnya adalah hitam. 

 
 Output Size 

 
 Plotted size. Ukuran hasil plot setelah dikurangi margin. 
 Scale. Skala. 

 
 

3. Pilih NEXT, elemen yang anda pilih akan ditampilkan (seperti plot view) 
dan form berikut akan ditampilkan: 
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Form terdiri dari field-field berikut: 
 

 Additional Features. Pada saat plot anda dapat sekaligus  membuat 
Grid Definiton, Scale Bar Definition, Title Definition, North Arrow 
Definition dan Re-Scale. Caranya jika anda mau menambahkan feature-
feature tersebut pilih check box masing-masing feature  (√) kemudian klik 
kiri tab masing-masing feature. 

 
 Grid Definition. Jika anda memilih grid definition maka form berikut 

akan ditampilkan: 
 

Form terdiri dari field berikut: 
 
 Grid Display. Pengaturan display untuk grid. 

 
 X spacing distance dan Y spacing distance. Jarak spacing untuk 

tiap-tiap garis/titik grid pada koordinat X maupun Y. 
 Z spacing. Jarak spacing untuk tiap-tiap garis/titik grid pada 

koordinat Z. 
 Colour. Warna yang digunakan untuk tiap-tiap garis grid. 
 Line Style dan Line weigh. Jenis dan tebal garis yang digunakan 

untuk garis grid. 
 Text font dan Text size. Jenis dan ukuran huruf yang digunakan 

untuk koordinat garis grid. 
 Northing Prefix dan Easting Prefix. Nama awalan yang diberikan 

pada koordinat Northing dan Easting. 
 Northing Suffix dan Easting Suffix. Nama akhiran yang diberikan 

pada koordinat Northing dan Easting. 
 Grid Boundary. Jika field ini dipilih maka akan dibuat polygon 

boundary untuk grid. 
 Window boundary. Jika field ini dipilih maka akan dibuat polygon 

boundary untuk window. 
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 Scale bar definition.  Jika field ini dipilih maka form berikut akan 
ditampilkan: 

 

 
 

Form terdiri atas field-field berikut: 
 Location and Size. 

 Position. Posisi penempatan scale bar. 
 Max Width. Lebar maksimum scale bar. 

 
 Scale Bar Display. 

 Colour. Warna yang digunakan untuk scale bar. 
 Font. Jenis huruf yang digunakan untuk scale bar. 
 Weight. Ketebalan garis yang digunakan untuk scale bar 

 
 Title Definition. Digunakan jika anda akan membuat title. Form berikut 

akan ditampilkan: 
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Form terdiri dari field-field berikut: 
 Location and size 

 Posision. Lokasi penempatan title. 
 Height. Tinggi title box. 
 Width. Lebar title box. 
 Border weight. Ketebalan garis border title box. 

 
 Title type. Jenis title yang disediakan. Anda dapat memilih salah satu 

jenis title yang tersedia. 
 Title Display. Text untuk setiap box dalam title box. Anda tinggal 

mengetikkan text untuk tiap-tiap box pada field Text Box. 
 Justification. Tampilan text apakah rata kanan (right), rata kiri (left) 

atau tengah (centre). 
 Draw box outline. Apakah akan dibuat garis pada setiap box. 
 Border wieght. Tebal garis untuk setiap box. 
 North arrow definition. Dipilih jika anda mau membuat  panah untuk 

penunjuk arah utara. Sebuah form berikut akan ditampilkan: 
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Form terdiri dari field berikut: 
 

Arrow type 
Jenis arrow yang disediakan. Anda dapat memilih salah satu jenis arrow 
yang disediakan. 
 

Arrow Display 
 Colour. Warna yang digunakan untuk arrow. 
 Line style dan line weight. Jenis garis dan tebal garis yang digunakan 

untuk arrow. 
 Fill pattern. Fill yang digunakan untuk arrow. Field ini berlaku jika 

arrow type yang dipilih berupa polygon  dan rose. 
 Font. Jenis huruf yang digunakan  untuk text pada arrow. 
 Arrow text. Huruf yang akan digunakan untuk arrow. Jika anda 

memasukkan huruf tertentu maka huruf itu akan ditempatkan diatas 
arrow. 

 Scale faktor. Skala faktor untuk text arrow. 
 

Pilih OK. Setelah itu tempatkan arrow pada lokasi yang anda inginkan. 
 

4. Pilih NEXT, sebuah form berikut akan ditampilkan: 
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Form terdiri atas field berikut: 
 

 Output.  
 Plotter. Jika anda pilih plotter maka elemen grafis yang telah anda 

pilih akan langsung diplot. Kemudian anda harus menentukan No of 
Copy dan Configure Plotter. Untuk konfigurasi plotter pilih Configure 
plotter, form berikut akan ditampilkan: 

 

 
 

Pada field Format pilih Emf dan pada field Plotter pilih nama salah 
satu plotter.  

 
 Both. Jika anda pilih Both maka outputnya berupa plot file dalam 

format GDS dan plotter. 
 GDS. Jika anda pilih GDS maka outputnya berupa plot file dalam 

format GDS (nama plot file mempunyai suffixs .plt) 
 File. Jika anda pilih file maka outputnya berupa plot file. 

 
5. Pilih Ok atau Apply. 

 
 
 
 
 
 
 
 

  7 

DOWNLOAD TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys

Download TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys



  Plotting 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.2 Plot Slot 

Plotslot  adalah suatu menu yang digunakan untuk membuat plot baik yang 
sederhana maupun kompleks. Plot slot yang dibuat akan disimpan dalam direktory 
specs dengan format penamaan mempunyai ekstention .plotslot. 
 
Format plotslot dibagi menjadi beberapa slot atau area berikut: 

• Data (gambar) 
• Title box 
• Scale bar 
• Logo 
• North arrow 
• Border 

 
Gambar berikut menggambarkan pembagian slot pada suatu plotslot 
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Plotslot Template 
 
Plotslot template adalah suatu fasilitas yang digunakan untuk mendefinisikan format 
suatu plot dalam bentuk slot. Setiap slot maksimum terdiri dari 50 gambar. Gambar 
tersebut dapat ditampilkan overlap. Misalnya gambar kontur dapat dioverlapkan 
dengan basegrid. 
 
Komponen Plotslot template 
 
Suatu plotslot template terdiri dari beberapa slot. Setiap slot berisi salah satu dari 
komponen berikut: 
 

 Drawing 
Adalah gambar yang akan dimasukkan ke dalam slot. Gambar tersebut 
harus sudah ada dalam design file suatu projects. 

 Legend 
 Ancillary Data 

Ancillary data yaitu data tambahan yang dapat dimasukkan ke dalam plot 
seperti title box dan logo perusahaan. Data tersebut harus sudah ada di 
dalam projects. 

 Feature 
Feature yaitu ancillary data khusus, seperti border, scale bar, base grid 
dan north arrow. 

 Expression 
Sebuah mxl expresi dapat dimasukkan (hingga 80 karakter). Ekspresi 
dapat berupa ekspresi sederhana yang berisi rangkaian text atau 
ekspresi kompleks yang berisi  variable dan fungsi PLOTSLOT MXL. 
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Tahapan Pembuatan Plotslot 
 

1.2.1 Persiapan 

 Layer-layer yang berisi grafis yang akan diplot, misalnya kontur 
topography. 

 Layer-layer yang berisi grafis feature, misalnya: Location dan North 
Arrow. 

 Layer-layer yang berisi grafis ancillary, misalnya: Title 
 Display definition untuk slot title dengan ukuran cm, misalnya seperti 

contoh dibawah ini: 
 
Buat display definition dengan menggunakan menu berikut: 
 
MINESCAPE EXPLORER – ENVIRONMENT – DISPLAY DEFINITION – CREATE 
 
Form berikut akan ditampilkan: 

 

 
 

Berikut field-field yang harus diisi: 
Name:  title1 
Font: Times_Bold 
Size: 0.4 
Buat display definition lain dengan cara yang sama: 
 Nama title2, font Helvetica_Bold, ukuran font 0.35 
 Nama title3, font  Times_BoldItalic, ukuran font 0.30 

 

1.2.2 Memulai Plotslot 

1. Membuat Plot slot Template 
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Pilih menu: Page – Plot – Plotslot setup  
 

Tab Main 
 

Isi tab main seperti berikut: 

 

 
 
Input 

 Plotslot. Nama plotslot spec. 
 Siteplot. Nama base map spec. Spec terdiri dari semua informasi yang 

berhubungan dengan format pembuatan plot dasar. Field ini boleh tidak 
diisi. 

 
Save As Panel 

 Plotslot. Nama output plotslot yang akan disimpan ke dalam spec. 
 
Plot Info Panel 

 Project. Nama project. 
 Scale. Skala plot. 
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 Title. Judul plot. Dapat digunakan sebagai description dengan 
menggunakan expression TITLE. Maksimum jumlah karakter adalah 32. 

 Author.  Nama user. Dapat digunakan sebagai description dengan 
menggunakan expression USER. 

 Company. Nama perusahaan. Dapat digunakan sebagai description 
dengan menggunakan expression COMPANY. 

 
Destination 

 Plotter. Mengirimkan output langsung ke plotter. Pada saat plotting 
sebuah temporary file akan dibuat pada direktori tertentu (default 
/usr/tmp pada unix dan direktory MIN_TMP sesuai dengan setting 
MIN_TMP pada  environment variable pada NT). Temporary file tersebut 
akan dihapus jika plotting sudah selesai. 

 
Pastikan bahwa masih terdapat free space pada directory temporary. Jika tidak 
maka pada saat plotting tidak akan komplit. Plot yang terdiri dari text dan anotasi 
akan membutuhkan space yang lebih besar dibandingkan dengan yang berisi garis. 
 

 GDS – mengirimkan otput ke file GDS.  
 File – mengirimkan output menjadi sebuah file.  

 
 No of copies.  Jumlah hasil plotting. Field ini hanya aktif jika destination berupa plotter. 
 Configure plotter. Pilihan ini hanya aktif jika destinationnya berupa plotter atau File. 
 File name. Masukkan nama GDS file. Sebuah file dengan extention 

(<filename>/<extention>) akan dibuat. Extentionnya adalah .plt dan akan disimpan 
pada direktory plots suatu projects. 

 
Catatan: Pilihan ini hanya aktif jika outputnya berupa GDS atau File. 
 
Konfigurasi Ploter 
 
Plotter yang digunakan dan format bahasa pengantar plotter dapat di konfigurasi untuk output 
hardcopy. 
 
Untuk mengkonfigurasi plotter: 
 
Pilih Configure Plotter  pada tab Main – form berikut akan ditampilkan: 
 

  
 

 Format – Pilih bahasa pengantar plotter dengan memilih dari daftar pull 
down. 

Pastikan bahwa format tersebut support ke destination plotter. Jika tidak, anda akan 
menghasilkan output yang tidak sesuai. 
 

 Plotter. Pilih salah satu jenis plotter dari daftar pull down.  
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Pilih Ok  
 
Plotslot Toolbar  
 

Tombol-tombol dalam form plotslot memungkinkan anda untuk menentukan 
posisi slot dalam plotslot window. Berikut adalah tombol-tombol yang tersedia 
beserta fungsinya: 

 
 

Tombo
l 

Nama Fungsi 

 
Redraw Slots Menampilkan kembali semua slot. 

 Pick Slot Memberikan nama slot yang dipilih secara 
graphics.  

 New Slot Membuat slot baru. 

 
Move slot Memindahkan slot secara graphics dalam 

plotslot window. 

 Centre Slot Menempatkan slot relative di tengah-tengah  
terhadap slot yang dipilih. 

 Offset Slot Meng-offset slot relative terhadap slot yang 
dipilih. 

 
Resize slot Mengubah ukuran slot secara graphic dalam 

plotslot window. 

 
Delete slot Menghapus slot dari plotslot window. 

 
Previous Entry Memilih nama slot sebelumnya dalam daftar 

field Slot Name dan mengupdate definition 
pada form tersebut. 

 
Next Entry Memilih nama slot berikutnya dalam filed Slot 

Name dan mengupdate definition pada form 
tersebut. 

 
New/Edit Border Membuat atau mengubah ukuran dan orientasi  

kertas atau border. 
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Settings 
 

 
 
Text Sizes 

 Centriod size. Ukuran anotasi centroid pada saat plot. Jika field ini tidak diisi, maka 
tidak ada anotasi centroid yang di plot. 

 Coordinate size. Ukuran anotasi koordinat pada saat plot. Jika field ini tidak diisi, maka 
tidak ada anotasi koordinat yang di plot. 

 Contour size. Ukuran anotasi kontur pada saat di plot. Jika field ini tidak diisi, maka 
tidak ada anotasi kontur yang di plot. 

 Contour spacing. Kontrol spacing antar anotasi kontur. Jika ukuran anotasi kontur 0.2 
dan spacing 10, maka jarak antar anotasi pada saat plot adalah 2.  

 Text size. Ukuran text yang tidak dikontrol oleh display definition. 
 
Global Limit Parameter 

 Western limit. Batas Western dari plot. 
 Eastern limit. Batas eastern dari plot misalnya batas umum. Digunakan pada saat 

gambar tidak mempunyai limit. 
 
Catatan: Limit tersebut mungkin akan mempengaruhi semua gambar termasuk ancillary. 
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 Southern limit. Batas southern dari plot. 
 Northern limit. Batas northern dari plot. 
 Minimum elevation. Batas minimum nilai elevasi yang digunakan pada saat plot. 

Misalnya global limit. Digunakan jika gambar tidak mempunyai nilai  batas minimum. 
 Maksimum elevation. Batas maksimum nilai elevasi yang digunakan pada saat plot. 

Misalnya global limit. Digunakan jika gambar tidak mempunyai nilai  batas maksimum. 
 
Default 

 Rotation about X. Default Rotasi sumbu X. Hanya digunakan jika drawing view di set 
ke default. 

 Rotation about Z. Default rotasi sumbu Z. Hanya digunakan jika drawing view di set ke 
default. 

 X exaggeration. Default exaggeration dalam X. Hanya digunakan jika drawing view di 
set ke default. 

 Y exaggeration. Default exageration dalam Y. Hanya digunakan jika drawing view di 
set ke  default. 

 Z exaggeration. Default exaggeration dalam Z. Hanya digunakan jika drawing view di 
set ke default. 

 
Base grid 

 X Line spacing. Spacing X base grid. Hanya digunakan jika base grid dibuat pada saat 
plotting. 

 Y line spacing. Y spacing base grid. Hanya digunakan jika base grid dibuat pada saat 
plotting. 

 
 

2. Membuat Border 
 
Sebelum membuat slot drawing, features dan ancillaries, border slot harus dibuat terlebih dahulu. 
Pilih tombol New/Edit Border – form berikut akan ditampilkan: 
 

 
 
Slot name 

 Slot name. Ketikkan nama slot atau pilih dari daftar pull down. 
 Paper size. Pilih ukuran kertas yang akan digunakan pada saat plot dari daftar pull 

down. 
Orientation  
Pilih orientation yang akan digunakan Landscape  atau Potrait. 
 
Pilih Ok untuk membuat atau mengedit border. 
Catatan: Jika mengedit border, pastikan bahwa semua slot ditempatkan relative terhadap border yang 
telah diedit. 
 

3. Membuat Slot 
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Slot dapat ditempatkan secara absolut dengan memasukan angka atau relative terhadap slot lain. 
Minescape menyediakan sejumlah MXL yang memungkinkan anda untuk menentukan nilai relative. 
Berikut adalah MXL yang disediakan: 
 

1. Untuk menentukan nilai relative terhadap data dalam slot 
 DATAXMIN 
 DATAXMAX 
 DATAYMIN 
 DATAYMAX 

 
2. Untuk menentukan nilai relative terhadap slot lain 

 SLOTXMIN 
 SLOTXMAX 
 SLOTYMIN 
 SLOTYMAX 

 
Setiap fungsi mempunyai argument tersendiri, yaitu sebuah nama slot. Misalnya: 
SLOTXMAX (‘TITLE’) 
 
Menandakan value dari slot yang bernama TITLE 
 
Contoh Slot 
Contoh berikut akan membantu untuk menentukan nilai absolut atau relative dalam menentukan letak 
dan ukuran suatu slot. Misalnya anda sudah membuat slot yang bernama SLOT-A dan DATA, 
kemudian  anda ingin mendefinisikan slot lain yaitu SLOT-B. 
SLOT-B jaraknya 40cm dari SLOT-A dan 15 cm disebelah kanan slot DATA. Tinggi SLOT-B 12cm 
dan panjangnya 80cm (seperti pada contoh gambar berikut) 
 

 
Berikut adalah beberapa cara untuk mendefinisikan SLOT-B: 

 Sisi kiri SLOT-B harus ditempatkan 15 cm dari sisi kanan slot DATA. Definisinya bisa 
berupa: 

SLOTXMAX (‘DATA’) + 15 
 Sisi kanan SLOT-B harus ditempatkan pada jarak 80 cm dari sisi kiri SLOT-B. Posisi 

SLOT-B dapat didefinisikan dengan 3 cara: 
 Relative terhadap sisi kanan DATA, yaitu SLOTXMAX(‘DATA’)+95 
 Relative terhadap sebelah kiri SLOT-B, yaitu SLOTXMIN(‘SLOT-B’)+80 
 Nilai absolute (panjang x), yaitu 80 
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 Bagian bawah SLOT-B harus ditempatkan sejauh 40cm diatas bagian atas SLOT-A. 
dapat didefinisikan sebagai berikut:  
 SLOTYMAX(‘SLOT-A’) +40 

 Bagian atas SLOT-B harus ditempatkan sejauh 12 cm dari bagian bawah SLOT-B. 
Dapat didefinisikan dengan 3 cara: 
 Relative terhadap bagian atas SLOT-A, yaitu SLOTYMAX(‘SLOT-A’) 
 Relative terhadap bagian bawah SLOT-B, yaitu SLOTYMIN(‘SLOT-B’)+12 
 Nilai absolut (Panjang Y), yaitu 12 

 
Drawing Slot 
 
Isi tab drawing slot seperti berikut:  

 

 
 
 Pilih Save  dan pilih tombol Redraw Slot. 
Buat slot lain yaitu EDGE dengan cara yang sama seperti slot drawing hanya 
penempatannya seperti berikut: 
 
X Minimum: SLOTXMIN (‘BORDER’) + 0.5 
X Length: 83 
Y Minimum: SLOTYMIN (‘BORDER’) + 0.5 
Y length: 58 
 
Feature Slot 
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Buat slot untuk feature seperti location, scalebar dan north arrow. Isi tab feature seperti 
berikut:  
 

 
 

Pilih Save  kemudian pilih tombol Redraw Slot. 
 
Buat slot lain, namanya SCALEBAR  dan NORTHARROW dengan cara yang sama seperti 
slot location hanya penempatannya seperti berikut: 

Scalebar 
X Centre: SLOTXCEN(‘BORDER’)  
X Length: 8 
Y Minimum: SLOTYMIN(‘EDGE’) + 2 
Y Length: 1 
Northarrow 
X Center: SLOTXCEN(‘SCALEBAR’) 
X Length: 2 
Y Minimum: SLOTYMAX(‘SCALEBAR’) + 0.5 
Y Length: 2.5 
 
Ancillary Slot 
Buat ancillary slot untuk Title, Drawn, Approved, Drawing dan Date. Isi tab 
Ancillary seperti berikut: 
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Pilih Save  kemudian pilih Redraw Slot 
Buat slot lain, namanya Drawn, Approved, Date dan Drawing dengan cara yang sama 
seperti slot title hanya penempatannya seperti berikut: 

 
Drawn 
X Maximum: SLOTXMIN(‘TITLE’) + 4 
X Length: 2.5 
Y Maximum: SLOTYMAX (‘TITLE’) – 4.95   
Y Length: 0.5 
 
Approved 
X Maximum: SLOTXMAX (‘TITLE’) - 1 
X Length: 2.5 
Y Minimum: SLOTYMAX (‘TITLE’) – 4.95   
Y Length: 0.5 
 
Date  
X Maximum: SLOTXMAX (‘TITLE’) - 1 
X Length: 2.5 
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Y Minimum: SLOTYMIN (‘TITLE’) –    
Y Length: 0.5 
 

Drawing  
X Maximum: SLOTXMIN(‘TITLE’) + 4 
X Length: 2.5 
Y Minimum: SLOTYMIN (‘TITLE’)    
Y Length: 0.5 
 
Drawings 
 
Isi tab drawing seperti berikut: 
 

 
 

Slot Allocation 
 Slot. Nama slot. 
 Design File. Nama design file yang berisi gambar yang akan diplot. 

Maksimum 50 design file. 
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 Layer. Nama layer dari gambar yang akan di plot. Setiap layer  harus ada 
dalam design file yang dipilih. 

 Fit status. Gambar tidak diharuskan mengikuti skala, gambar dapat 
disesuaikan dengan slot. Pilih salah satu dari pilihan yang disediakan 
pada daftar pull down. 
 Nonfit. Gambar tidak disesuaikan dengan slot, tetapi dengan  skala. 

Jika gambar terlalu besar dari slot, maka gambar akan ditampilkan 
keluar dari slot area. 

 CLIP. Tidak menyesuaikan gambar dengan slot, tetapi dengan skala 
yang ditentukan. Jika gambar tertalu besar untuk slot, maka gambar 
tersebut akan di clip.  

 XFIT. Menyesuaikan gambar hanya dalam arah X. Gambar diperbesar 
atau diperkecil dalam arah x dan y untuk menyesuaikan dimensi x dari 
slot. 

 YFIT. Menyesuaikan gambar  hanya dalam arah Y.  
 XYFIT. Fit gambar dalam arah X dsan Y. 
 FIT. Menyesuaikan gambar secara seragam dalam dua arah. 

 Scale. Skala yang digunakan pada saat plotting. Field ini hanya diperlukan 
jika gambar-gambar yang akan di plot skalanya tidak sama. 

 X Justify. X justification gambat dalam slot. Pilihannya adalah left, right 
dan centre. 

 Y Justify. Y justification gambar dalam slot. Pilihannya adalah top, centre 
dan bottom. 

 View. Tampilan gambar pada saat di plot. Pilihannya adalah left, right, top, 
bottom, front, Back, southwest, southeast, northwest, northeast dan 
default. Jika default dipilih maka akan digunakan rotasi dan exaggeration 
default plot. 
Jika field view tidak diisi, maka module akan memeriksa apakah ada nama 
view dalam design file yang namanya sama dengan nama layer. Jika ada 
view tersebut akan digunakan, jika tidak ada top view akan digunakan. 

 Z exaggeration. Exaggeration gambar dalam arah Z dari suatu plot (tidak 
berlaku untuk plan view). Jika tidak diisi maka akan digunakan default 
exaggeration yaitu 1. 

 North. Batas utara gambar yang akan di plot. 
 South. Batas selatan gambar yang akan  di plot. 
 East. Batas timur gambar yang akan di plot. 
 West. Batas barat gambar yang akan di plot. 
 Low. Batas elevasi minimum yang digunakan dalam gambar. 
 High. Batas elevasi maksimum yang digunakan dalam gambar. 
 Label slot. Slot yang digunakan untuk legend dalam gambar. Jika legend 

akan dibuat dari data dalam gambar, maka item berikut harus disiapkan. 
 Item slot. Slot yang digunakan untuk item legend dalam gambar. 
 Item type. Jenis item legend. Pilihannya adalah annotation, usercata 

atau display tergantung atribut elemen yang digunakan pada saat 
membuat legend. 

 Display defs. Display definition legend.  
 Clip polygon.  Elemen id dari polygon yang akan digunakan untuk clip. 

Polygon harus  disimpan dalam design file yang sama dengan gambar.  
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Feature Slot 
 
Isi tab feature seperti berikut: 
 

 
 
Features 
 Slot. Nama features slot yang akan di plot. 
 Feature. Jenis feature. Berikut adalah jenis-jenis feature yang tersedia: 

 
Jenis Feature Keterangan 
BOX Box atau border disekitar slot 
GRID Base grid akan dibuat dengan menggunakan X dan 
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Y spacing yang ditentukan  
HBARSCL Scale bar horisontal 
HORSCL Scale bar horisontal beserta skala 
NORTHARRO
W 

North arrow sederhana 

SECTION Section orientasi grid 
VBARSCL Scale bar vertikal 
VERSCL Scale bar vertikal berikut anotasi skala 

 
 Data slot.  
 Display definition. Display definition untuk setiap feature. 

Catatan:  jika ingin membuat basegrid pada saat plot, tentukan X dan Y line spacing pada 
Tab Main kemudian pada Tab Slot Feature isi field Slot dengan nama slot 
untuk drawing dengan memilih dari daftar full down, pada  field Feature pilih 
Grids dari daftar full down dan pada  field Data Slot  pilih slot untuk drawing 
(namanya sama dengan slot pada   field slot).    

 
 

Expression 
 

Expression adalah rangkaian text yang ditempatkan dalam slot. Expression dapat 
berupa rangkaian text yang kompleks atau mxl variable plotslot  berikut: 
 

Variable Keterangan 
USER Masukkan nama user yang sudah 

ditentukan dalam tab Main 
COMPANY Masukkan nama perusahaan yang sudah 

ditentukan dalam tab Main 
PROJECT Masukkan nama project yang sudah 

ditentukan pada tab main 
TITLE Masukkan judul plot yang sudah 

ditentukan pada tab main 
SCALE Masukkan skala plot 

 
Berikut adalah function khusus yang dapat digunakan dalam expression: 
 

Function Keterangan 
Date(<n>) 
 
 
DATE(0) 
DATE(1) 
DATE(2) 
DATE(3) 
DATE(4) 
DATE(5) 
DATE (256) 
DATE(258) 
DATE(259) 

Tanggal  dapat menggunakan salah satu dari 
format berikut, dimana <n> adalah jenis format 
tanggal: 
DD-Mth-YY 
DD’th Month YYYY 
DDMMYY 
DD/MM/YY 
Day, Mth DD YYYY 
YYDDD, (ddd adalah hari) 
DD-Mth-YYYY 
DDMMYYYY 
DD/MM/YYYY 

TIME()R Current time dengan menggunakan format 
HH:MM:SS 

DESCRIPTION(<N>) <n> th deskripsi yang sudah ditentukan dalam tab 
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DESCRIPTIONS 
FSCALE(<slotname>) Rangkaian, misalnya ‘1:10000’. 

 
 
 
 
 
 
 
 
 
Ekspression  
 
Isi tab expression seperti berikut: 
 

 
 

 Slot. Nama slot  dimana expression akan ditempatkan. Biasanya  berupa 
ancillary slot. 

 Expression. MXl expression yang akan dimasukkan. Jika expression 
berasal dari file, gunakan format –f <nama file mxl>. 

 X justification. Justifikasi X expression dalam  slot. Pilihannya adalah 
left, right dan centre. 

 Y Justification. Justifikasi Y expression dalam slot. Pilihannya adalah 
top, bottom dan centre. 
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 Display def. Display definition untuk mengatur text suatu  expresi. 
 
 
 
 
 
 
 
 
 
 

Description 
 

Pengisian tab description harus disesuaikan dengan tab expression. 
 

 
 
Jika semua tab sudah dilengkapi pilih Build.   
 
Catatan: Jika posisi text untuk title tidak sesuai dengan X dan Y Justification yang sudah 
didefinisikan dalam Tab Features maka anda harus mengubah posisi slot untk masing-
masing text. 
Setiap mengubah posisi slot anda harus memilih Save kemudian pilih tombol  Redraw 
Slot agar yang ditampilkan slot dengan penempatan yang terakhir. 
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Untuk melihat hasilnya klik kiri icon   pada docking area atau pilih dari Minescape 
Explorer – Plots – pilih nama plot file – pilih tombol View 
 
 
 
 
 
 
Hasilnya adalah seperti berikut: 

 

 
 
 

1.3 Site Plot 

 

1.3.1 Pendahuluan 

Membuat Site Plot pada prinsipnya adalah mendefinisikan suatu format plot yang 
disesuaikan dengan kebutuhan site. Format plot yang dibuat kemudian digunakan 
sebagai default semua pembuatan plot file. 
 
Format ditentukan dengan cara mendefinisikan tata letak dari bingkai gambar atau 
dalam istilah Minescape disebut Plot Slot. 
 
Beberapa plot slot yang telah tersedia dalam Minescape adalah seperti digambarkan 
pada contoh konfigurasi slot di bawah ini: 
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DAT
A

BORDE
R

SCALE 
BAR DRAWINGDATE

DRAW DEPARTMEN
T

TITLE 

TITLE1

TITLE2 

NORTH 

 
Adapun langkah-langkah pembuatan siteplot adalah seperti diuraikan berikut: 
 
Persiapan 

1. Layer-layer yang berisi grafis yang akan diplot, misalnya struktur kontur, 
posting dan subcrop. 

2. Layer-layer yang berisi grafis ancilaries untuk dijadikan acuan, misalnya: 
Basegrid, Title Box dan North Arrow. 

3. Display definition untuk slot title dengan ukuran cm, misalnya seperti 
contoh dibawah ini: 

 
Buat display definition dengan menggunakan menu berikut: 
 
MINESCAPE EXPLORER – ENVIRONMENT – DISPLAY DEFINITION – CREATE 
 
Form berikut akan ditampilkan: 
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Berikut field-field yang harus diisi: 
Name:  title1 
Font: Times_Bold 
Size: 0.4 

 
Pilih Apply 

  
Buat display definition lain dengan cara yang sama: 

 Nama title2, font Helvetica_Bold, ukuran font 0.35 
 Nama departement, font  Times_BoldItalic, ukuran font 0.30 
 Nama title, Font Roman_Simplex, Ukuran font 0.2 

 
 

4. Membuat base map 
 

Pilih menu berikut: PAGE – SITEPLOT – BASE MAP – SET BASE MAP 
 
Form berikut akan ditampilkan: 
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 Masukkan nama base map, misalnya: A1lscape 
 Pilih OK 

Form berikut akan ditampilkan: 
 

 
 

 Isi field Media, misalnya A1 
 Isi field orientation, misalnya  Landscape 
 Pilih OK 

 
Masukkan margin atau jarak antara border dan slot data misalnya 0.5 

 
Memulai Site Plot 

1. Parameters 
 

Digunakan untuk mengatur parameter-parameter base grid. 
 
Form berikut akan ditampilkan: 
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Form terdiri dari field-field berikut: 

 
 

General 
 Current base map. Nama current basemap yang akan digunakan. Pilih 

nama base map dari menu pull-down.  
 

Annotation Sizes 
 Centroid, contour dan coordinate annotation size. Ukuran anotasi 

untuk jenis anotasi centroid, contour dan koordinat. 
 Contour annotation spacing. Spacing untuk anotasi kontur. 

 
Base Grid (Length Unit) 

 Display definition. Display yang digunakan untuk base grid. 
 Grid line X dan Y spacing. Jarak spacing untuk setiap garis/titik grid 

pada koordinat X maupun Y. 
 X coordinate prefix dan  Y coordinat prefix. Nama awalan yang 

diberikan pada koordinat X atau Y. 
 X coordinate suffix dan Y coordinate suffix. Nama awalan yang 

diberikan pada koordinat X atau Y. 
 Line style. Jenis garis yang digunakan untuk garis grid. 
 Text font  dan Text size. Jenis dan ukuran huruf yang digunakan untuk 

koordinat grid. 
 Text position. Text dapat ditempatkan didalam (Inside) atau diluar 

(Outside). 
 

Pilih OK atau Apply 
 

2. Origin 
 
Koordinat pada bagian kiri bawah gambar, dapat diinput secara graphical maupun 
manual. 
Jika diinput secara graphical caranya klik kiri pada bagian kiri bawah gambar. Jika 
diinput  secara manual caranya klik kanan pilih Key in delta.  

 
3. Scale 

 
Masukkan skala yang akan digunakan, misalnya 5000 
 

4. Rotation 
 
Besar sudut rotasi, dapat ditentukan jika hasil plot ingin dirotasi. 

 
5. Edit Base Map 

Dilakukan untuk mendefinisikan letak slot border dan slot data. 

 
Pilih menu: PAGE – SITE PLOT – BASE MAP 
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Form berikut akan ditampilkan: 
 

 
 

Masukkan  nilai X length dan Y length untuk DATA (Main Slot), misalnya seperti 
pada contoh diatas. 

  
6. Coverage 

 
Memeriksa apakah grid sudah sesuai dengan acuan yang sudah ditentukan. Jika 
belum maka anda harus mengedit base map dengan cara yang sama seperti diatas 
kemudian  ubah nilai X length dan Y length pada DATA (Main Slot) sampai sesuai. 
Jika sudah sesuai anda harus mengubah nilai X length dan Y length pada 
BORDER (Paper) sesuai dengan margin yang dimasukkan kemudian  periksa nilai 
X  dan Y origin pada BORDER dan DATA. Nilai X dan Y Origin pada BORDER 
harus lebih rendah daripada DATA. Misalnya jika nilai X dan Y origin pada 
BORDER adalah -0.5 maka pada DATA nilainya harus 0. 
 

7. Basegrid 
 
Jika mau membuat basegrid masukkan nama output base grid, misalnya 
basegrid_data. 

 
8. Membuat Slot 

 
Sebelum membuat slot anda harus menampilkan layer-layer yang akan dijadikan 
acuan seperti basegrid, title dan north arrow. 
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Untuk membuat slot pilih menu berikut: PAGE – SITE PLOT – BASE MAP – 
CREATE SLOT 
 
Form Berikut akan ditampilkan: 

 

 
 

 Pilih TITLE kemudian pilih OK. Tentukan posisi title box dengan cara klik 
kiri pada ujung kanan bawah title box yang sudah anda buat kemudian 
drag sampai ke ujung kanan atas title box.  
 

 Tentukan posisi TITLE 1, kemudian pilih OK. Tentukan posisi title1 box 
dengan cara klik kiri pada ujung kanan bawah title box yang sudah anda 
buat kemudian drag sampai ke ujung kanan atas title1 box. Sebuah form 
akan ditampilkan, pilih posisi text untuk title1 misalnya, Centre. Sebuah 
form display definition untuk display akan ditampilkan, pilih display 
definition untuk title1, misalnya title1.  
 

 Tentukan posisi TITLE2, DRAWN, DATE, DEPARTEMENT, DRAWING 
NO dengan cara yang sama seperti pada saat menentukan posisi 
TITLE1. 

 
Note:  Penentuan posisi awal untuk DRAWN, DATE dan DRAWING NO 

tidak sama seperti  pada TITLE1 tetapi harus disebelah kanan text 
yang sudah ada pada title box agar text tersebut ikut pada saat plot 
dibuat. 

 
 Pilih NORTH, kemudian pilih OK. Tentukan posisi north dengan cara klik 

kiri pada ujung kanan bawah north arrow yang sudah anda buat 
kemudian drag sampai ke ujung kanan atas. 

 Pilih SCALE kemudian pilih OK. Tentukan posisi scale dengan cara yang 
sama. 

 
9. Mengedit Slot  
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  Plotting 
 

 
− Resize Slot 

Mengubah ukuran slot. Caranya klik kiri slot yang ukurannya ingin 
diubah kemudian  drag hingga ukurannya sesuai dengan yang 
diinginkan. 
 

− Move Slot 
Memindahkan letak slot yang sudah dibuat. Caranya klik kiri slot yang 
akan diubah posisinya kemudian pindahkan ke tempat yang diinginkan. 

 
10. Menentukan Atribut Slot 

 
Hanya dilakukan jika atribut slot ingin diubah 

 Untuk mengedit atribut slot pilih menu: SLOT ATTRIBUTES 
 Pilih masing-masing slot yang atributnya akan diubah. 

 
11. Set Title Box 
 

 Pilih menu: PAGE – SITEPLOT - BASE MAP – SET TITLE BOX 
 Pilih nama design file dimana title box yang sudah dibuat disimpan, 

kemudian pilih OK. 
 Pilih nama layer yang berisi title box, kemudian pilih OK. 

 
12. Set North Arrow 
 

 Pilih menu: PAGE – SITE PLOT - BASE MAP – SET NORTH ARROW 
 Pilih nama design file dimana north arrow yang sudah dibuat disimpan, 

kemudian pilih OK. 
 Pilih nama layer yang berisi north arrow, kemudian pilih OK. 

 
13. Set Layer 
 

 Pilih menu: PAGE – SITE PLOT – SET LAYER 
 Sebuah form akan ditampilkan, pilih DATA, kemudian pilih OK. 
 Sebuah form akan ditampilkan, pilih nama design file dimana  elemen 

grafis yang akan diplot disimpan, kemudian pilih OK. 
 Sebuah form akan ditampilkan, pilih nama layer dimana  elemen grafis 

yang akan diplot disimpan, kemudian pilih OK. 
 Jika semua elemen grafis yang akan diplot sudah dipilih,  pilih Close. 

 
 

14. Built Plot 
 

 Pilih menu: PAGE – SITE PLOT – BUILT PLOT 
 Ketikkan text untukmasing-masing title. 
 Tunggu sampai proses selesai. 

 
 

15. Create Plot 
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  Plotting 
 

Langkah terakhir adalah membuat output plot file. Jika hasil built plot yang 
ditampilkan pada layar sudah sesuai dengan yang diinginkan, maka untuk membuat 
plot file, pilih menu PAGE – SITEPLOT - CREATE PLOT. 
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1 Mincom Expression Language (MXL) 

Apakah MXL itu? 
 
Mincom Expression Language (MXL) adalah bahasa yang memungkinkan anda 
menulis expressi sederhana dengan menggunakan data dan variabel-variabel yang 
telah ditentukan pada program Minescape. 
 
Fungsi dari expressi tersebut adalah untuk menghasilkan nilai tunggal. Nilai tersebut 
dapat berupa logika, numerik atau string tergantung pada aplikasinya. 
 
MXL sama dengan Mincom Programming Language (MPL) / Bahasa Program 
Mincom, tetapi tidak memiliki fasiltas serumit MPL. Sebagai contoh, MXL tidak 
memiliki fasilitas: 
 
• Assignment statements 
• GOTO 
• PERFORM 
• Loop structures 
 
Contoh 
 
Suatu expressi (mengatur nilai table dalam SURFTABLE) ditulis dalam MXL seperti 
berikut: 
 
/* 
/* SURFTABLE expression. Table column value is MISSING 
/* unless seam thickness is greater than 1.25, in which 
/* case the table value is set to seam thickness 
IF (THICK (‘AC1’) > 1.25) THEN; THICK (‘AC1’); ELSE; MISSING; 
ENDIF 
 
1.1 Notasi 

Expressi-expressi MXL terdiri dari: 
 
• Variabel 
• Constant 
• Operator 
• Function 
• Karakter Lanjutan 
• Keterangan 
• Statement separator 
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1.1.1 Fungsi  Notasi Argument  

Notasi singkat berikut digunakan pada waktu menjelaskan function argument: 
 
<exp> -- expressi dari jenis apa saja – logical, string, atau numeric. 
<log_exp> -- expressi logical. 
<str_exp> -- expressi string. 
<num_exp> -- expressi numeric. 
<value> -- nilai single numeric, logical atau string. 
<default> -- nilai single numeric, logical atau string default. 
[<arg>] -- argument pilihan 
 

1.1.2 Variable 

 
1.1.2.1 Variabel Modul Block & Surface 

 
Variabel-variabel dibawah dapat digunakan untuk penulisan expressi modul block & 
surface: 
 

CURRENTINTERVAL Current reserve interval 
CURRENTSURFACE Current surface 
EASTING Current easting value 
HEIGHT Height of bench 
LABEL A module-specified value 
LEVEL Current level 
NEXTHEIGHT Height of next bench 
NORTHING Current northing value 
SAMPLEBOTTOM Elevation of the bottom of the sample 
SAMPLEBURDEN Sample burden category 
SAMPLEINTERVAL Current reserve interval 
SAMPLEPOLYGON Sample polygon name 
SAMPLESOLID Sample solid name 
SAMPLESUBSET Sample subset name 
SAMPLETOP Elevation of the top of the sample 
WIDTH Width of bench 

 
 
1.1.2.2 Variabel Modul Table 

Variabel-variabel yang terdapat pada modul table adalah nama kolom, nama 
Constant table yang sedang digunakan dan dapat dilihat seperti berikut: 
 
ORIG_ROW_NUM The TABFREQUENCY, TABLINE,TABBAR,TABACCUM and 

TABREPORT modules use this variable because of their 
need to sort and subset data into a temporary table. 

ROW_NUM Current row number. 
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1.1.2.3 Variabel Modul GRIDMXL 

Variabel-variabel yang terdapat pada modul GRIDMXL adalah nama-nama nilai grid 
dari grid yang sedang digunakan dan dapat dilihat seperti berikut: 
 

COLUMN 
EASTING or X 
NORTHING or Y 
ROW 

Current grid column. 
Easting of the current grid node. 
Northing of the current grid node. 
Current grid row. 

 
1.1.2.4 Variabel Modul PLOTSLOT 

Variabel-variabel berikut dapat digunakan pada expressi untuk slot-slot expressi 
PLOTSLOT: 
 

COMPANY 
PROJECT 
SCALE 
TITLE 
USER 

The company name. 
The project name. 
The numeric scale. 
The drawing title. 
The user name. 

 
1.1.2.5 Variabel Modul Drill Hole Interrogation 

Variabel-variabel berikut dapat digunakan dalam penulisan expressi untuk modul drill 
hole interrogation: 
 

COLLAR 
HOLENAME 
LITHDEPTH 
 
 
 
TOTALDEPTH 

Elevation of drill hole collar. 
Drill hole name. 
Depth of the last intersection of a drill hole,Calculated as 
the difference in elevations Between the first point (collar) 
and the last Intersection. 
Total depth of the drill hole, calculated as the difference in 
elevations between the first point (collar)and the last point. 

 

1.1.2.6 Variabel Wash Table 

Variabel-variabel yang terdapat pada expressi wash table adalah nama wash table 
(nama hole, nama sampel, nama interval dan lain-lain), variabel-variabel tersebut 
adalah sebagai berikut: 
 

EASTING 
NORTHING 
WASHSAMPLEBOT 
WASHSAMPLETOP 

Easting of the current wash table sample. 
Northing of the current wash table sample. 
Bottom elevation of the current wash table sample. 
Top elevation of the current wash table sample. 

 

  3 of 26 

DOWNLOAD TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys

Download TUTORIAL MINESCAPE, XPAC dan SURPAC  :
bit.ly/2mJJJys



  MXL 
 

1.1.3 Constant 

1.1.3.1 Constant yang telah ditetapkan sebelumnya 

Beberapa constant yang sering digunakan biasanya telah ditetapkan sebelumnya.  
Constant-constant ini digunakan dengan cara yang sama sebagaimana variabel-
variabel normal, bagaimanapun juga nilai-nilai constant tersebut tidak dapat diganti. 
Constant yang telah ditetapkan tersebut adalah: 
 
• TRUE – Nilai logical TRUE. 
• FALSE – Nilai logical FALSE. Dimana TRUE  lebih besar dari FALSE. 
• PI – 3.141592653589793238. 

e.g. PI * SEARCHRAD **2 

• MISSING – nilai numeric yang belum diketahui. 
Constant MISSING memiliki beberapa sifat-sifat khusus: 

• Jika digunakan dalam expressi aritmatika, expressi tersebut akan menilai 
MISSING. 

• Jika secara aritmatika expressi tidak benar (misalnya, dibagi oleh 0), maka 
hasilnya akan MISSING. 

 
1.1.3.2 Constant yang telah ditetapkan oleh User  

• Constant String 
 

Constant String diikuti oleh tanda kutip tunggal (‘). Misalnya: 
‘Thickest point’ 
Gunakan sepasang tanda kutip (“) untuk meletakkan satu tanda kutip tunggal 
dalam suatu string. Misalnya:  
‘Bob’‘s ASH’ 

 
• Constant Numeric 
 

Constant numeric harus dimulai dengan suatu nilai angka, misalnya ‘0-9’,’-‘,’+’. 
atau ‘.’, dan dapat memiliki pola tertentu sebagai suatu presisi dua bilangan asli. 
Contoh: 
0.99957601 

 

1.1.4 Operator 

• Operator dengan Hasil Numeric 
• Operator dengan Hasil String 
• Operator dengan Hasil Logical 
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• Prioritas Operator 
 
Berikut ini adalah daftar beberapa operator yang dapat digunakan dalam expressi: 
 
1.1.4.1 Operator dengan Hasil Numeric 

Operator Use Example 
   
+ Addition FLOOR (‘AC1’) + .5 
- Substraction ROOF (‘AC1’) - .5 
* Multiplication THICK (‘AC1’) * SURFACE (‘AC0RD’) 
/ Division THICK (‘AC1’)/4 
** Raise VALUEREAD (A”ASH’, ROW, COLUMN) **2 
|< Minimum value THICK (‘AC1’) |, THICK (‘AC0’) 
|> Maximum value SLOPE (‘TOPO’) |> 0.5 

 
1.1.4.2 Operator dengan Hasil String 

Operator 
 

Use Example 

// String concatenation TIME ( ) // ‘GMT’ 
 
1.1.4.3 Operator dengan Hasil Logical 

Operator 
 

Use Example 

< Less than SLOPE (‘TOPO’) < 0 
> Greater than THICK (‘AC1’) > 1.5 
== Equal to SLOPE (‘AC1’) == 0 
<> Not equal to SLOTCOUNT (‘LEFT’)<>1 
<= Less than or equal to ROW <= 50 
>= Greater than or equal to ROOF (‘AC1’) >= ROOF (‘AC0’) 
& Logical AND IF (THICK (‘AC1’) > 5) & ~ 

(SURFACE (‘AC1RD’) <> MISSING) ~ 
THEN 

| Logical OR IF (EASTING > 450000) | ~ 
(EASTING < 550000) THEN 

^ or \ Logical NOT ^LOADED 
 
1.1.4.4 Prioritas Operator 

Jika suatu expressi sedang dihitung, maka operatornya menilai dengan cara berikut: 
 
1. Eksponensiasi (**) 
2. Unary minus /bilangan negatif (-) 
3. Perkalian (*) dan pembagian (/) 
4. Penambahan (+) dan pengurangan (-) 
5. Konkatenasi (//) 
6. Operator hubungan (<, <=, >=, <>, ==) 
7. Logical NOT /BUKAN(^,\) 
8. Logical AND /DAN (&) 
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9. Logical OR /ATAU (|) 
10. Semua operator dan function lainnya. 
 
Misalnya: 
 
-2**2 
 
akan memberikan nilai berupa –4, sebagaimana 2**2 dihitung pertama kali (hasilnya 
adalah 4), kemudian unary minus /bilangan negatif dihitung dan memberikan hasil 
akhir, yaitu –4. 
 
Tanda kurung dapat digunakan dalam expressi untuk mengganti perintah 
penghitungan. Misalnya: 
 
(-2)**2 
 
akan memberikan nilai, yaitu 4. 
 
Operator yang membagi prioritas kepada operator lain (merujuk pada nomor 3, 4 
dan 6 diatas) dihitung mulai dari kiri ke kanan dalam expressi tersebut: 
 
5*2 + 6/2 – 9*6/3 + 4 

 
dihitung menjadi: 
 
(((5*2) + (6/2)) – ((9*6)/3)) +4 

 
hasilnya adalah –1. 
 

1.1.5 Karakter Lanjutan 

Jika karakter terakhir pada suatu baris asal terdapat tanda tilde (~), berarti baris 
tersebut dilanjutkan pada baris berikutnya. Misalnya: 
 
THICK(‘AC1’) > 5 | ~ 
THICK (‘AC2’) . 5 
 
Dilanjutkan menjadi: 
THICK (‘AC1’) > 5 | THICK (‘AC2’) > 5 
 
1.1.5.1 Keterangan 

Semua karakter yang diikuti garis miring dan tanda asterik (/*) dari atas sampai akhir 
baris diabaikan oleh compiler, misalnya, berupa suatu keterangan. Contoh: 
 
/* 
/*   Return seam thickness 
/8 
THICK (‘AC1’)  /* Thickness of AC1 
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1.1.6 Statemen Separator 

Sejumlah statement dapat muncul pada satu baris jika dipisahkan oleh tanda titik 
koma (;). Misalnya: 
 
if SCALE < 100 then; 100; else; SCALE; endif 
 

1.1.7 Statemen Bersyarat 

MXL menyediakan suatu block if berstruktur seperti berikut: 
 
if <condition> then 
  <expressions> 
elseif <condition> then 
   <expression> 
else 
   <expressions> 
endif 
 
Statement elseif, mungkin banyak terdapat atau tidak terdapat samasekali. 
Sedangkan statement else, mungkin ada satu atau tidak sama sekali. 
 
Jika ada statement elseif dan else, maka else harus ada setelah statement elseif 
yang paling akhir. Misalnya: 
 
/* this is a valid block if statement. 
if ASH > 5 then 
 ASH  /* executed when  ASH is greater than 5 
elseif ASH == 5 then 
 0  /* executed when  ASH is equal to 5 
elseif ASH < 5 then 
 MISSING /* executed when  ASH is less than 5 
endif 
 
/* this is a valid block if statement. 
if (Z > 5) & Z < 10 then 
 Z  /*executed when  Z > 5 and Z < 10 
else 
 
 MISSING /*executed for all other cases. 
endif 
 
/* this is a valid block if statement. 
if Z >= 20 then 
 MISSING /*executed when  Z is greater than 
   /* or equal to  20 
endif 
 
/* this is an invalid block if statement. 
if Z > 67.2 then 
 20 
else 
 200 
elseif X > 99.9 then 
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 MISSING 
endif 
 
Block if pada contoh ini adalah tidak benar, sebab statement else harus ada setelah 
statement elseif yang paling akhir. 
 

1.1.8 FUNCTION 

 
Function-function MXL mempunyai pola kata seperti berikut: 
 
<function name>  (<argument>, <argument>, …) 
 

Dimana argument tersebut sesuai dengan jenis dan nomor pada argument 
yang terdapat dalam definisi function. 

 
Function tanpa argument harus disertai tanda kurung buka dan tutup, misalnya. 
 
<function name>  ( ) 
 
Semua operator seperti (+, - dan lain-lain) adalah function, dan disebut sebagai 
function bukannya operator. 
 
Merujuk pada topik Daftar Function Built-In untuk penjelasan mengenai  beberapa 
function tertentu. 

1.2 Pesan-Pesan Error 

 Compile Error 
 Runtime Error 
 MATH Library Error 

 

1.2.1 Compile Error 

 
Berikut adalah daftar error yang mungkin dihasilkan oleh MXL compiler dan MXL 
processor. 
 
Compile error terdiri dari: 
 

1. Unexpected End Expression 
 
Akhir expressi telah ditemukan, tetapi MXL compiler juga sedang mencari tanda 
lainnya, seperti tanda ), atau koma , atau bahkan suatu nama variabel. 
 

2. Variable  {X} Expected 
 
MXL compiler mencari suatu nama variabel (atau function, tergantung pada pesan 
yang terdapat dalam {X}), tetapi malahan tanda lain yang ditemukan. 
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3. Unknown {X}-{X} 

 
Serangkaian pesan yang muncul merujuk pada error yang biasa terjadi, dimana MXL 
compiler tidak dapat mengenal tanda yang diuraikan. Kemungkinan tanda tersebut 
merupakan suatu kata kunci/key word yang digunakan diluar konteks atau 
function/nama variabel atau jenis data yang tidak ditetapkan oleh MXL atau modul 
yang sedang digunakan. 
 

4. {X} Expected, But Found{X} 
 
Serangkaian pesan yang muncul merujuk pada error yang biasa terjadi, dimana MXL 
compiler mencari tanda-tanda tertentu, tapi menemukan tanda yang lain. 
 
Periksa pola kata statement yang anda buat. 
 

5. Unmatched {X} 
 
Serangkaian pesan yang muncul merujuk pada error yang biasa terjadi, dimana MXL 
compiler mencari tanda kutip, tanda koma, tanda kurung, atau jenis argument yang 
digunakan dalam function call. 
 
Pastikan string dikutip dengan benar dan argument ke function dari jenis dan nomor 
yang telah ditentukan dalam Daftar  Built-In Function atau dokumentasi modul yang 
sesuai. 
 
Juga Periksa expressi yang digunakan dalam statement if dan elseif merupakan 
jenis LOGICAL. 
 

6. Unrecognized Token {X} 
 
Tanda yang terdapat pada {X} ditemukan mengikuti nama variabel, tetapi bukan 
operator, tanda kurung, keyword mana saja, atau simbol yang secara benar dapat 
mengikuti suatu variabel. 
 
Periksa pola kata expressi. 
 

7. Args Function Diharapkan Menjadi Jenis Yang Sama – Tetapi Tidak 
Sama 

 
Jika seluruh argument untuk suatu function telah diuraikan, maka MXL compiler 
akan memastikan bahwa argument-argument tersebut merupakan jenis yang telah 
ditentukan untuk function. Function yang sedang diuraikan akan ditetapkan. 
 
Memiliki argument yang mungkin dari jenis mana saja – SELAMA SEMUA 
ARGUMENT MERUPAKAN JENIS YANG SAMA. 
 

8. Missing Block If Statement 
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Statement endif telah ditemukan, tetapi tidak ada statement if yang mengikuti endif 
tadi – terlalu banyak statement endif terdapat dalam program tersebut, atau 
statement if telah dihilangkan. 
 

9. Too Many Block If Statement. The Maximum Allowed Is {J} 
 
MXL compiler ditentukan untuk memiliki bilangan terbatas dari Ifstatement aktif pada 
suatu waktu. Jika nesting ifstatement sangat banyak melewati batas ini kemungkinan 
akan dilampaui. 
 

10. {J} Missing Endif Statement 
 
Uraian program terakhir telah dilengkapi dan tidak ada statement endif yang cukup 
untuk semua statement if yang digunakan. Periksa sisa if----endif. 
 

11. Missing’ For String Constant 
 
Constant string telah diuraikan, dan akhir baris atau akhir expressi telah ditemukan 
sebelum tanda kutip tunggal tertutup ditemukan untuk string tersebut. Periksa jika 
ada tanda kutip tertutup untuk string tadi. 
 

12. Polish Stack Overflow, Stack Pointer Would Be {J}-{X} 
 
Routine yang disebutkan dalam {X}menulis beberapa kode MXL yang telah disusun 
ke polish stack dan diketahui bahwa polish stack tersebut dapat digunakan secara 
keseluruhan. Pesan yang muncul {J} memberitahukan seberapa besar polish stack 
yang diperlukan untuk melaksanakan perintah penulisan. Ukuran polish stack yang 
ada harus perbesar untuk mengatasi error ini, atau program yang lebih kecil ditulis. 
 

13. Out Of Room On The {X}. Maximum Number Is {J}. 
 
Daftar yang disebutkan dalam {X} penuh. Jumlah maksimum nilai yang dapat 
disimpan adalah dalam {J}. 
 

14. No More Room On Application Defined Functions List   
 
Bilangan terbatas dari aplikasi berbeda yang telah ditetapkan dapat digunakan untuk 
satu program MXL tunggal – anda hanya perlu melewati batas ini. Merujuk pada 
dokumentasi module untuk menentukan function mana yang ditetapkan oleh 
aplikasi. 
 
CATATAN: Sejumlah invokasi function yang sama tidak mempengaruhi batasan 
yang dilampaui– masalahnya adalah jumlah function.aplikasi BERBEDA yang telah 
ditetapkan. 
 

15. The Function {X} Has Not Been Defined 
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Nama yang terdapat pada {X} telah digunakan sebagai function (contoh, nama 
tersebut diikuti oleh tanda kurung terbuka) – tapi belum ditetapkan sebagai function 
MXL built-in atau function aplikasi yang telah ditetapkan. 
 
Merujuk pada Daftar function Built-in untuk daftar function MXL. 
 

16. {X} Trying To {X} 
 
Jenis error MXL compiler ini menjelaskan error yang terjadi ketika compiler mencoba 
membaca, menulis atau menghapus suatu file. 
 

17. Parentheses: {J} More (X} Found Than Were Matched 
 
Jumlah tanda kurung terbuka dan tertutup dalam suatu baris harus sama. Jumlah di 
{J} memberitahukan kelebihan jenis tanda kurung yang terdapat di {X}. Periksa 
jumlah dari ‘(sama dengan jumlah dari ‘)’. 
 

18. Expected ‘)’ For {X}. Found End Of Expression 
 
Jumlah tanda kurung terbuka dan tertutup dalam suatu baris harus sama. 
 
Struktur yang terdapat pada {X} mencari tanda kurung tertutup, tapi akhir expressi 
yang ditemukan. Periksa jumlah dari ‘ (‘ sama dengan jumlah dari ‘)’. 
 

19. A Comma In A Function Declaration Must Be Surrounded By 
Function Arguments 

 
Periksa jumlah argument yang telah ditetapkan tersebut jika benar untuk referensi 
function. 
 
Merujuk pada Daftar Function Built-In dari daftar function dan argumentnya. 
 

20. Cannot Count The Args For {X} - Check Commas And Bracket 
Balance 

 
Jika function telah diuraikan, maka expressi yang ada di-scan untuk menghitung 
jumlah argument yang disediakan untuk function tersebut. Ada kesalahan pada 
expressi ini, yaitu menghalangi scan dari penghitungan yang berulang-ulang. 
 
 
 
 

21. Function {X} Must Have At Least {J} Arguments 
 
Function yang tersebut di {X} ditetapkan untuk dapat memiliki paling sedikit 
sejumlah {J}argument. 
 
Merujuk pada Daftar Function Built-In untuk daftar function dan argumentnya. 
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22. Too Many Arguments For {X}. Maximum Is{J}, Found {J} 
 
Referensi function yang tersebut di {X} memiliki terlalu banyak argument. 
 
Merujuk pada Daftar Function Built-In untuk daftar function dan argumentnya. 
 

23. This Argument Is Modifiable, Expected Variable Name, Found {X}. 
 
Argument ini dimodifikasi oleh function, sehingga argument tersebut harus 
merupakan suatu variabel yang sederhana – bukan Constant atau expressi. 
 

24. Bad Function – Id. Should Be Greater Than Or Equal To 2000, Found 
{J}. 

 
Function eksternal harus ditetapkan untuk dapat memiliki pengenal function 2000 
atau yang lebih besar. Periksa file External Function Definition - {J} adalah pengenal 
function yang tidak valid. 
 

25. A Result Expression Was Expected In This Program, But None Was 
Found. 

 
Modul yang sedang dijalankan menghendaki hasil dari program MXL ini, tapi tidak 
ada expressi RESULT pada program tersebut. 
 
Periksa dokumentasi modul yang relevan untuk menentukan jenis hasil yang 
diinginkan modul. 
 

26. The Result Type ({X}) Is Not Type Required ({X}). 
 
Modul yang sedang dijalankan menghendaki hasil jenis tertentu dari program MXL 
ini, tapi jenis yang tidak benar telah ada dalam expressi RESULT tersebut. 
 

27. (Warning) This Result Expression Will Be Ignored 
 
Pengerjaan program akan dihentikan jika ekpresi RESULT pertama dihitung. 
Expressi RESULT mana saja yang muncul akan diabaikan. 
 
if A > B then 
  C 
  D 
else 
  E 
endif 
 
akan mengabaikan expressi RESULT D. 
 
 
 

28. Missing Then For Elseif 
 
Statement IF adalah dari bentuk berikut ini: 
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if <logical_exp> then 
 exp 
elseif <logical_exp>then 
 exp 
else 
 exp 
endif 
 
Then mengikuti pengujian elseif adalah missing. 
 

29. Invalid Function Return Type {X}. 
 
Modul yang sedang dijalankan telah menentukan jenis functionnya untuk MXL 
dengan tidak benar. Jenis-jenis function harus berupa presisi ganda, logical atau 
string. Function yang menyebabkan error ini tidak dapat digunakan dalam suatu 
program MXL sampai karyawan support Mincom telah diberitahu dan modulnya 
diganti. 
 

1.2.2 Runtime Error 

Error yang ditemukan pada saat runtime akan dijelaskan berikut ini. Beberapa 
diantaranya dihasilkan oleh MXL dan beberapa lainnya dihasilkan oleh routine yang 
melakukan kalkulasi untuk MXL. 
 

1. The Stack {X} Is Empty {X} 
 
Error ini dilaporkan oleh MXL processor. 
 
Stack yang telah ditemukan pada {X} pertama harus dikosongkan oleh routine yang 
terdapat pada {X } kedua. Hal ini bisa berarti adanya virus pada MXL compiler, atau 
bagian polish stack yang dihasilkan oleh MXL compiler telah dirusak. 
 

2. Unrecognized Instruction Group {J} 
 
Error ini terjadi karena pengerjaan bagian MXL. Sekelompok instruksi yang 
dikeluarkan oleh MXL compiler tidak dapat dikenali oleh processor. Hal ini bisa 
berarti bahwa MXL compiler, atau bagian polish stack yang dihasilkan oleh MXL 
compiler telah dirusak. 
 

3. The Mxl You Want To Run Cannot Be Processed By This Processing 
Routine  

 
Program MXL telah disusun oleh compiler bukan dari versi yang sama seperti MXL 
processor ini. 
 
Pastikan bahwa modul yang menyusun program MXL memiliki MXL release yang 
sama seperti modul yang menjalankan program MXL. Jika keluaran baru dari MXL 
compiler dan processor telah di-install, maka perlu menyusun kembali file sumber 
MXL yang ada untuk membuat kembali kepustakaan kode-kode MXL yang ada. 
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4. Polish Stack Result Type Is {X}, The Application Expects {X} 
 
Error ini terjadi karena pengerjaan bagian MXL. Program MXL yang telah disusun 
dan yang sedang dijalankan akan mengembalikan hasil dari jenis (numeric, string 
atau logical) yang dijelaskan oleh{X}pertama, tapi modul tersebut memerlukan suatu 
hasil dari jenis yang dijelaskan oleh {X}kedua. 
 
Periksa dokumentasi modul untuk jenis hasil yang diinginkan dan pastikan program 
MXL yang telah disusun akan memberikan hasil jenis tersebut. 
 

5. No Result Found. A Result Must Be Returned. Check For If Exlusion 
 
Error ini terjadi karena pengerjaan bagian MXL. 
 
Modul menginginkan hasil dari program MXL ini, tapi tidak ada expressi hasil yang 
dikerjakan. 
 
Contoh if exclusion adalah sebagai berikut: 
 
if A > B then 
C 
endif 
 
Jika A lebih kecil dari B, maka tidak ada hasil yang di-generate. 
 

6. Result Too Big. Trying To Store {D} In An {X} Field. 
 
Error ini terjadi karena pengerjaan bagian MXL. 
 
Data numeric disajikan secara internal pada MXL sebagai angka presisi ganda, 
bagaimanapun juga modul dapat mengalokasi jenis-jenis data yang lebih kecil untuk 
menyimpan hasil kalkulasi. Error ini akan terjadi jika MXL secara internal telah men-
generate suatu angka yang terlalu besar untuk dimasukkan ke dalam field integer 
atau short integer yang disediakan oleh modul tersebut. 
 
Merujuk pada dokumentasi modul untuk batasan ukuran pada beberapa item-item 
data. 
 
Kemungkinan Error disebabkan oleh beberapa masalah logical dalam program – 
kalkulasi mengembalikan hasil yang lebih besar daripada yang diinginkan. 
 

7. Error Decoding {X} Into A{X}. At Character Position{X} 
 
Error ini terjadi karena pengerjaan bagian MXL. 
 
Pesan ini akan muncul jika string argument ke LDCODE atau NDECODE tidak valid. 
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Posisi karakter {J} adalah karakter dalam string yang pertama kali menyebabkan 
terjandinya error. 
 
Untuk LDCODE argument string harus TRUE /BENAR atau FALSE /SALAH. 
 
Untuk NDCODE argument string harus merupakan suatu string yang valid dari 
karakter angka, ‘-‘dan ‘-‘. 
 

8. String Range Error. Attemp To Reference A String From {J} To {J}. 
 
Error ini terjadi karena pengerjaan bagian dari MXL. 
 
Pesan ini muncul jika numeric argument untuk SUBSTRING function tidak mungkin 
dikerjakan – jika posisi start berada pada 0 atau kurang, dan panjangnya 0 atau 
kurang dari itu. 
 
Dua format {J} dalam pesan tersebut adalah start yang telah dikalkulasikan dan 
posisi akhir karakter dalam string. 
 

9. Wrong Stack Type. Cannot Execute An Mpl Stack With An Mxl 
Processor 

 
Error ini terjadi karena pengerjaan bagian MXL. 
 
MPL (Mincom Programming Language) merupakan suatu exspression evaluator 
yang rumit dengan pola kata yang sama dengan MXL. 
 
Kode stack yang di-generate oleh MPL compiler tidak dapat dikerjakan oleh MXL 
processor. 
 
 

1.2.3 MATH library error 

Runtime error yang ditemukan oleh MATH library adalah: 
 

1. (Madmul) {X} On Multiply 
 
{X}adalah overflow atau underflow. Hasil perkalian dua faktor yang akan 
menghasilkan suatu angka, dimana komputer tidak dapat mempresentasikannya. 
 

2. (Madmod)  Attempt To Divide By 0. Factors {D}And {D} 
 
Pembagian dengan 0 adalah tidak valid. Argument kedua {D} adalah 0. 
 

3. (Madmod) {X} Pada Pembagian 
 
{X} adalah overflow atau underflow, Hasil pembagian dua faktor yang akan 
menghasilkan suatu angka, dimana komputer tidak dapat mempersentasikannya. 
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4. (Madsqt) Attempt T Square Root A Negative Number: {D} 
 
Program menginginkan square root angka yang terdapat pada {D}. Untuk 
mendapatkan square root bilangan negatif adalah tidak mungkin. 
 

5. (Madtan) Tan Argument Not In Valid Range: {D} 
 
Function TAN untuk argument tertentu akan menghasilkan suatu hasil yang tidak 
terbatas..  
 
e.g 90 270 dst 
{D} = 90 + 180 * n, ( n sebagai integer) 

6. (Madlog) Log Base 10 Argument Less Than Or Equal To  0: {D} 
 
Log base 10 function tidak ditentukan untuk nilai-nilai argument yang kurang dari 
atau sama dengan 0. Argument {D} kurang dari 0. 
 

7. (Madasn) Arcsin Argument Not In Valid Range: {D} 
 
ARCSIN tidak ditetapkan untuk nilai-nilai argument yang berada diluar range 0 
sampai 1. Argument {D} berada diluar range ini. 
 

8. (Madacs) Arccos Argument Not In Valid Range: {D} 
 
ARCCOS tidak ditetapkan untuk nilai-nilai argument diluar range 0 sampai 1. 
Argument {D} berada diluar range ini. 
 

9. (Maddiv) Attempt To Divide By 0. Factors Are {D} And {D} 
 
Pembagian dengan 0 adalah tidak valid. Argument ke dua {D} adalah 0. 
 

10. (Maddiv) {X} On Divide 
 
{X} adalah overflow atau underflow. Hasil pembagian dua angka akan menghasilkan 
angka yang tidak dapat dipresentasikan oleh komputer. 
 

11. (Madln) Natural Log Argument Less Than Or Equal To 0: {D} 
 
Natural log function tidak ditetapkan untuk nilai-nilai argument yang kurang dari atau 
sama dengan 0. Argument {D} kurang dari 0. 
 

12. (Madras) Attempt To Raise A Negative Number To A Non Integral 
Power Of{D} 

 
Tidak benar menaikkan bilangan negatif ke suatu power yang memiliki bilangan 
pecahan. Power yang menyebabkan error adalah {D}. 
 

13. (Madras) {X} On Raise 
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{X} adalah overflow dan underflow. Hasil dari kenaikkan dapat berupa angka yang 
tidak dapat dipresentasikan oleh komputer. 
 

14. (Madat2) Both Arguments Are 0. 
 
Tidak benar menyertakan ATAN2 dengan kedua argument 0. 
 

1.3 File-File Expressi Mxl 

Expressi MXL dapat disimpan dalam file. Hal ini sangat berguna jika anda ingin 
menggunakan sejumlah expressi yang rumit dalam suatu waktu. 
 
Gunakan menu path Minescape berikut untuk memelihara file-file expressi: 
 
GENERAL/FILES/MXL 
Untuk membuat file expressi, gunakan menu path Minescape berikut: 
 
GENERAL/FILES/MXL/CREATE 
 
Window yang menjalankan editor tertentu ke sistem anda akan ditampilkan. 
Masukkan expressi yang diinginkan dengan menggunakan editor ini. 
 
File-file expressi disimpan dalam subdirektori mxl project dengan ekstension file 
.mxl. 
 

1.3.1 Menggunakan file-file expressi MXL 

 
Untuk menggunakan expressi MXL yang telah disimpan dalam suatu file expressi, 
anda dapat memasukkan nama berikut ke dalam field expressi yang sesuai: 
 

- file <MXL filename> 
 
1.3.1.1 Function Logical 
 

AND (<log_exp1>,<log_exp2>) 
EO(<exp1>, <exp2>) 
GE(<exp1>,<exp2>) 
GT(<exp1>, <exp2>) 
LE(<exp1>), <xp2>) 
LT(<exp1>), <xp2>) 
MISS(<num_exp>) 
NE(<exp1>, <exp2>) 
NOT(<log_exp>) 
OR(<log_exp) 
OUTSIDE(<num_exp1>, <num_exp2>, <num_exp3>) 
RANGE(<num_exp1>, <num_exp2>, <num_exp3>) 
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1.3.1.2 Function Matematika 
 

ABS(<num_exp>) 
DIVIDE(<num_exp1>, <num_exp2>) 
DROUND(<num_exp1>, <num_exp2>) 
EXP(<num_exp1>, <num_exp2>) 
IFC(<log_exp>, <num_exp1>, <num_exp2>) 
INT(<num_exp>) 
LOG(<num_exp>) 
LOG10(<num_exp>) 
MAX(<num_exp1>, <num_exp2>) 
MIN(<num_exp1>, <num_exp2>) 
MINUS(<num_exp1>, <num_exp2>) 
MOD(<num_exp1>, <num_exp2>) 
MULTIPLY(<num_exp1>, <num_exp2>) 
NONMISS(<num_exp1>, <num_exp2>) 
PLUS(<num_exp1>, <num_exp2>) 
RAISE(<num_exp1>, <num_exp2>) 
RANDOM(<num_exp1>, <num_exp2>) 
ROUND(<num_exp1>, <num_exp2>) 
SIGN(<num_exp1>, <num_exp2>) 
SORT(<num_exp>)S 
UMINUS(<num_exp>) 

 
1.3.1.3 Function Trigonometris 
 

ACOS(<num_exp>) 
ASIN(<num_exp>) 
ATAN(<num_exp>) 
ATAN2(<num_exp1>, <num_exp2>) 
COS(<num_exp>) 
SIN(<num_exp>) 
TAN(<num_exp>) 

 
1.3.1.4 Function String yang berkaitan 
 

CONCAT(<str_exp1>, <str_exp2>) 
CONVERT(<str_exp>, <exp>) 
ENCODE(<str_exp>, <exp>) 
IFCS(<log_exp>, <str_exp1>, <str_exp2>) 
INDEX(<str_exp1>, <str_exp2>) 
LEN(<str_exp>) 
LDCODE(<str_exp>) 
LOCASE(<str_exp>) 
NDECODE(<str_exp>) 
SUBSTRING(<str_exp>, <num_exp1>, <num_exp2>) 
TOKEN(<str_exp>, <num_exp>) 
TRIM(<str_exp>) 
UPCASE(<str_exp>) 
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1.3.1.5 Function File yang berkaitan 
 

FILEDELETE(<str_exp>) 
FILEEXISTS(<str_exp>) 
TMPFILE(<dirname>) 

 
1.3.1.6 Function Lainnya 
 

DEGTODMS(<flag>, <degrees>) 
DMSTODEG(<dms_string>) 
SYSTEM(<command_string>) 

 
1.3.1.7 Function Utility 
 
Sekumpulan function utility terdapat pada modul-modul yang menggunakan MXL. 
 
Periksa titik yang ada dalam elemen 2D polygon. 
INPOLYGON(<filename>, <element_id>, <x>, <y> 
Proyeksikan titik ke atas plane yang telah ditentukan oleh titik x, y, z dan sudut strike 
& dip. 
PLANEANGLE(<x>, <y>, <x1>, <y1>, <z1>, <strike>, <dip> 
 
Proyeksikan titik ke atas plane yang telah ditentukan oleh elemen dan sudut. 
PLANEELE (<filename>, <element_id>, <x>, <y>, <angle> 
 
Proyeksikan titik ke atas plane yang telah ditentukan oleh titik x, y, z dan sudut. 
PLANEPOINT(<x>, <y>, <x1>, <y1>, <z1>, <x2>, <y2>, <z2>, <angle>) 
 
 
1.3.1.8 Function Block & Surface 
 
Function block dan surface menghitung thickness, roof dan floor suatu interval 
(dalam database surface) dan nilai surface, slope dan arah slope suatu surface 
(dalam database surface). Function berikut ini dapat digunakan dalam expressi 
yang ditulis untuk modul block dan surface: 
 
Menentukan bearing slope dari suatu surface. 
DIRSLOPE(<surface>, [<x>, <y>]) 
 
Menentukan floor suatu interval. 
FLOOR(<interval>, [<x>, <y>]) 
 
Menentukan jarak terdekat titik data. 
NEAR(<surface>, [<x>, <y>]) 
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Menentukan roof suatu interval. 
ROOF(<interval>, [<x>, <y>]) 
 
Menentukan slope suatu surface. 
SLOPE(<surface>, [<x>, <y>]) 
 
Menentukan nilai suatu surface. 
SURFACE(<surface>, [<x>, <y>]) 
 
Menentukan ketebalan /thickness suatu interval. 
THICK(<interval>, [<x>, <y>]) 
 
1.3.1.9 Function GRIDMXL 
 
Function UTILITY MXL dan kegunaanya berikut ini dapat digunakan untuk modul 
GRIDMXL: 
 

Menentukan bearing true slope tersebut untuk nilai pada suatu node. 
DIRSLOPE(<grid-value-name>, <row>, <column>) 
 
Kembalikan lokasi grid node. 
NODE(<axis>, <row>, <column>) 
 
 
Menentukan true slope nilai suatu node. 
SLOPE(<grid_value_name>, <row>, <column>) 
 
Interpolasi nilai pada lokasi tertentu. 
VALUEINTER(<grid_value_name>, <x>, <y>) 
 
Kembalikan nilai pada node tertentu. 
VALUEREAD(<grid_value_name>, <row>, <column>) 
 
1.3.1.10 Function PLOTSLOT 
 
Function utama PLOTSLOT yang digunakan adalah untuk menempatkan suatu plot 
relatif ke slot yang ada. 
 
Jika menggunakan replikasi dalam PLOTSLOT, Function SLOTxxxx akan merujuk 
pada replikasi yang terbaru dari slot yang telah dipilih, dan routine INITxxx akan 
merujuk pada spesifikasi awal dari slot yang dipilih. Jika replikasi tidak sedang 
digunakan, maka function SLOTxxx sama dengan function INITxxx. 
 
Semua function ini akan mengembalikan data dalam unit-unit plotter, sebagaimana 
yang telah ditentukan dalam database program Minescape. 
 
Kembalikan pusat data nilai X dari suatu slot. 
DATAXCEN(<slot>) 
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Kembalikan panjang nilai X dari suatu slot. 
DATAXLEN(<slot>) 
 
Kembalikan maximum data nilai X dari suatu slot. 
DATAXMAX(<slot>) 
 
Kembalikan minimum data nilai X dari suatu slot. 
DATAXMIN(<slot>) 
 
Kembalikan pusat data nilai Y dari suatu slot. 
DATAYCEN(<slot>) 
 
Kembalikan panjang data Y dari suatu slot. 
DATAYLEN(<slot>) 
 
Kembalikan data maksimum nilai Y dari suatu slot. 
DATAYMAX(<slot>) 
 
Kembalikan data minimum nilai Y dari suatu slot. 
DATAYMIN(<slot>) 
 
Kembalikan tanggal terkini senagai suatu string 
DATE(<format>) 
 
Kembalikan deskripsi tertentu dengan <index> 
DESCRIPTION(<index>) 
 
 
Kembalikan skala dari suatu slot. 
FSCALE(<slot>) 
 
Initial definition pusat nilai X dari suatu slot. 
INITXCEN(<slot>) 
 
Initial definition panjang X dari suatu slot. 
INITXLEN(<slot>) 
 
Initial definition  nilai maksimum X dari suatu slot. 
INITXMAX(<slot>) 
 
Initial definition nilai minimum X dari suatu slot. 
INITXMIN(<slot>) 
 
Initial definition pusat nilai Y dari suatu slot. 
INITYCEN(<slot>) 
 
Initial definition panjang Y dari suatu slot. 
INITYLEN(<slot>) 
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Initial definition  nilai maksimum Ydari suatu slot. 
INITYMAX(<slot>) 
 
Initial definition nilai minimum Y dari suatu slot. 
INITYMIN(<slot>) 
 
Kembalikan jumlah replikasi aktif untuk suatu slot. 
SLOTCOUNT(<slot>) 
 
Kembalikan pusat nilai X dari suatu slot. 
SLOTXCEN(<slot>) 
 
Kembalikan panjang X dari suatu slot. 
SLOTXLEN(<slot>) 
 
Kembalikan maksimum nilai X dari suatu slot. 
SLOTXMAX(<slot>) 
 
Kembalikan minimum nilai X dari suatu slot. 
SLOTXMIN(<slot>) 
 
Kembalikan pusat nilai Y dari suatu slot. 
SLOTYCEN(<slot>) 
 
Kembalikan panjang Y dari suatu slot. 
SLOTYLEN(<slot>) 
 
Kembalikan nilai maksimum Y dari suatu slot. 
SLOTYMAX(<slot>) 
 
Kembalikan nilai minimum Y dari suatu slot. 
SLOTYMIN(<slot>) 
Kembalikan waktu terkini sebagai suatu string. 
TIME(  ) 
 
 
1.3.1.11 Function Schema Stratigrafi 
 
Function Skema Stratigrafik menghitung thicknes, roof dan floor dari suatu interval 
dan slope dan azimuth slope dari surface dan rasio overburden dari definisi skema. 
Function-function ini dapat digunakan dalam expressi yang ditulis untuk modul-
modul skema stratigrafik. 
 
Tiap function ini memerlukan nama interval dan surface mana saja. Function yang 
mengembalikan nilai yang melewati range memerlukan dua nama. Jika argument 
<x> dan <y> dihilangkan, maka nilai EASTING terbaru (koordinat x) dan NORTHING 
(koordinat y) dapat digunakan. 
 
Menentukan sumber/ketebalan batubara dalam suatu interval. 
COAL (interval>, [<x>, <y>] 
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Same as RESOURCE
 
Menentukan bearing slope dari skema surface. 
DIRSLOPE(surface>, [<x>, <y>] 
 
Menentukan tinggi dari suatu fault. 
FAULTSURFACE (fault>, [<x>, <y>] 
 
Menentukan pemindahan fault dalam arah X. 
FAULTX(fault>, [<x>, <y>] 
 
Menentukan pemindahan fault dalam arah Y. 
FAULT(fault>, [<x>, <y>] 
 
Menentukan pemindahan fault dalam arah Z. 
FAULTZ(fault>, [<x>, <y>] 
 
Menentukan floor suatu interval. 
FLOOR(interval>, [<x>, <y>] 
 
Menentukan ketebalan inteburden  suatu interval. 
INTERBURDEN(interval>, [<x>, <y>] 
 
Menemukan skema rasio kenaikan interval. 
IRATIO(interval>, [<x>, <y>] 
 
Temukan skema rasio kumulatif interval. 
ORATIO(interval>, [<x>, <y>] 
 
Menentukan ketebalan overburden untuk interval. 
OVERBURDEN(interval>, [<x>, <y>] 
 
Menentukan bagian interval 
PARTING(interval>, [<x>, <y>] 
 
Kembalikan sumber/ketebalan batubara untuk range interval yang diberikan. 
RANGECOAL(start_interval>, <end_interval>, [<x>, <y>] 
Same as RANGERESOURCE 
 
Kembalikan floor interval terendah untuk range yang diberikan. 
RANGFLOOR(start_interval>, <end_interval>, [<x>, <y>] 
 
Temukan ketebalan interburden untuk range interval yang diberikan. 
RANGEINTERBURDEN(start_interval>, <end_interval>, [<x>, <y>] 
 
Temukan rasio kenaikan diantara dua interval. 
RANGEIRATIO(start_interval>, <end_interval>, [<x>, <y>] 
 
Temukan rasio kumulatif diantara dua interval. 
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RANGEORATIO(start_interval>, <end_interval>, [<x>, <y>] 
 
Temukan ketebalan overburden untuk range interval yang diberikan. 
OVERBURDEN(start_interval>, <end_interval>, [<x>, <y>] 
 
Kembalikan jumlah bagian interval untuk range interval yang diberikan. 
RANGEPARTING(start_interval>, <end_interval>, [<x>, <y>] 
 
Kembalikan jumlah sumber/ketebalan batubara untuk range interval yang diberikan. 
RANGESOURCE(start_interval>, <end_interval>, [<x>, <y>] 
 
Kembalikan interval roof tertinggi untuk range yang diberikan. 
RANGEROOF(start_interval>, <end_interval>, [<x>, <y>] 
 
Kembalikan jumlah ketebalan interval untuk range yang diberikan. 
RANGETHICK(start_interval>, <end_interval>, [<x>, <y>] 
 
Menentukan sumber/ketebalan batubara dalam interval. 
RESOURCE(<interval>, [<x>, <y>] 
Same as COAL.
 
Menentukan roof interval. 
ROOF(<interval>, [<x>, <y>] 
 
Menentukan slope skema surface. 
SLOPE(<surface>, [<x>, <y>] 
 
Menentukan nilai surface. 
SURFACE(<surface>, [<x>, <y>] 
 
Menentukan ketebalan interval. 
THICK<interval>, [<x>, <y>] 
 
Temukan total sumber/ketebalan batubara dari unit gabungan. 
TOTALCOAL(<interval>, [<x>, <y>] 
Same as TOTALRESOURCE. 
 
Temukan floor terendah dari unit gabungan. 
TOTALFLOOR(<interval>, [<x>, <y>] 
 
Temukan ketebalan interburden untuk unit gabungan. 
TOTALINTERBURDEN(<interval>, [<x>, <y>] 
 
Temukan rasio kenaikan untuk unit gabungan. 
TOTALIRATIO(<interval>, [<x>, <y>] 
 
Temukan rasio kumulatif untuk unit gabungan. 
TOTALORATIO(<interval>, [<x>, <y>] 
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Temukan ketebalan overburden untuk unit gabungan. 
TOTALOVERBURDEN(<interval>, [<x>, <y>] 
 
Temukan parting unit gabungan. 
TOTALPARTING(<interval>, [<x>, <y>] 
 
Temukan total sumber/ketebalan batubara unit gabungan. 
TOTALRESOURCE(<interval>, [<x>, <y>] 
Same as TOTALCOAL. 
 
Temukan uppermost roof unit gabungan. 
TOTALROOF(<interval>, [<x>, <y>] 
 
Temukan total ketebalan interval unit gabungan. 
TOTALTHICK(<interval>, [<x>, <y>] 
 
1.3.1.12 Function Quality 
 
Function telah ditetapkan untuk memprediksi nilai-nilai Quality. Function tersebut 
dapat dicapai dimana saja, dimana model Quality dapat ditentukan. Function ini 
mungkin ada pada expressi surface mana saja. 
 
Tentukan nilai waste atau Quality dilution untuk interval yang ditunjuk. 
 
Tentukan nilai Quality untuk interval pada suatu lokasi. 
 
 
1.3.1.13 Function Wash Table 
 
Kembalikan nilai Quality float/sink. 
FLOATQUALITY(<quality>, <usize>, <Isize>, <float>, <sink>) 
 
Kembalikan float/sink yield. 
FLOATYIELD(<usize>, <Isize>, <float>, <sink>) 
 
Kembalikan nilai Quality froth. 
FROTHQUALITY(<quality>, <usize>, <Isize>, <time>) 
 
Kembalikan a froth time yield. 
FROTHYIELD(<usize>, <Isize>, <time>) 
 
 
Kembalikan nilai Quality untuk oversize atau slime. 
ITEMQUALITY(<category>, <quality>) 
 
Tentukan Quality suatu produk untuk wash table terkini. 
PRODUCTQUALITY(<quality>) 
Kembalikan size yield. 
SIZEYILED(<category>, <Isize>, <float>) 
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Kembalikan nilai Quality tail. 
TAILSQUALITY(<quality>, <usize>, <Isize>) 
 
Kembalikan tail yield. 
TAILSYILED(<usize>, <Isize>) 
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